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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client
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DevTrack Web offers two primary advantages over the Windows client: 
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1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
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     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 
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DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 
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     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 
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Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
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DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 
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          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 
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Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    
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          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 
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TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 
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DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 
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Key Benefits 
 
 
 
Rapid Return on Investment (ROI): with the combined power, flexibility, ease-of-use, and competitive pricing, DevTrack gives 
you the best value. 
Increase developer satisfaction with subscription notifications and better process control 
Fast deployment with easy installation and automated upgrades. 
Intuitive user interfaces reduces training time and gets users up to speed faster. 
System customization to suit individual demands: easily configured workflow rules that can be changed to control the business
processes based on your organization's mission. 
Resolve issues efficiently with greater teamwork and collaboration between different users, teams, and even customers. 
Ensure no bug ever falls through the cracks with auto-routing and escalations. 
Universal access to DevTrack Web from any location using almost any browser. 
 
 
 
 
 
Features Overview 
Easily customize DevTrack forms and fields using point-and-click operations from a simple Graphical User Interface (GUI) to fit
unique business requirements. 
Design sophisticated workflow rules to control important business processes including issue states and status transition. 
Define an unlimited number of roles to ensure that information is secure. 
Administrators and project managers can control individual user access to pages and fields based on their role or issue status.
Automatically route issues to appropriate users when an issue is created or forwarded. Issues that are open too long, past 
due, or stagnant, can also be automatically escalated to notify appropriate engineers or issue owners. 
Send email notifications through an extensive list of triggers and recipient choices. A subscription-based notification system 
cuts down on unwanted emails. 
Create and assign subtasks to different team members to help track and resolve parent work items and issues. Status 
changes on a parent issue can automatically trigger the creation of pre-defined sub-issues. 
A secure, personalized web portal where Beta customers can submit, track and update issues. They can also create and 
assign sub-issues. 
Import and authenticate users from Active Directory or other LDAP sources for single sign-on. 
Integrated knowledge base and document management means that information needed is always a search away. 

  

  

  

 Chapter 1- Defect Tracking Management with 
DevTrack 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack in TechExcel DevSutie
Solutions

  

TechExcel DevSuite is a family of integrated application lifecycle management (ALM) tools that place knowledge management —from ideas, to formal specifications, to 
competitive information to issue resolution and customer insight—at the core of anyproduct development initiative. 
  
The DevSuite knowledge-centric strategy enables improve communication, keep uptodate on changes, and reduce the development cycles so that the business may deliver 
the right products for the right markets in the shortest possible time. 
  
                                            

                                  

  
                                                     DevSuite Knowledge-Centric Development 
  
DevSuite places knowledge management at the core of all development processes. TechExcel KnowledgeWise provides for the easy and efficient collection and organization 
of informal ideas, gathered from a wide variety of sources, that area shared across multiple DevSpec, DevTrack, and DevTest projects. 
  
KnowledgeWise projects provide controlled access to documents, improve communication and coordination between distributed development teams, and facilitate the 
management and sharing of information between development teams and project stakeholders. 
  
TechExcel DevSuite leverages intellectual assets with KnowledgeWise, communicating a clear product vision and tactical execution strategy by linking ideas and customer 
feedback, specifications, requirements, designs, prototypes, and other documents to specific areas of work. 
  
DevSuite can be effectively used to help an organization build their development culture around best practices. Best 
practices and development guidelines are enforced and mandated by every team member's activities. DevSuite's 
individual products can also be independently used as point solutions for requirements management, issue and project 
tracking, and QA test management: 
  

  

  
  

1 Understanding the DevTrack Clients 
Development organizations may deploy DevTrack using any combination of Windows and web clients. DevTrack Web may be 
used as a stand-alone product or in tandem with the DevTrack Windows client uniting internal and external development 
teams. All data is completely synchronized in real time to the central DevTrack database. 

The procedures required to manage issues in the web client are essentially the same as the procedures required to perform 
similar tasks in the DevTrack Windows client. 

  

1.1 Advantages of the DevTrack Web 

The following features areonly availablein theDevTrack Web: 

Easy Deployment:The web client can be accessed through your standard web browser. Unlike thewindowsclient, your users
don't need to install anything on their systems. This makes the web client much easier for managing future patches and 
upgrade. 
 
 
 
Improved Performance:DevTrack web has been designed to scale and perform better than thewindowsclient. 
 
 
 
Enhanced Reporting:DevTrack web offers a larger variety of reportsthan the windows client. It also providesmore 
customizability. 
 
 
 
Windows NT Authentication:DevTrack can be setup so that your users’Windows NT Loginscan be used as a single-sign-on
into the DevTrack web. Users log on to their workstations through their domain account, and thenthey canlogin directly into 
the DevTrack web client. 

 

1.2 Advantages of the DevTrack Windows Client 

  

The followingfeatures are only available in the DevTrack Windows Client: 
 
Importing and exporting issues:Issues can be imported and exported between different DevTrack installations, projects 
and 3rd party applications through this utility. 
 
 
 
Managing the Customer Beta Portal:Users can manage customers and contacts and provide them with the ability to submit 
defects into DevTrack. 
 
 
 
Auto-generated Reports:Reports can be generated on a scheduled basis and emailed to DevTrack users. 

1.3 Understanding the DevTrack Web Client 

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser. 
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsanduser preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  
DevTrack Web offers two primary advantages over the Windows client: 
      • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

      • Project members do not need to install thethickclient on their local machine. Usingthewebclient greatly simplifies the 
upgrade process. 

 Chapter 2- DevTrack Web Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Understanding DevTrack Web Client

  

DevTrack Web enables project members to log into DevTrack projects through the Internet using a web browser.  
 
 
 
The web client organizes project data in multiple web pages. Each web page is designed to track a specific type of datasuch 
asissues, reportsand user preference/settings. 

 
 
Within each web page, project data may be organized into multiple frames and tool bars. The most important and most 
frequently used web page in DevTrack Web is theIssue Listpage. 

  

  
DevTrack Web offers two primary advantages over the Windows client: 
  
  • Project members may access a DevTrack project from anywhere in the worldas long as they have access 

  • Project members do not need to install thethickclient on their local machine. Usingthe web client greatly simplifies the 
upgrade process.  

  

  

1 Browser Compatibility 
  

The web client pages can be access via HTTP or HTTPS, so users can access the client through any standard browser. We 
recommend our users to use the latest versions of Internet Explorer or Mozilla Firefox. The webclient utilizes controls that 
require ActiveX, Java and Javascript to be enabled. 

  

1.1 To enable Java and JavaScript in Firefox 3.x: 
1Select the Options command in the Tools menu. The Options manager appears. 

2Select the Content tab. 

3Select the Enable Java check box and the Enable JavaScript check box. 

4Click the OK button. 

   

  

  

1.2 To Enable Java, JavaScript and ActiveX Controls in Internet Explorer 

  

The default settings in IE should be adequate; however, any display issues that you may encounter in the web could be due 
non-standard browswer settings. You should have the following set in Internet Explorer: 

  

1. Select Tools > Internet Options 

2. Select the Advanced Tab 

3. Use JRE 1.6.x should be selected. Note that your users should have Java 6 installed. 

  

 

  

1.3 Enable Scripting of Java Applets 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Scripting of Java Applets as shown below. 

  

 

1.4 Enable Active X Controls 

  

1. Select Tools > Internet Options 

2. Select Security Tab 

3. Select Custom Level... 

4. Enable Active X by selecting "Run ActiveX controls and plug-ins" 

  

 

2 Getting Started with the Web Client 
  

2.1 Logging into Projects 
  
  
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 
  
DevTrack supports two forms of authentication: 

DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
Windows NT Authentication:DevTrack can be setup so that users log into the web client via their Windows domain 
account login. 

  

To Log into Projects in the Web Client 

1. Select the DevTrack Web icon in the Start menu. 
  
  
  
  

 

  
  
The default URL to access the web client is as follows:http://%7bservername%7d/scripts/texcel/DevTrack/DevTrack.dll 
  
2. DevTrack Web login page is then brought up in your default web browser. Enter a login name (username) and password to 
log in.    
Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    
  

Login Name: terry-j  
Password: terry-j  
  

  

 
 
 
 
Note: Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3.Optional:To launch DevTrack Web in a new browser window, select the ‘Pop up a new browser window’ check box. 
  
4. Click theLoginbutton to get in. MyWork Dashboard page is displayed. 
  

        

  

2.2 Switching Views 
  

In DevTrack, a view is an interface that displays and organizes data in the client workspace. DevTrack supports three distinct 
views: the issue list view, report view, and knowledge view. 

Only one view is displayed in the workspace at a time.   

To Switch Views in the Web Client 
  
To switch views in the web client, select a view button in the menu bar. The DevTrack web client menu bar displays control 
buttons that enable project members to navigate between pages in the DevTrack web client. The menu bar is displayed in all 
DevTrack web pages. 

  

 
  
The menu bar consists of six buttons that enable project members to invoke commands: 
  

            The Home button navigates users back to the project selection page where they can choose the DevTrack 
project they like to log into. 
  

       The Issue List button allows users to navigate to the Issue List page (view). 
  

             The New button allows users to quickly submit a new issue to the project they are currently in.    
  

           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 
different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

2.3 Switching Projects 
 
 
The Switch Project command enables project members to exit one project and open another project without logging out of 
DevTrack. 
 
 
 
Using controls in the Home page, project team members may quickly switch between development projects in the DevTrack 
Web client. 
 
  

To Switch Projects in the Web Client 

  

Users can switch from one work project to another from the web client through the following steps: 

  

1Click on the Current Project control in the tool bar. 

  

   

  

  

2A list of availabble projects will be displayed beneath the tool bar. Select the project users would like to enter and click the 
OK button. 

  

  

3 Users are now brought to the target project.   

  

3 Understanding DevTrack Web Client Workspace 
  

The DevTrack web client is a “thin client” that enables project team members to view, manage, and track incidents, events, 
and customers through the Internet using a web browser. The client workspace organizes project data in multiple web pages 
called views. A view is an interface that displays and organizes data in the client workspace. 

Each web page is designed to track a specific type of data—issues, reports, knowledge items— and features tools that enable 
the user to perform tasks in that view Within each web page, project data may be organized into multiple frames and tool bars. 
The most important and most frequently used web page in DevTrack Web is the issue view. 

 

  

The workspace in each view is organized into three tiled panels: the tree panel, the list panel, and the detail panel: 

  

Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The 
folders displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a 
tabular list of columns and rows. 
  
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or 
specification in a series of tabbed pages. 
  

  

In addition to the information presented within each page, each page displays controls for navigating between pages: 

  

Tool Bar:The tool bar displays command buttons that enable project members to perform tasks within a specific page. 
The controls displayed in the Tool bar are specific to each page.   

  

Search Bar:The search bar contains controls that enable project members to filter the data displayed in the page.   

  

Tree Bar:The tree bar displays command buttons that enable the user to manage subproject folders in the tree panel. 

  

List Bar:The list bar displays command buttons that enable the user to manage development issues displayed in the list 
panel. 

  

Detail Bar:The detail bar displays command buttons that enable the user to manage the development issues displayed 
in the issue detail panel. The detail bar also displays cloning, interproject action and branch action commands. 

  

3.1 Understanding the Issue List Panel 

  

In DevTrack, list panels enable project members to quickly view high-level information about multiple work items in each view. 
The list panel shows high-level information about work items (issues, linked issues, specifications, events, and knowledge 
items) in a tabular list of rows and intersecting columns. 

  

3.2 Understanding the Subproject Tree Panel 

  

The folders and subfolders displayed in the subproject tree panel enable project team members to organize and manage work 
within a project. Each folder represents a distinct type of work. Folders displayed in the tree panel are of two 
categories:subprojectsandpersonal folders. 

  

3.2.1 Subprojects 

In DevSuite, subprojects enable development organizations to manage, schedule, and track iterations of development by 
organizing development tasks into distinct areas of development. 

  

A DevTrack project may support four distinct types of subprojects: regular subprojects, iteration group subprojects, iteration 
subprojects, and defect tracking subprojects. 

  

Regular Subproject:A regular subproject is a logical grouping of issues within a DevTrack project that enables 
development teams to schedule, prioritize, and track those issues separately from other issues in the project. 

  

Iteration Group Subproject:An iteration group subproject (also called amilestone subproject)is a tool for organizing, 
managing, and tracking the development tasks that define a project milestone such as the completion of a version or build 
of a product. 

  

Iteration Subproject:An iteration subproject (also called asprint subproject) is a tool for organizing, managing, and 
tracking a set of implementation tasks within a set time period. The iterative subproject defines the tasks that must be 
completed to meet the goal of an iteration. 

  

Defect Tracking Subproject:A defect tracking subproject is a subproject designed to manage the development issues 
related to a specific iteration of development. 

  

  

3.2.2 Personal Folders 

In DevTrack, a personal folder is a tool for organizing the development issues that are assigned to project team members, 
receiving development issues by issue or event notifications and escalation, and viewing the workload of their team members. 

  

Personal folders are organized within two root personal folders: the My Personal Folder and the Team Member’s Folder. 

The My Personal Folder contains personal folders that contain issues assigned to the project member. Project 
members may drag and drop issues into these folders. 

  

The Team Member’s Folder contains personal folders belonging to other project members belonging to the same 
group. 

3.3 Understanding the Issue Detail Panel 

The detail panel displays detailed information about the work items (issues, subprojects, or specifications) managed in a 
DevTrack project. 

  

Issue Detail Panel:The issue detail panel displays detailed information about a single development issue in multiple 
tabbed pages. 

  

Subproject Detail Panel:The subproject detail panel displays detailed information about a single subproject folder in 
multiple tabbed pages. 

  

Specification Detail Panel:The specification detail panel displays detailed information about a single specification. 

  

Note:Use the subproject tree bar to switch the display of detail panel between issues/specifications and subprojects. Click the 

Issue List Mode button  for the detail panel to display the highlighted issues or specifications. Click the Edit Mode button

 for the detail panel to display the properties of the highlighted subproject.  

            

  

3.4 Understanding the Tool Bar 

  

The tool bar displays buttons and controls that enable project team members to perform common tasks such as switching 
between projects and views or defining personal preferences. 

  

  

 
  

  
The menu bar consists of six buttons that enable project members to invoke commands: 
  
            The Home button navigates users back to the project selection page where they can choose the DevTrack 

project they like to log into. 
  
       The Issue List button allows users to navigate to the Issue List page (view). 

  
             The New button allows users to quickly submit a new issue to the project they are currently in.    

  
           The Report button allows users to navigate to the Report View where they can generate a variety of reports for 

different purposes. 

          The Settings button navigates users to the user configuration page where they can manage user preferences 

     The Knowledge button allows users to navigate to the knowledge base. 

              The Exit button allows users to log out of the web client. 

  

  

  

  

  

3.5 Understanding the Search Bar 

  

The search bar displays buttons and controls that enable the user to perform common work item management tasks such as 
submitting new issues, defining queries, or filtering the items displayed in the list panel based on predefined queries. 

  

 

  

  

The search bar is divided into two primary controls:list panel filtersandcommand buttons. 

  

3.5.1 List Panel Filters 

  

Filter controls in the search bar enable project team members to filter the work items displayed in the list panel based on its 
property values. The search bar displays four kinds of filter controls: 

  

Owner:The User dropdown list enables the user to filter the work items displayed in the list panel by owner. 

  

Status:The Status dropdown list enables the user to filter the work items displayed in the list panel by status, workflow 
state, and state group. 

  

Query:The Query dropdown list enables the user to filter the work items displayed in the list panel using a saved query. 

  

Go To:The Go To control enables the user to filter the work items displayed in the list panel by ID number or text 
strings. 

  

  

3.5.2 Command Buttons 

Command buttons in the search bar enable project team members to submit new issues, define queries, and personalize the 
display of work items in the client. The search bar displays seven command buttons.  

  

Refresh:The Refresh button enables the user to “refresh” the data displayed in the client workspace by reloading 
the web page. 

  

Quick Search: The Quick Search button enables the user to view the Quick Search controls in the client 
workspace.  

  

Search:The Search button enables the user to define a query that filters the development issues displayed in the list 
panel based on issue property values. 

  

Cancel Search:The Cancel Search button enables the user to cancel the query used to filter the development 
issues displayed in the list panel. 

  

Show/Hide Detail Panel:The Show/Hide Detail Panel enables the user to show or hide the detail panel in the client 
workspace. The detail panel may display detailed information about a single issue, subproject, or specification. 

  

New Issue:The New Issue button enables the user to define and submit new development issues to the project. 

  

Multiple Tab Presentation/ One Page Presentation: This modal button is used to indicate how the information in 
the detail panel is displayed. Multiple tab presentation enables users to view work item info in multiple tabs, while one 
page presentation enables users to view all the info associated with a work item within a single page.  

  

3.6 Understanding the Tree Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the tree panel enables project team members to manage the subprojects 
displayed in the subproject tree panel. Subproject management is the process of defining and managing subprojects in a 
development project.   

Subproject management tasks may be performed in the DevTrack client or the DevPlan client. In development projects using 
DevPlan, many subproject management commands are read-only in the DevTrack client. 

  

                   

  

3.6.1 Standard Commands 

Four commands are always accessible in the Actions menu in the subproject tree panel: 

  

Property:The Property command enables the user to view and edit the properties of a selected subproject. 

  

Show/Hide Closed Subproject: The Show/Hide Closed Subproject command enables the user to either hide or 
display closed subprojects in the subproject tree panel. 

  

Move:The Move command enables the user to move the selected subproject to a different location in the subproject 
hierarchy. 

  

Refresh:The Refresh command enables the user to see the changes made to the subproject tree by refreshing the tree 
panel. 

  

  

3.6.2 Subproject Management Commands 

  

Four subproject management tasks are displayed in the Actions menu in the tree panel when DevPlan support is not enabled 
for a project: 

  

New Sub-Project as Child:The New Subproject as Child command enables the user to add a subproject as the child of 
the selected subproject. 

  

New Sub-Project as Sibling above:The New Subproject as Sibling Above command enables the user to add a sibling 
subproject immediately above the selected subproject. 

  

New Sub-Project as Sibling below:The New Subproject as Child Below command enables the user to add a sibling 
subproject immediately below the selected subproject. 

  

Delete:The Delete command enables the user to delete the selected subproject. 

  

Note:When DevPlan is enabled for a project, all the subproject management tasks can only be done through the DevPlan 
client. All the subproject management commands will show as read-only in the DevTrack client. 

3.7 Understanding the List Panel Tool Bar and Actions Menu 

  

In the DevTrack Web client, the tool bar and the Actions menu in the list panel enables project team members to manage the 
development issues displayed in the issue list panel. 

 

  

The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
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The number and type of commands displayed in the list panel Actions menu depend on the features enabled in a DevTrack 
development project. 

  

 

  

3.7.1 List Bar Commands 

  

Below are the commands available in the list bar: 

Show specifications:The Show specifications command enables the user to view the specification associated with 
the development issues in the list panel. 

  

Show items of child folders:The Show items of child folders commandenables the user to view the development 
issues belonging to the selected subproject and all descendent child subprojects in the list panel. 

  

Hide items of child folders:The Hide items of child folders commandenables the user to view just the development 
issues belonging to the selected subproject in the list panel. 

  

Group Change/Group Action:The Group Change/ Group Action buttons displayed in the list bar enable the user to 
update the progress status or the field values of multiple issues at the same time. 

  

Delete:The delete button displayed in the list bar enables the user to delete selected development issues from the 
DevTrack system. 

3.7.2 Standard List Panel Commands in the Actions Menu 

  

 

  

Below is a list of commands that are available in the tree panel Actions menu: 

  

Customize Page:The Customize Page command enables the user to choose which columns are displayed in the list 
panel. 

  

Sort:The Sort command enables the user to sort the development issues displayed in the list panel based on issue 
property values. 

  

Add Notes:The Add Notes command enables the user to add notes to the selected development issue(s). 

  

Links:The Links command enables the user to define links between selected issue and other development issues 
across the projects. 

  

Clone:The Clone command enables the user to define a copy of the selected development issue. 

  

Email:The Email command enables the user to send a copy of the development issue by email. 

  

Show specifications:The Show specifications command enables the user to view the specification associated with the 
development issues in the list panel. 

  

Change Subproject:The Change Subproject command enables the user to reassign a development issue to a different 
subproject. 

  

Move to Backlog:The Move to Backlog command enables the user to move one or move development issues to the 
product backlog for planning purposes. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
selected development issue. 

  

Change Issue Type:The Change Issue Type command enables the user to change the issue type of a selected 
development issue. 

  

3.8 Understanding the Detail Panel Actions Menu 

  

In the DevTrack Web client, the Actions menu in the detail panel enables project team members to manage the issues and 
subprojects displayed in the detail panel. The issue detail panel Actions menu may display many different commands as 
shown below: 

  

                  

  

  

Customize Page:The Customize Page command enables the user to choose which pages (tabs) are displayed in the 
issue detail panel. 

  

Subproject Links:The Subproject Links command enables the user to view and define the linked primary 
specifications, and linked knowledge, requirements, and specifications for the subproject to which the selected issue 
belongs to. 

  

Notes:The Notes command enables the user to add notes to the development issue selected in the list panel.  

  

Links:The Links command enables the user to view and define links to development issues, knowledge, requirements, 
and specifications. 

  

Events:The Events command enables the user to create and manage events associated with the selected development 
issue. 

  

Move to backlog:The Move to backlog command enables the user to move the selected development issue to the 
product backlog for planning purposes. 

  

Issue Time Track:The Issue Time Track command enables the user to view and define issue time track entries of the 
selected work item in the list panel. 

  

Clone:The Clone command enables the user to define a copy of a development issue. 

  

Email Subscription:The Email Subscription command enables the user to subscribe to notifications for the 
development issue. 

  

View Workflow Graph:The View Workflow Graph command enables the user to view a workflow diagram for a 
development issue. . 

  

Print:The Print command enables the user to print a development issue. 

  

Tip:Use the refresh button  in the issue detail bar to refresh the detail panel whenever a change is made. 

  

  

 Chapter 3- DevTrack Windows Client Basics 
lass="WIKI_section_title WIKI_section_level_1" title="Title of section level 1">Getting Started in DevTrack Windows Client

1 Logging into Projects 
 
 
DevTrack implements project-level security by assigning a unique username, password, and account type to every project 
team member. 

DevTrackWindows Clientsupports two forms of authentication: 
 
 
 

1.DevTrack Login Name and Password:Users can register their own login and password through the Admin Console 
and use that to login to their system. 
  
2. LDAPAuthentication:DevTrack can be setup so that users logginginto thewindowsclientwill be authenticatedvia 
theirActive Directory. 
 
  
  
  

 To log into projects in the Windows Client: 

 
1. Select the DevTrackClienticon in the Start menu. 
  

 
  
  
  
2. DevTrack loginwindow will pop up. Enter a login name (username) and password to log in.    
    Users who do not have a username and password can login with the built-in sample user that TechExcel offers:    

Login Name: terry-j  
Password: terry-j  
  
  

 
  
Note:Password is case-sensitive. Please make sure that you enter the password correctly. 
  
3. Click theOKbutton tologin.The ‘Select Project to Login’window is displayed. Users will see a list of projects they have 
access to with the number of open issues associated with them in each project. 
  
Highlight the project users wishing to get in and select the OK button. Users can also use theSelect Projectdropdown list to 
choose the project. 
  

 

  

1.1 Switching Projects in the Windows Client 

DevTrack users can use theSwitch Projectcommand to switch between working projects without logging out.  

1Select theSwitch Projectcommand. In thewindows client project members may access the Switch command 
usingfollowingmethods: 

Press CTRL+W. 
SelectSwitch Projectcommand in the File menu. The Select Project to Loginwindowappears. 
2Select a project from the Select Project dropdown list. 

3Select the OK button. 

  

1.2 Switching Views in the Windows Client 
  
In the Windows client, project members may use view buttons, keyboard shortcut commands, or View menu commands to 
switch between DevTrack views. 
  
Usingview buttonsto switch views: 
  

Click the Main icon for the Issue View 
 
 
 
Click the Report icon for the Report View. 
 
 
 
Click the Knowledge icon for the Knowledge View 
 
 
 
Click the DevPlan icon for the DevPlan View 
 
(Note:This view is only available if you own the DevPlan module and have it enabled fortheproject) 

         
  
Using keyboard shortcuts to switch views: 
  

Press CTRL+M for themain Issueview 
Press CTRL+R for the Report view 
Press CTRL+D for theKnowledgeview 

  
  

1.3 Reconnecting to the DevSuite Server 
Occasionally, project members may lose their connection to the DevSuite Server; for example, when the network goes down. 
DevTrackwindows users may reconnect to the DevSuite Server using the Reconnect command. 

The Reconnect command may be invoked by two methods: 

Press CTRL + B. 
Select the Reconnect command in the File menu. 

  

1.4 Reloading Issue Data 
The Reload command enables project members to reload issue data in the issue list panel. The Reload command ensures 
that the most recent data is displayed in thewindows client. 

DevTrackwindows client users may reload issue information by two methods: 

Press F6. 
Select the Reload command in the File menu. 

1.5 Refreshing the Issue List 
The Refresh command enables project members to refresh issue data in the issue list panel. The Refresh command ensures 
that the most recent data is displayed in the client. 

Windows clientuserscan refresh the issue list panel by two methods: 

Press F5. 
Select View > Refresh Issue List. 

  

1.6 Reloading Project Settings 
The Reload Project Settings command enables project members to reload project definition settings. 

DevTrackwindows client users may reload project settings by two methods: 
  

Press F7. 
Select the Reload Project Settings command in the File menu. 

1.7 Exiting Projects 
The Exit command enables project members to exit a project and close the client. 

To exit a project,select theExitcommand in the File menu. 

  

2 Understanding DevTrack Windows Client Workspace 
  
The client workspace organizes project data in multiple views. A view is an interface that displays and organizes data in the 
client workspace. Each view is designed to track a specific type of data—issues, reports, knowledge items— and features 
tools that enable the user to perform tasks in that view. 
  
Within each view, project data may be organized into multiple panels and tool bars. The most important and most frequently 
used view in DevTrack Client is the issue view. 
Take the issue view for example. The workspace in this view is organized into three tiled panels: the tree panel, the list panel, 
and the detail panel. 
  

 
Tree Panel:The tree panel organizes work items into a hierarchical structure consisting of folders and subfolders. The folders 
displayed in the tree panel may represent regular subprojects, iteration subprojects, or personal folders. 
  
List Panel:The list panel displays high-level information about work items (incidents, events, or specifications) in a tabular list 
of columns and rows. 
  
Detail Panel:The detail panel displays detailed information about a single development issue, subproject, or specification in a 
series of tabbed pages. 

3 Using Keyboard Shortcuts in the Windows Client 
  
Keyboard shortcuts are combinations of keystrokes that enable users to perform apredefined function quickly. Keyboard 
shortcuts generally consist of a modifier keyand a hot key or function keys. 
  
In the DevTrack Windows client, two types of keyboard shortcuts are supported:system keyboard shortcuts and issue 
management keyboard shortcuts. 
System keyboard shortcuts provide project members with quick access to commands that are otherwise available in the menu 
bar or tool bar. 
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager. 

3.1 System Keyboard Shortcuts 
 
 
Many of the system-level DevTrack commands that are available in the menu bar andthe tool bar are also accessible through 
keyboard shortcuts: 
  
CTRL + A                 The Select All command enables project members to undo changes made to a DevTrack issue. 
  
CTRL + B                 The Reconnect command enables project members to reconnect to the DevTrack Database Server. 
  
CTRL + C                 The Copy command enables project members to copy text entered into a DevTrack edit box control. 
  
CTRL + D                 The Knowledge View command enables project members to display the knowledge view. 
  
CTRL + G                 The Go To command enables project members to find DevTrack issues by issue ID number or keyword. 
  
CTRL + L                  The Login command enables project members to log into a DevTrack project. 
  
CTRL +M                 The Main View command enables project members to display the main view. 
  
CTRL + N                 The New command enables project members to create new issues. 
  
CTRL + P                 The Print command enables project members to print issues. 
  
CTRL + Q                The Load Query command enables project members to search for DevTrack issues using a predefined 
query. 
  
CTRL + R                 The Report View command enables project members to display the Report view. 
  
CTRL + S                 The Search command enables project members to filter the issues displayed in the issue list panel based 

on  user-defined  parameters and criteria. 
  
CTRL + V                The Paste command enables project members to paste text into a DevTrack edit box control. 
  
CTRL + W               The Switch Project command enables project members to switch between projects. 
  
CTRL + X                The Cut command enables project members to cut text entered into a DevTrack edit box control. 
  
CTRL + Z                The Undo command enables project members to undo changes made to a DevTrack issue. 
  
F4                           The Save command enables project members to save changes made to DevTrack issues. 
  
F5                           The Refresh Issue List command enables project members to refresh the records displayed in the issue list

panel. 
  
F6                           The Reload command enables project members to reload information for a single issue. 
  
F7                           The Reload Project Settings command enables project members to reload project settings. 
  
  

3.2 Issue Management Keyboard Shortcuts 
  
Issue management keyboard shortcuts enable project members to quickly browse and edit issues in the Update Issue 
manager: 
  
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in the 

Update Issue manager. 
  
CTRL + N                 The Next command enables project members to view the next development issue in the Current Status in 

the Update Issue manager. 
  
CTRL + P                  The Previous command enables project members to view the previous development issue in the Current 

Status in the Update Issue manager. 
  
  

4 Printing DevTrack Issues 
  
The DevTrack Windows client enables project members to print copies of development issues. Using tools in the Print dialog 
box project members may select one or multiple DevTrack issues for printing, preview the printout, define the number of 
copies, or create page breaks between the issues printed. 
  
Project members may define the level of detail in the printout: 
  
The Detail option prints the values in the Issue ID, Title, Description, Type, Priority, Version, Submitted By, Assigned By, 
Component, Progress Status, Platform, Date Assigned, Date Submitted, and Current Owner fields for each issue.   
The Brief option prints the values in the Issue ID, Title, and Description fields for each issue. 

4.1 To Print DevTrack Issues 
  
1Select the Print command: 
  

Select File > Print in the menu bar. 

Press CTRL + P. The Print dialog box appears. 
 

 

 
 
 
2Select a printer in the Printer dropdown list. 
  
3Select an option in the Description area. 
  

Select the Detail radio button to print a detailed information about the issue. 
Select the Brief radio button to print high-level information about the issue. 

  
4Select the issues to be printed: 
  

Select the All Listed radio button to print every issue displayed in the issue list panel. 
Select the Selected Ones radio button to print every only selected issues in the issue list panel. Enter the Issue ID in the 
field. 

  
5 Optional: To place a page break between the issues printed, select the Page Break Between Issues check box. 
  
6 Optional: To print multiple copies of the printout, select a number in the Number of Copies control. 
  
7Click the OK button. 
  

  

4.2 To Set Up Pages for Printing 
  
1Select File > Page Setup in the menu bar. 
   The Page Setup dialog box appears. 
  
2In the Orientation area define the orientation of the print out. 
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
3In the Measurement area define the system of measurement for the print out. 
  
Select the Inches radio button to define page layout in inches. 
Select the Centimeters radio button to define page layout in centimeters. 
Select the Points radio button to define page layout in points. 
Select the Pica radio button to define page layout in picas. 
  
4In the Margins area define the left, right, top, and bottom margins for the print out. 
  
5Click the OK button. Project members may view printout previews a page at a time or two pages at a time. 
Project members may also use controls in the printout preview page to print, navigate between pages, and zoom in or zoom 
out on the printout. 
  
  

4.3 To Preview Issue Printouts 
  
  
1Select the Print command. 
Select File > Print in the menu bar. 
Press CTRL + P. The Print dialog box appears. 
  
2Define print settings. 
  
3Click the Preview button. A preview of the printout is displayed. 
  
4Click the OK button. 
  
  

4.4 To Define Printer Settings 
  
  
1Select File > Print Setup in the menu bar. 
   The Print Setup dialog box appears. 
  
2Select a printer from the Name dropdown list. 
  
3Click the Properties button to define printer properties. 
  
4In the Paper area define the size and source of the paper. 
  
Select a paper size from the Size dropdown list. 
Select a paper source from the Source dropdown list. 
  
5In the Orientation area define the orientation of the print out. 
  
Select the Portrait radio button to print in Portrait mode. 
Select the Landscape radio button to print in Landscape mode. 
  
6Click the OK button. 
  

 Chapter 4- Issue Submission 

In this chapter: 

• Understanding Development Issue Management 

• Submitting Development Issues 

• Editing Development Issues 

• Forwarding Development Issues 

• Closing, Reopening, and Deleting Development Issues 

 
 

1 Basic Issue Management Tasks 
 
Basic issue management consists of six basic tasks: the submit, update, forward, close, reopen, and delete actions. 
Submit                  To submit an issue is to create a new issue in a DevTrack project. 
Edit                        To edit an issue is to update issue properties in the DevTrack client. 
Forward                To forward an issue is to change the issue workflow state of an issue or to change the issue owner of 

an issue. 
Close                      To close an issue is to forward an open issue to a closed issue workflow state. 
Reopen                  To reopen an issue is to forward a closed issue to an open issue workflow state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. 
All basic issue management tasks are privilege-based. The ability of a project member to submit, update, forward, 
close, or reopen a development issue is based on their account type. For more information see understanding Issue 
Management Privileges. 
 
 
 
 
 

2 Understanding Development Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes, enhancements, or 
features in workflow. All development tasks are represented and tracked in the project asdevelopment issues. An issue
is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. All basic issue properties may be managed and tracked in the Description page, the 
Current Status page, and one or more custom pages in the DevTrack client. 

  

Project members may define, update, and manage issue data, add notes, note attachments and screen shots, view 
issue history, or create links between related issues in the DevTrack Web and Windows clients. 

2.1 Understanding Issue Management Tasks 
Issue management is the process by which the development team guides development issues through the 
development life cycle. Issue management may be divided into two categories: basic tasks and advanced tasks. 

2.2 Understanding Issue Types and Subworkflows 
DevTrack features anissue-basedsubworkflow model that provides development teams with greater power and 
flexibility to manage subprojects and issues. Multiple workflow enables development organizations to assign different 
workflow paths (subworkflows) to the issues (bugs, features, enhancements) managed in a project. 
An issue type is class of development issues that are managed by a distinct set of workflow rules. Each issue type is 
managed within asubworkflow. A subworkflow is a unique issue life cycle and corresponding workflow rules that are 
designed to managed a specific issue type. 
Issue typing offers development team maximum flexibility and power to customize project workflow to support and 
manage their business processes. Development organizations may define as many different issue types are necessary 
to manage development issues in their project. The DevTrack Sample Project includes seven different types of 
development issues. 

Bug Report                                           Change Request 
Documentation                                    Future Enhancement Minor 
Improvement                                        New Feature 
Third Party 

Each of these issue types represent very different and are best managed using business processes and workflow rules 
that are uniquely tailored to the work required. 
DevTrack subworkflow assignment rules may be defined by subproject or byissue type. The issue type of an issue is 
typically linked to its type definition (for example, bug, new feature, enhancement), but alternatively may be linked to its 
priority, component, platform, build, version, or any other criteria. 
Using the issue-type subworkflow model, each subproject may manage many different types of issues that are subject 
to different workflow rules. Development organizations may define subprojects for groups, teams, individuals, 
components, builds, or any other criteria that is useful to their business. 

2.3 Submitting Development Issues (Transition-Based Workflow) 
In projects using transition-based workflow, project members may manage issues by performingactions. An action 
represents a transition between two issue workflow states. A submission action represents a transition between the New
issue workflow state and another issue workflow state. One or more action buttons are displayed in the action bar of the 
DevTrack clients. One action button is displayed for each transition between the current issue workflow state of the 
development issue and other issue workflow states. The New Issue page may display the Description page, the Current
Status page, one or more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.4 Submitting Development Issues (State-Based Workflow) 
In projects using state-based workflow, project members may manage issues by directly changing the issue workflow 
state of the issue in the Issue Status control. Project members may use controls in the New Issue page to define and 
submit new DevTrack issues. The New Issue page may display the Description page, the Current Status page, one or 
more custom pages. 
The steps required to submit an issue depend on many different factors including administrator-defined customizations, 
administrator-defined workflow rules, the account type of the user submitting the issue, the client used (Windows-based 
or Web-based), and the workflow model (state-based or transition-based). 

2.5 Understanding Issue Criterion Triggers 
An issue creation trigger is an administrator-defined business rule that automates the submission and linking of 
development issues in DevTrack projects based on changes to the issue workflow state of an issue. Project 
administrators may define two types of issue creation triggers: automatic issue creation triggers and interactive issue 
creation triggers. 
Automatic Issue Creation                   Trigger An automatic issue creation trigger automatically creates and submits a 

new development issue whenever trigger criteria are met. The project member cannot edit the 
issue before it is submitted. 

Interactive Issue Creation                  Trigger An interactive issue creation trigger requires input from a project member 
before it can be submitted to a project. Once the trigger criteria is met, the project member is 
prompted to submit a new development issue. The project member may edit the issue before it 
is submitted. 

Issue creation triggers may automatically create new issues in specific subprojects and define links between the 
autocreated issue and the issue that triggered its creation. 
Project administrators may define issue creation triggers for each issue workflow state in issue workflow. The criteria 
required to set off a trigger depend on the workflow model used in a project. 

In a state-based workflow model, issue creation triggers are always based on changes to a particular issue 
workflow state. 
In a transition-based workflow model, issue creation triggers may be based on actions or changes to a 
particularissue workflow state. 

 

3 Editing Development Issues 
A development issue is a collection of data that represents a particular task or set of tasks that must be processed in the
course of a development project. The issue provides the development organization with a central hub for collecting and 
communicating information about specific development tasks and for tracking that effort throughout the development life
cycle. 
In the course of its life cycle, a development issue may owned by many different project members and pass through 
many workflow states. At each stage of the issue life cycle, project members may add comments, work descriptions, 
documents, and update issue property definitions to keep the others in the organization informed of their progress. 
In DevTrack, project members have two primary tools for editing development issues: the issue detail panel or the 
Update Issue page. 
The issue detail panel displays detailed information about a single development issue in multiple tabbed pages 
including theDescription page, the Current Status page, the Notes page, and many other pages. 
The Edit Issue window that displays multiple tabbed pages including the Description page, the Current Status page, the 
Notes page, and many other pages. 

3.1 Editing Issues in the Edit Issues Page 
The Edit Issue Window may display multiple pages including the Description page, Current Status page, the Notes page
and one or more custom pages. 
  

 

The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 

3.1.1 To Edit a Development Issue 
1Click the Edit button in the action bar. The Update Issue manager appears. 
2Optional: To move the issue to a different subproject, click the Subproject Ellipsis button and select a subproject from
the dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects
in the project. If this option is not enabled the Subproject dropdown list is not displayed. 
3Optional: Click an action button in the Action bar. In transition-based projects, project members may change the 
workflow state of issues by performingactions. Each action represents a transition between the current workflow state 
and another workflow state. The Update Issue manager displays one action button for each transition connecting the 
current workflow state with other applicable workflow states. The number of action buttons displayed and the names of 
the button depend entirely on administrator-defined workflow rules. 
4Define issue properties in the Current Status page. The Current Status page enables project members define and 
track the history of work performed on a development issue. Data-entry controls displayed in theCurrent Status page 
include the Progress Status, Issue Owner, Sub-status, the Target Release, and the Work Description controls. 
5Optional: Update issue properties in the Description page. The Description page displays data-entry controls that 
enable project members to define the basic nature of the issue. Once defined, the issue properties tracked in the 
Description page do not generally change during the life cycle of an issue. 
6Optional: Define issue properties in custom pages. Project administrators may define one or more custom pages. 
Custom pages may display custom-defined data-entry controls that may or may not be mandatory on submission. 
7Optional: Add a note or note attachment to the issue in the Note page. Project may add or update notes to DevTrack 
issues whenever they update an issue. 
8Click the Submit button. 

  

3.2 Using Issue Editing Navigation Controls 
  
Issue navigation controls displayed in the action bar of the Edit Issue page enable project members to quickly navigate 
between development issues without exiting edit mode. Issue editing navigation controls include: the Previous button, 
the Next button, and the Issue Navigation dropdown list. 

 

The Issue dropdown list enables project members to switch between issues without closing the issue editing manager. 
The Next and Previous buttons enable project members to move from one development issue to the next with a click of 
the button. 
The Refresh button reloads an web client so that changes made to the development issue are displayed in the work 
area. 
All changes to development issues are saved the moment the moment that the project member navigates to another 
issue. 
Clicking the Next button or Previous button automatically saves the changes made to the current issue and displays the 
next issue in the sequence. 
Project members may edit issues based on administrator-defined access controls and workflow rules. If the user 
navigates to an issue that they cannot edit, they have the option to view that issue in read-only mode or to skip to the next
issue in the sequence. 

3.3 Understanding Issue Editing Keyboard Shortcuts 
In the DevTrack Windows client, project members may use keyboard shortcuts to quickly browse between development
issues in the Windows client. Keyboard shortcuts are combinations of keystrokes that enable users to perform a 
predefined function quickly. Keyboard shortcuts generally consist of a modifier key and a hot key or function keys: 
CTRL + O                 The Owner command enables project members to select the Owner control in the Current Status in 
the 

Update Issue manager. 
CTRL + N                The Next command enables project members to view the next development issue in the Current 
Status in 

the Update Issue manager. 
CTRL + P                The Previous command enables project members to view the previous development issue in the 
Current 

Status in the Update Issue manager. 

3.4 Editing Issues in the Issue Detail Panel 
The issue detail panel displays detailed about a single development issue in multiple tabbed pages: the Description 
page, the Current Status page, the Notes page, and many other pages. 
  

 

By default, the pages in the issue detail panel are editable and project members may use the controls in these pages to 
edit development issues. 
However, the pages and controls in the issue detail panel of the DevTrack Windows and DevTrack Web clients may be 
defined as read-only in DevTrack projects. If issue locking is enabled in a DevTrack project, project members must use 
the Edit Issue page to edit development issues in the client. 

  

3.4.1 To Display Issue Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail panel, click the
Issue Detail button  in the search bar. 

3.4.2 To Edit an Issue in the Issue Detail Panel (Web Client) 
1Select the issue in the issue list panel. 
2Click the Edit button in the Issue Detail bar of the issue detail panel. 
  A red Edit button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 
3Edit issue properties in the Description, Current Status, and other pages. 
4Click the Save button. 
  The edited issue is saved. 

3.4.3 To Edit an Issue in the Issue Detail Pane (Windows Client) 
1Select the issue in the issue list panel. 
2Edit issue properties in the Description, Current Status, and other pages. 

3.5 Understanding Workflow Field Resrictions 
A workflow field restriction is an access control that determines which issue properties are updated in an issue workflow 
state. 
The data-entry controls displayed in the Description page, Current Status page, and custom pages may be defined as 
mandatory, read-only, or invisible in each issue workflow state. 
Mandatory Field   A mandatory field is a data-entry control that must be defined before the issue may progress to the 

next stage in its life cycle. Mandatory fields may be defined on a state-by-state basis. 
Read-Only Field   A read-only field is a data-entry control is displayed but not editable in the DevTrack client. Data-entry 

controls may be defined as read-only fields based on account type-based access controls or state-based 
workflow rules. 

Invisible Field      An invisible field is a data-entry control is not displayed in the DevTrack client. Data-entry controls may 
be defined as invisible fields based on account type-based access controls or state-based workflow rules. 

  
Workflow field restrictions are based on the workflow state of an issue and not the account type of the project member. 
Project administrators may also define fields as read-only fields or invisible fields to particular account types. 

  

3.6 Understanding Quick Actions 
A quick action is a transition between two workflow states in which the project member may update the issue owner and 
issue workflow state, but no other issue properties. All other data-entry controls in the issue manager are read-only. 

3.7 Understanding User Identity Authentication 
User authentication enables development teams to ensure that key transition and state changes to issues and events 
are approved in DevTrack projects. 
Development teams may wish to restrict certain issue or event changes to certain project members. DevTrack account 
types and workflow rules are designed to ensure that only project members with the appropriate privileges may make 
changes in projects. 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Identity authentication on issue state or transition changes: Issue authentication rules may require that project 
members enter their password before an issue can be updated based on transitions or state changes identified by
the administrator. 
Identity authentication on event state or transition changes: Event authentications rules may require that project 
members enter their password before an event can be updated based on event templates and event states 
identified by the administrator. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. 
 Project members are prompted to enter their password whenever they attempt to update an issue or event covered by 
an authentication rule. 

4 Forwarding Development Issues 
DevTrack issues enable organizations to manage and track development tasks through each stage of the development 
process. Each stage in the development life cycle is represented by an issue workflow state. 
The issue property values tracked in the Current Status page are especially important when forwarding a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Sub-status, 
the Target Release, and the Work Description controls 
In DevTrack, toforwardan issue is to change its issue workflow state or owner. 
Workflow State    The workflow state of an issue is a stage is the life cycle of the issue. Issues may be forwarded to a 

issue workflow state only if a transition exists between the current issue workflow state and the target 
workflow state. 

Issue Owner          The issue owner is the project member that is responsible for an issue. The ability of project 
members to edit and forward DevTrack issues is determined by their account type and the workflow state of 
the issue. 

  
Project members typically also change the issue owner, issue substatus, and add a note or attachment when forwarding 
an issue. 
Project members with the appropriate privileges may forward issues from one issue workflow state to other applicable 
workflow states using controls in the DevTrack Windows and web clients. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

 

4.1 Forwarding Issues (Transition-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using transition-based workflow, 
issues are forwarded to new workflow states or owners by means ofactions. In DevTrack, an action is a transition 
between two issue workflow states or between an issue workflow state and itself. Every action that a project member 
may perform is represented by an action button in the Action bar of the DevTrack clients. 
  

 

Issues may be forwarded to an issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. Multiple transitions may exist between workflow states each of these transitions may be 
defined by different transition-dependent workflow rules. Note also, that transitions may exist be between a workflow 
state and itself. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 
  
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

Transitions to open states appear as gray boxes with blue text as illustrated in the picture on the right. 

Transitions to closed states appear as gray boxes with red text as shown on the right. 

One action buttons is displayed for each transtion that may be performed by the user. Transition-dependent workflow 
rules may restrict the actions that a project member may perform based on their account type. For more information see
“Understanding Who Can Perform Rules” 
Applicable owner rules define which which project members may own issues in each workflow state. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. Data-
entry controls may be defined as mandatory, read-only, or invisible in each state or transtion. 

4.1.1 To Forward Issues (Transition State) 
1Select an issue in the issue list panel. 
2Click an action button the issue detail bar. 
 In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. The Forward Issue page 
appears. 
3Select an applicable owner from the Forward To control in the Current Status page. 
The options displayed in the Forward To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 

Note:Project members may only forward issues to other project members within and outside their group if they 
belong to an account type that has been assigned the appropriate privileges. 

4Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. 
If the simplified action option is selected the Forward Issue manager displays only one page. If the detailed action 
option is selected the Forward Issue manager displays multiple editable pages. 
5Optional: To forward the issue to a subproject, click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
6Click the OK button. The issue is forwarded and reassigned to the selected project member. If the project 
administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking.  

4.2 Forwarding Issues (State-Based Workflow) 
To forward an issue is to change its issue workflow state or issue owner. In projects using state-based workflow, issues 
may be forwarded to new workflow states or owners by updating issue property definitions in the client. 
Project members may change the workflow state of an issue by selecting a workflow state in the Progress Status control
in the Current Status page. The options displayed in the Progress Status control represent the next workflow state in the 
life cycle of the issue. 
  

 

Issues may be forwarded to a issue workflow state only if a transition exists between the current issue workflow state 
and the target workflow state. In state-based projects, project members must forward an issue to change its workflow 
state. The Progress Status control is read-only in the issue detail panel. 
The pages and controls that are displayed in issue detail panel are defined by the account type-based privileges 
granted to the user and administrator-defined workflow rules. 

An issue may only be forwarded to a workflow state if a transition exists between the current workflow state and the
target workflow state. State-dependent workflow rules ensure that only applicable workflow states are displayed in 
the Issue Progress list of the Current Status page. For more information seeUnderstanding Who Can Perform 
Rules. 
An issue may only be forwarded to project members that have been designated as applicable in the target 
workflow state. Applicable owner rules ensure that only applicable owners are displayed in the Owner list of the 
Current Status page. 
Workflow field restriction rules define which issue properties may be defined or edited in each state or transition. 
Data-entry controls may be defined as mandatory, read-only, or invisible in each state or transition. 

4.2.1 To Display Issues Detail Panel (Web Client) 
The issue detail panel may be displayed or hidden in the web client work area. To display the issue detail 
panel, click the Issue Detail button   in the search bar. 

4.2.2 To Forward an Issue (Web Client) 
1Select the issue in the issue list panel. 

2Click the Forward button  in the issue detail bar of the issue detail panel. 
A red Forward button is displayed in the issue detail bar and editable pages are displayed in the issue detail panel. 

3Select an issue owner in the Owner list. 
The Owner list displays all applicable issue owners based on administrator-defined workflow rules. 

4Select an issue workflow state in the Progress list. 
The Progress list displays all applicable issue workflow states based on administrator-defined workflow rules. 

5Click the Save button. 
The issue is forwarded. 

4.2.3 To Forward an Issue (Windows Client) 
1Select the Forward command. 
The Forward Issue manager appears. 
2Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. 
Project members may select a subproject if the project administrator has enabled support of subprojects in the project. 
If this option is not enabled the Subproject dropdown list is not displayed. 
3Select an applicable workflow state from the Progress Status control in the Current Status page. 
The options displayed in the Progress Status control represent the next workflow state in the life cycle of the issue 
4Select an applicable owner from the Assigned To control in the Current Status page. 
The options displayed in the Assigned To control are based on two factors: the project members forwarding privileges 
and state-dependent Applicable Owner rules. 
5Optional: Define issue properties in the Current Status page, Description page, and appropriate custom pages. 
Administrators may define forwarding actions assimplified actionsordetailed actions. If the simplified action option is 
selected the Forward Issue manager displays only one page. If the detailed action option is selected the Forward Issue 
manager displays multiple editable pages. 
6Click the OK button. 
The issue is forwarded. If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time 
Track page may appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack 
Time Tracking 

4.3 Understanding Simplified and Detailed Actions 
In both state-based projects and transition-based projects, issue forwarding and issue closing may be defined 
assimplified actionsordetailed actions. 

If the simplified action option is selected both the Close Issue manager and the Forward Issue manager appear 
as single page forms in the client. Project members may select an option from the Assign To control, select an 
issue substatus, and add a note. All other controls are read only. 
If the detailed action option is selected both the Close Issue manager and the Forward Issue manager appear as 
multiple page tabbed forms in the client. Project members may edit and update controls on multiple pages. 

4.4 Group Forwarding Issues 
Project members can use the Group Change command to reassign multiple DevTrack issues. For more information 
seeManaging Group Actions 

5 Closing, Reopening, and Deleting Development 
Issues 
Issue management is the process by which the development team guides development issues through the 
development life cycle?rom their initial submission to final closure. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow state in this life cycle is defined by itsworkflow status(open or closed). 

Open issues are issues that are in an open state-- a state that has an open status.   
Closed issues are issues that have been forwarded to aclosedstate-- a state that has a closed status. Issues are 
typically closed whenever they have been resolved or dropped. 

In the course of project workflow, development issues may be closed, reopened, or deleted. 
Close                     To close an issue is to forward an open issue to a closed state. Closed issues may be viewed, but 

not edited in the client. 
Reopen                  To reopen an issue is to forward a closed issue to an open state. 
Delete                   To delete an issue is to permanently remove an issue from the DevTrack database. Either open or 

closed issues may be deleted by project members that have been granted the appropriate privileges. 
Closed issues are not deleted from the project. Closed issues may be viewed, reopened, or deleted. 

Project members may view closed issues in the Issue list panel. Closed issues are only displayed in the Issue list 
panel when a Closed or Open & Closed option is selected in the Status dropdown list. Closed issues are not 
displayed in the Issue list panel when the Open option is selected in the Status dropdown list. 
Project members may reopen closed issues by forwarding the issue to an open issue workflow state.   
Project members with appropriate privileges may delete issues. Deleting an issue permanently removes that issue
from the DevTrack database. Deleted issues cannot be reopened. Both open and closed issues can be deleted. 

5.1 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. 
DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. 
Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
The action buttons in the issue detail bar are color-coded to indicate the status (open or closed) of the target issue 
workflow state. 

Transitions to closed states are indicated by gray buttons with red text. 

Transitions to open states are indicated by gray buttons with blue text. 

To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.1.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.1.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar.   
Select the Close | Reopen in the File menu.   
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. The Close window
appears. 

3Click a closing action in the Edit Issue window. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

  

5.2 Closing Issues (Transition-Based Workflow) 
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To close an issue is 
to forward that issue from an open workflow state to a closed workflow state. In state-based projects, project members 
may close issues by directly updating the issue workflow state of the issue in the client. 
  

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development in the issue life cycle. Every workflow may consist of 
multiple open states and multiple closed states.. 

 

Issues may be closed only if a transition exists between the current (open) workflow state and a (closed) workflow state. 
State-dependent workflow rules ensure that only applicable workflow states are displayed in the Issue Progress list of 
the Current Status page. 
To close DevTrack issues a project team member must belong to an account type that has been granted the Can Close
Issues privilege. 

5.2.1 To Close a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click the Close button in the issue detail bar. 
The pages and controls in the issue detail panel are editable. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Save button. 
The issue is closed. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.2.2 To Close a Development Issue (Windows Client) 
1Select a development issue in the issue list panel. 
2Select the Close command. 

Click the Close button in the tool bar. 
Select the Close | Reopen in the File menu. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 

The Close window appears. 
3Edit the issue workflow state of the issue in the Progress Status list. 
The Progress Status list displays only closed issue workflow states. 
4Optional: Input a description of work in the Close Description text box. 
The Close Description is frequently a mandatory field. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
6Click the Submit button. 
If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may appear. 
For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.3 Group Closing Issues 
Project members can use the Group Change command to close multiple DevTrack issues. For more information 
seeManaging Group Actions 

5.4 Reopening Issues (Transition-Based Workflow) 
  
A closed issue is an issue that is in a closed issue workflow state-- a state that has a closed status. To reopen an issue 
is to forward that issue from an closed workflow state to an open workflow state. 

   

DevTrack workflow is conceived as a series of issue workflow states that represent the various stages of development 
in the issue life cycle. Every workflow may consist of multiple open states and multiple closed states. Project members 
must belong to an account type that has been granted appropriate privileges to reopen closed issues. 

5.4.1 To Reopen a Development Issue (Web Client) 
1Select a development issue in the issue list panel. 
2Click an action button the issue detail bar. 
In transition-based projects, project members may change the workflow state of issues by performingactions. Each 
action represents a transition between the current workflow state and another workflow state. 
The Close Issue page is displayed in the issue detail panel. 

Note:If no transition exists between the current (open) state and a (closed) state, the pages and controls in the 
issue detail panel remain read-only. 

3Optional: Input a description of work in the Close Description text box. The Close Description is frequently a 
mandatory field. 
4Optional: Update issue properties in the Description page, Current Status page, and custom pages. 
5Click the Save button. The issue is reopened. 
  
6If the project administrator has enabled the Issue-Level Time Tracking feature, the Issue Time Track page may 
appear. For step-by-step instructions on entering issue time tracking reports seeManaging DevTrack Time Tracking. 

5.5 Reopening Issues (State-Based Workflow) 
Project members may use the Close |Reopen command to reopen closed DevTrack issues. 
Closed issues are issues that have been forwarded to a closed workflow state. Every workflow state in project workflow 
is either an open or closed state. The reopen command enables project member to move an issue from a closed issue 
state to an open issue state. 
Project members must belong to an account type that has been granted appropriate privileges to reopen closed issues.

5.5.1 To Reopen Issues (State-Based) 
1Select a closed issue in the issue list panel. 
To view closed issues select the Open & Closed option or the Closed option in the Status dropdown list of the tool bar. 
2Select the Reopen command. 
Project members may invoke the Reopen command by six different methods: 

Click the Reopen icon in the tool bar. 
Select File > Close | Reopen in the menu bar. 
Right-click in the issue list panel and select the Close | Reopen command in the shortcut menu. 
Click the Reopen button (blue) in the History page. The Reopen Issue manager appears. 

3Optional: To forward the issue to a subproject click the Subproject Ellipsis button and select a subproject from the 
dialog box. Project members may select a subproject if the project administrator has enabled support of subprojects in 
the project. If this option is not enabled the Subproject dropdown list is not displayed. 
4Change the issue status in the Progress Status dropdown list. 
Only open states are displayed in the Progress Status dropdown list. 
5Optional: Update issue properties in the Description page, Current Status page, and custom pages. Administrators 
may define reopening actions assimplified actionsordetailed actions. If the simplified action option is selected, the 
Reopen Issue manager displays only one page. If the detailed action option is selected the Reopen Issue manager 
displays multiple editable pages. 
6Click the Submit button. 

  

5.5.2 Group Reopening Issues 
Project members can use the Group Change command to reopen multiple DevTrack issues. For more information 
seeManaging Group Actions. 

5.5.3 Deleting Issues 
Project members can use the Delete command to permanently remove issues from the DevTrack database. 
Project members can delete issues by two methods: 

Right-click the issue and select the Delete command from the shortcut menu. 
Select File > Delete in menu bar. Users may generally delete issues that they created if ownership of the record 
hasnever changed. But project administrator may disable this privilege in DevTrack Admin. 

If the ownership of a record is changed, project members may only delete DevTrack issues if that project member 
belongs to an account type that has been granted the Can Delete Issues privilege. 

  

5.5.4 Group Deleting Issues 
Project members can use the Group Change command to delete multiple issues. For more information seeManaging 
Group Actions. 

 Chapter 5- Advanced Issue Management 

• Managing Issue Cloning 

• Managing Issue Templates 

• Managing Issue Prioritization 

• Managing Issue Subscriptions 

• Managing Group Actions 

• Importing and Exporting DevTrack Data 

• Managing Interproject Actions 

• Importing and Exporting DevTrack Data 

• Managing Issues Notifications 

1 Understanding Advanced Issue Management 
TechExcel DevTrack is a tool for managing and tracking development tasks such as bug fixes or product 
enhancements. All development tasks are represented and tracked in DevTrack project workflow asdevelopment 
issues. 
An issue is a collection of data that represents a particular task or set of tasks that must be processed in the course of a 
development project. Every issue is defined by a unique issue ID, description, workflow state, owner, work description, 
and other dynamic properties. 

Basic issue management tasks include the creation and editing of issues and the management of those issue in 
project workflow. 
Advanced issue management tasks consist of tasks that enable project members to manage issues in project 
workflow. 

2 Managing Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. 
Each issue template consists of multiple predefined issue properties that may be used to pre-populate development 
issue properties in the Description page, the Current Status page, and custom pages whenever a new development 
issue is submitted to a DevTrack project. 
Project members may create, edit, copy, and delete issue templates in the Issue Template manager of the DevTrack 
Windows client. 

Note:The Issue Template manager is not accessible in the DevTrack web client. Project members may select an 
issue template whenever they submit a new development issue, but they cannot create, edit, copy, or delete issue 
templates in the DevTrack web client. 

Project members may create two different types of issue templates: public issue templates and private issue templates. 
Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do 
notappear as options in the client of any other project member. 

2.1 Creating Issue Templates 
An issue template is a user-defined template that enables project members to submit new development issues quickly 
and easily. Project members may create new issue templates in the Issue Template manager of the DevTrack Windows 
client. 
Project members may create two different types of issue templates: public issue templates and private issue templates. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. Private templates do not 
appear as options in the client of any other project member. 

To create public issue templates, a project member must be granted the Can Define Public Issue Template privilege by 
a project administrator. 

2.1.1 To Create Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the New button 
3The Save As dialog box appears 
4Select an option from the Template Type dropdown list. 

Public issue templates are available to all project members in the project. 
Private issue templates are only available to the project member that created them. 

5Enter a name for the issue template in the Template Name field. 
6Click the OK button. The New Issue Template manager appears. 
7Define issue properties in the Description page. 
8The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
9Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
10Define issue properties in the Custom Page page. 
11Click the Submit button. 

2.2 Editing Issue Templates 
Project members may edit existing issue templates in the Issue Template manager of the DevTrack Windows client. 

2.2.1 To Edit issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Edit button. The Edit Issue Template manager appears. 
4Define issue properties in the Description page. 
5The Description page enables project members define the fundamental nature of each development issue. Data-entry 
controls displayed in the Description page include the Title, the Issue Type, the Issue Priority, and the Issue Description 
controls. 
6Define issue properties in the Current State page. 
The Current Status page enables project members define and track the history of work performed on a development 
issue. Data-entry controls displayed in the Current Status page include the Progress Status, Issue Owner, Substatus, 
the Target Release, and the Work Description controls. 
7Define issue properties in the Custom Page page. 
8Click the Submit button. 

2.3 Deleting Issue Templates 
Project members may delete issue templates in the Issue Template manager of the DevTrack Windows client. 

2.3.1 To Delete Issue Templates 
1Select Tool > Define Issue Template. The Issue Template dialog box appears. 
2Select a template in the Template Names list. 
3Click the Delete button. The Delete Issue Template manager appears. 
4Click the Ok button. 

2.4 Copying Issue Templates 
Project members may create clones of existing issue templates and redefine selected issue property values to define 
new issue templates in the Issue Template manager of the DevTrack Windows client. 

2.4.1 To Copy Issue Templates 
1Select Tool > Define Issue Template. 
The Issue Template dialog box appears. 
2Select the Copy button The Copy New Issue Template dialog box appears. 
3Select an option from the Template Type dropdown list. 

Private templates can only be used by the project member that created them. 
Public templates can be used by all project members. 

4Enter a name for the issue template in the Template Name field. 
5Click the OK button. The New Issue Template manager appears. 
6Define all appropriate issue properties in the controls displayed. 
  
7Click the Submit button. 

3 Managing Issue Cloning 
Issue cloning is the process by which a project member may create an exact copy of an existing development issue. 
Cloning enables developers to save time and effort when they need to create multiple issues to manage identical or 
nearly identical development tasks. 
Cloned issues share the same issue property definitions, issue history, or issue notes. Every cloned issue is either 
aduplicate issueor anew issue. 

Duplicate cloned issues copy issue property definitions and the issue history from an original issue. Project 
members may optionally choose to copy the originating issue notes as well. 
New cloned issues copy the issue property values from the originating issue, but not the issue history. Project 
members may choose to copy the work history of the original issue to the description of the clone. 

Development teams may wish to clone existing issues when they need to execute the same or similar tasks in multiple 
environments and wish to assign an issue to multiple development teams or project members. 
For example, a new feature must be developed for both Windows and Unix platform. A single issue may be created, 
cloned, and addressed to the appropriate project or subproject. 
DevTrack provides development teams numerous options for managing cloned issue prior to their submission: 

Project members may add cloned issues to subprojects. 
Project members may create links between cloned issues and the original issue. 
Project members may create the cloned issues automatically or edit the values of the cloned issues before it is 
submitted. 

3.1 Submitting Issue Clones (Duplicate Issues) 
A duplicate cloned issue is an exact copy of another DevTrack issue (the originating issue). Project members may 
optionally choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 
A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 

Memo 
Field 

Indexed 
Data 

Time 
Stamping 

Mandatory Web Size Screen 
Capture 

HTML 
Editor 

Issue 
Description 

X X X X X X 

Work 
Description 

X X X 

Close 
Description 

X X X 

Note 
Description 

X X X X 

Forward 
Note 

X X X X 

Link 
Comment 

X 

Development 
Event 
Description 

X X 

Branch 
Event 
Description 

X X 

custom 
memo 
field 

X X 

Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 

Memo 
Field 

Indexed 
Data 

Time 
Stamping 

Mandatory Web Size Screen 
Capture 

HTML 
Editor 

Issue 
Description 

X X X X X X 

Work 
Description 

X X X 

Close 
Description 

X X X 

Note 
Description 

X X X X 

Forward 
Note 

X X X X 

Link 
Comment 

X 

Development 
Event 
Description 

X X 

Branch 
Event 
Description 

X X 

custom 
memo 
field 

X X 

Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 

Memo 
Field 

Indexed 
Data 

Time 
Stamping 

Mandatory Web Size Screen 
Capture 

HTML 
Editor 

Issue 
Description 

X X X X X X 

Work 
Description 

X X X 

Close 
Description 

X X X 

Note 
Description 

X X X X 

Forward 
Note 

X X X X 

Link 
Comment 

X 

Development 
Event 
Description 

X X 

Branch 
Event 
Description 

X X 

custom 
memo 
field 

X X 

Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. 
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A cloned issue is an exact copy of another DevTrack issue and which shares the same issue property definitions, issue 
history, or issue notes. 
Project members may define which properties are copied from the originating issue to the cloned issue, define the link 
type of any link between the two issues, and to identify the target subproject of the cloned issue. 
The Clone Issue page enables project members to define a prefix for the cloned issue, copy the history and notes of 
the originating issue to the clone. 
Project members may also create a link between the originating issue and its clone. The administrator-defined link type 
may belong to the Referential link type category or the Parent-Child link type category 

3.1.1 To Submit Duplicate Issue Clones 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the 
Subproject dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. The title prefix is concatenated to the title of the cloned 
issue. Adding a title prefix to a cloned issue enables development teams to quickly identify cloned issues (by sorting or 
searching) in the Issue list panel. 
 4Select the Clone a Duplicate Issue radio button. 
The issue property definitions and issue history of the originating issue are copied to the cloned issue. 
5Optional: To copy the issue notes of the originating issue to the duplicate cloned issue, select the Copy Notes check 
box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. For step-by-step instructions 
see Managing Issue Linking?on page 65. (todo: create link) 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. If 
the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. If the Edit New Issue Before Creating check box is selected, the project member may 
update issue property values before submitting the cloned issue. 

3.2 Submitting Issue Clones (New Issues) 
Anew cloned issueis an exact copy of another DevTrack issue (the originating issue). Project members may optionally 
choose to copy the originating issue notes as well. 
DevTrack enables project members to choose the type of information that is copied over from the original issue to the 
cloned issue, and to edit the issue clone prior to its submission to the project. Project members may choose to copy the 
issue properties and the entire history of the original issue to the cloned issue, or only the issue properties. 

3.2.1 To Submit New Cloned Issues 
1Select the Clone command in the Actions menu. 
The Clone Issue page appears. 
2Optional: To add the cloned issue directly to a subproject, select a option subproject from the Subproject dropdown 
list. 
Subprojects are a feature of the DevTrack Enterprise Edition. If subprojects are not enabled in a project, the Subproject 
dropdown list is not displayed in the Clone Issue page. 
3Define a title prefix for the cloned issue in the Title Prefix field. 
The title prefix is concatenated to the title of the cloned issue. Adding a title prefix to a cloned issue enables 
development teams to quickly identify cloned issues (by sorting or searching) in the Issue list panel. 
4Select the Clone a New Issue radio button. The issue property definitions of the originating issue are copied to the 
cloned issue. 
5Optional: To copy the work history of the originating issue to the new cloned issue, select the Copy Work History to 
Issue Description check box. 
6Define the issue workflow state of the duplicate cloned issue. 

To copy the issue workflow state from the original issue, select the Keep Issue Status radio button. Project 
members may define the issue owner of the issue clone. 
To define the issue workflow state of the issue clone, select the New Action radio button radio button. Project 
members may select an action (transition-based workflow) or status (state-based workflow) and the issue owner of 
the issue clone. 

7Optional: To create a link between the original issue and the issue clone the project member must enable issue 
linking, select an appropriate link type category and link type, and define link type notes. 
For step-by-step instructions see Managing Issue Linking?on page 65. 
8Optional: To edit the cloned issued prior to submission, select the Edit the New Issue Before Creating check box. 
If the project member selects this check box, the Duplicate Issue manager opens after the Issue Clone manager is 
closed enabling the project member to update the issue properties of the cloned issue. 
9Click the Continue button. 
If the Edit New Issue Before Creating check box is selected, the project member may update issue property values 
before submitting the cloned issue. 

4 Managing Issue Linkage 
Issue linking is a tool that enable development organizations to identify and manage related development issues so that 
they may avoid issue duplication and to share information across multiple issues and projects. Project members may 
create links between issues using controls in the Add Link page, the Edit Link page, the Clone Issue page, the 
interproject Copy page, and the interproject Submit page. The Link Type dropdown list in each of these pages displays 
the administrator-defined link types available to them. 

  

Every issue link is based on an administrator-defined link type. A link type is an administrator-defined template for 
creating links between DevTrack development issues. All link types belong to one of twolink type categories: referential 
links or parent-child links. 
Referential Links                 Referential links create one-to-one relationships between two development issues and 

indicate that the two issues are related to one another in a significant way. Every referential link is 
based on an administrator-defined referential link type. 

Parent-Child Links                 Parent-Child links create a parent-child relationship between two development issues. 
Administrator-defined issue link closing rules may restrict the ability of project members to close a parent or child issue 
if they are linked to an open issue. No workflow rules may be defined for referential link types. 
Both referential link types and parent-child link types may be used for interproject linking. Project members may use 
administrator-define link types to create links between DevTrack issues in the same or different projects, between 
DevTrack issues and TechExcel CustomerWise incidents, or between DevTrack issues and TechExcel ServiceWise 
incidents. 
Project administrators may also define rules which make the Issue Status field in either the parent or child issue read-
only. In such cases, the status of the issue in the parent-child relationship is based entirely on the administrator-defined 
state change rules. 

4.1 Managing Linked Issues in the Linked Issues List 
Once two issues are linked together, development issue details of each issue are visible in the issue detail page of the 
other issue. 
Project members may view detailed information about linked issues including their history, comments, and notes and 
make updates to linked issues in the Links page. 
The Linked Issues list displays all current links in between the current issue and other issues. Project members may use 
controls to add, edit, delete, or print links. 

   

Linked issues are displayed in a hierarchical tree structure that enables project members to view information not only 
about issues directly linked to the current issue, but also to view information about the issues that are linked to the linked 
issue. 
For example, if issue A is linked to issue B, and issue B is linked to issue C, a tree in issue A will display both issue B 
and issue C. This view also applies to issues that are linked in another project. 
Each link type displayed in the Links list is represented by a unique icon that represents that link type. 

The Linked Child Issue icon identifies linked child issues in the DevTrack project. The link type belongs 

to the Parent-Child Link Type category. 
The Linked Parent Issue icon identifies linked parent issues in the DevTrack project, and is of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs to the 

Referential Link Type category. 
Issue link icons may also be displayed in the Issue list panel enabling project members to quickly identify links by their 
link type categories. Project members may filter, sort, and search for linked issues based on their link types 
administrator-defined link types. 

4.2 Managing Referential Links 
Referential linkscreate one-to-one relationships between two development issues and indicate that the two issues are 
related to one another in a significant way. Every referential link is based on an administrator-defined referential link type. 
To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
Then Go To control enables project members to search for issues based on their issue ID number. 

Project members may create referential links based on administrator-defined referential link types. The Link Type 
dropdown list displays all administrator-defined referential link types. 

4.2.1 To Create Referential Between Issues 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. 
The Add Link manager appears. 
3Select an option from the Project dropdown list. 
The projects displayed in the Project dropdown list are determined by the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field.   
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Select a target issue in the Issue list. 
7Select the As Reference radio button. 
8Select an referential link type option from the Link Type dropdown list. The Link Type dropdown list displays all of the 
referential link types created by the administrator in DevTrack Admin. 
9To add a note to the link, enter a note in the Comments field. 
10Click the OK button. 

4.3 Managing Parent-Child Links 
Parent-Child linkscreate a parent-child relationship between two development issues. Administrator-defined issue link 
closing rules may restrict the ability of project members to close a parent or child issue if they are linked to an open 
issue.No workflow rules may be defined for referential link types. 
Project members may create parent-child links based on administrator-defined parent-child link types. Each parent-child 
link type represents one of five different workflow rules that determine how the parent-child link is managed in a project. 
No Enforcement                                                  The No Enforcement rule enables project members to close either the 

parent or child issues without restrictions. 
Warning: Do Not Close Parent                          The Warning: Do Not Close Parent rule warns project members not to 

close a parent issue until the link child issue is closed, but enables them to close the parent 
if they   choose. 

Enforce: Cannot Close Parent                            The Enforce: Cannot Close Parent rule prevents project members from 
closing parent issues if they are linked to an open parent issue. 

Warning: Do Not Close Child                             The Warning: Do Not Close Child rule warns project members not to 
close a child issue until the linked parent issue is closed, but enables them to close the 
child if they choose. 

Enforce: Cannot Close Child                               The Enforce: Cannot Close Child rule prevents project members from 
closing child issues if they are linked to an open parent issue. 

To link a development issue to another issue, project members must identify the development issue to be linked. 
Project members may identify relevant issues in the current or an external project. using the keyword search control or 
the Go To control in the Link search bar. 

The keyword search control enables project members to search for issues based on keywords. 
The Go To control enables project members to search for issues based on their issue ID number. 

4.3.1 To Definite Parent-Child Links 
1Select the Links tab in the issue detail panel. 
Project members may create links between issues using controls in the Add Link page, the Edit Link page, the Clone 
Issue page, the interproject Copy page, and the interproject Submit page. 
2Click the Add button. The Add Link manager appears. 
3Select an option from the Project dropdown list. The projects displayed in the Project dropdown list are determined by 
the project administrator in DevTrack Admin. 
4Define the search parameters for the search. 

Enter a keyword in the Keyword field. 
Enter Issue ID numbers in the ID Filter field. 
Select the AND or the OR operator. 

5Click the Search button. 
All issues that match the search parameters appear in the Issue list. All issues found from the search are displayed in 
the issue list and contain a brief overview: issue ID, issue title and current owner. The details of the highlighted issue are 
shown in the Issue Details section. 
6Define the relationship between the current issue and the linked issue: 
Select the As Parent radio button to identify the linked issue as the parent of the current issue. 
Select the As Child radio button to identify the linked issue as the child of the current issue. 
7Select a parent-child link type option from the Link Type dropdown list. 
The Link Type dropdown list displays all of the parent-child link types created by the administrator in DevTrack Admin. 
8To add a note to the link, enter a note in the Comments field. 
9Click the OK button. 

4.4 Searching for Issues by Keyword in the Link Page 
Enter the desired keywords in the Keywords edit box. Separate words with a space or comma. If a project member 
enters multiple keywords for searching, be sure and specify the keywords searching logic: 

The OR operator returns issues that have any of the specified keywords. 
The AND operator only returns issues that have all of the specified keywords.  

  

4.4.1 Searching for Issues by Issue ID in the Links Page 
The Issue ID filter enables project members to easily select an issue by issue ID number or by using the wildcard 
character, *. 
  

4.5 Editing Linked Issues 
Project members may use controls in the Links page of the issue detail panel to edit linked DevTrack issues, TechExcel 
CustomerWise incidents, and TechExcel ServiceWise incidents. 
Click the Edit button in the Links page opens the Update Issue manager. The Update Issue manager displays editable 
properties belonging to the linked issue or incident. 
  

 

Project members may update or define issue properties displayed in the Description page, Current Status page, and 
Notes page. 
Project members may or may not be able to edit linked issues in other DevTrack, TechExcel CustomerWise, or 
TechExcel ServiceWise projects. Project administrators must enable the development team to edit linked issues in 
each linked project. Administrators may enable project members to edit the progress status, the issue or incident owner, 
and the work description of linked issues in other projects. 

4.5.1 To Edit Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Edit button. The Update Issue manager appears. 
4Update issue properties in the data-entry controls: 
5Click the OK button. 

4.6 Deleting Issue Links 
Project members may delete links between issues using the Delete button in the Linked Issue area of the Link tab. 

4.6.1 To Delete Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select an issue in the Issue list. 
3Click the Delete button. The Delete Selected Links dialog box appears. 
4Click Yes. The Links disappears from the Link list. 

4.7 Viewing Linked Issues in the Issue List Panel 
Linked issues may be displayed in the Issue list panel of the DevTrack client. Project members may choose to display 
or hide linked issues in the Issue List tab of the User Preferences manager. 
Link icons are displayed next to linked DevTrack issues in the Issue list panel. Each linked issue displayed in the issue 
list panel is represented by an icon which identifies the link type category. 

The Linked DevTrack Issue icon identifies linked issues in another DevTrack project. 

The Linked ServiceWise Incident icon identifies linked incidents in a TechExcel 

ServiceWise project. 
The Linked CustomerWise Incident icon identifies linked incidents in a TechExcel 

CustomerWise project. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of 

the Parent-Child Link Type category. 
The Linked Child Issue icon identifies linked child issues in the DevTrack project of the 

Parent-Child Link Type category. 
The Linked Issue icon identifies a linked issue in the current project. The link type belongs 

to the Referential Link Type category. 

4.8 Printing Issue Links 
Project members may print the history of a link using the Print button the Linked Issue area of the Link tab. 

4.8.1 To Print Links Between Issues 
1Select the Links tab in the issue detail panel. 
2Select one or more issues in the Issue list. 
3Click the Print button. The Print manager appears. 
4Click Print. The Print manager appears. 
5Define printer details. For more information see Managing DevTrack Printing?on page 38.(todo: create link) 
6Click the Print button. 

  

5 Managing Interproject Actions 
DevTrack Interproject actions enable project members may submit or copy DevTrack issues to linked DevTrack 
projects, TechExcel CustomerWise projects, or TechExcel ServiceWise projects. 

Interproject Copy enables project members to copy a DevTrack issue and submit a copy of that issue to another 
project. Project members may optionally create a link between the original issue and the copy and update the 
properties of the copied issue. 
Interproject Submit enables project members to submit a new issue or incident into another DevTrack project, 
TechExcel CustomerWise project, or TechExcel ServiceWise project from within the DevTrack client. Project 
members may optionally create a link between the submitted issue and one or more DevTrack issues. 

Before project members can use the Interproject copy or the Interproject submit features, administrators must enable 
interproject actions in DevTrack Admin, map record fields, and define one or more interproject link types. 
When an issue is submitted or copied to another project, only fields that have mapped in DevTrack Admin will be copied 
to the new project. All field and field value mapping is specified in DevTrack Admin. 

5.1 Copying Issues to Other Projects 
Project members may use the Interproject Copy command to copy DevTrack issues to other DevTrack projects, or to 
TechExcel CustomerWise or TechExcel ServiceWise projects. 
The Issue Copy manager enables project members to define the target project, select an appropriate link type, define a 
title prefix and add a brief comment. Project members may select the target project, select an appropriate interproject 
link type, define a title prefix and add a brief comment. 
Administrators must enable each target project for interproject actions and, the copied issues is to be linked with the 
original issue, define appropriate link types. 
The Issue Copy manager consists of two primary areas: the Clone Options area and the Link Info area: 

   

The Copy Issue Option area contains tools that enable project members to define the properties to be copied from the 
original issue to the copy. Project members may choose a target project, copied issue status and assignment options, 
and whether the work history of the original is copied to the copy. 
The Link Info area contains controls that enable project members to create a link between the original issue and the 
copy, select a link type category (referential or parent-child), and define link notes. 
The Issue Copy manager also displays the Edit the New Issue Before Creating check box. If project members select 
this check box, they may edit the issue property values of the cloned issue before it is submitted to the project. 
To copy an issue to another project the project member must belong to an account type that has been granted the Can 
Perform interproject Submit/Copy privilege. 

5.1.1 To Copy Issues Between Projects 
1Invoke the interproject Copy command. 
Project members may use two methods to select the interproject Copy command: 

Select File > interproject Copy. 
Right-click in the issue list panel and select the interproject Copy command in the shortcut menu. The interproject 
Copy   page appears 

2Select the project in the Target Project dropdown list. 
Project members may copy DevTrack issues to other DevTrack projects, TechExcel ServiceWise projects, or 
TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue. 
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

5To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
6Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
7To edit the cloned issue prior to submission, select the Edit the New Issue Before Creating check box. 
8Click the OK button. 
If the project member selects Edit the New Issue Before Creating check box, the Copy Issue from [Originating Project] 
to [Target Project] manager opens after the Issue Clone manager is closed enabling the project member to update the 
issue properties of the cloned issue. 

5.1.2 Updating Copied Issue Properties 
The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
If the project member selects the check box, the Copy Issue from [Originating Project] to [Target Project] manager 
opens after the Issue Copy manager is closed enabling the project member to update the issue properties of the 
closed issue. 
Once the project member has defined the interproject copy definitions, the Copy Issue from [Originating Project] to 
[Target Project] manager appears. The Copy Issue from [Originating Project] to [Target Project] manager manager is a 
multi-page tabbed form consisting of the Description, Current Status, and custom pages. 

 

The Copy Issue manager enables project members to define issue or incident properties for the copied issue in the 
target DevTrack project, CustomerWise project, or ServiceWise project. 
In DevTrack Admin project administrators may map fields for copied issues and select an appropriate default issue 
template. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue page. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue page. 

5.2 Submitting Issues to Other Projects 
Project members may use the Interproject Submit command to submit issues to another DevTrack project, or to submit 
incidents to a TechExcel CustomerWise project or TechExcel ServiceWise project from within the DevTrack client. 
Submitting issues to other projects is a two-step process. Project members must first select a target project and an 
issue template in the Select Templates page and then define issue properties for the copied issue in the Submit Issue 
page. 

Issue submission properties include the target project, the issue template used, the link type, and link prefix.   
Issue properties include all of the standard issue properties included in the Description and Current Status pages. 

5.2.1 Interproject Submit Page 
Project members may define the target project, link type, and title prefix and add a brief comment in the interproject 
Submit page. 

Using the Interproject Submit page project members may link the new issue to issues displayed in the issue list panel. 
Project members may select multiple issues in the issue list prior to performing the interproject submit if required. 

5.2.2 The Create Page Manager 
Once the project member has defined the interproject submission definitions, the user has the option to edit the incident 
by selecting "edit the issue before creating." The creation page will then pop up as shown below for you. 
  
 

To submit an issue or incident to another project, the project team member must belong to an account type that has 
been granted the Can Perform interproject Submit/ Copy privilege. 

5.2.3 To Submit Issues Between Projects 
1Invoke the interproject Submit command. 
Project members may use two methods to select the interproject Submit command: 

Select Filed > interproject Submit. 
Right-click in the issue list panel and select the interproject Submit command in the shortcut menu. The 
interproject Submit page appears. 

2Select a target project in the Target Project dropdown list. 
Project members may submit DevTrack issues to other DevTrack projects, or incidents to TechExcel ServiceWise 
projects, or TechExcel CustomerWise projects. Administrators must enable each target project in DevTrack Admin. 
3Optional: Select a subproject from the Subproject dropdown list. 
If the copied issues is to be submitted to a DevTrack project that has enabled subproject management, the project 
member may select an option in the Subproject dropdown list. 
4To add a prefix to the title of the copied issues, enter a word or phrase in the Title Prefix field. 
5Define the status of the new issue. 
Project members may choose between two options: keep the issue status of the original issue or define the issue status 
of the copied issue. 

Select the Keep Issue Status radio button to copy the issue status of the original issue to the copied issue.   
Select the Select a New Action radio button to define the issue status of the copied issue. Project members may 
select an action (transition-based workflow) or status (state-based workflow) and select an appropriate applicable 
owner. 

6To copy the work history of the original issue to the copied issue, select the Copy Work History to Issue Description 
check box. 
If selected the entire work history of the original issue is copied to the Description field of the copied issue. 
7Optional: To link the new issue to the original issue, select the Link the Newly Created Issues check box, define the 
link type, and a link note. 
For step-by-step instructions on linking issues see Managing Issue Linking?on page 65. 
8Click the Continue button. The Create Page page appears. 

Fields mapped by the administrator in DevTrack Admin are automatically prepopulated in the Copy Issue dialog 
box. 
Administrators may also define an issue template for each target project. Fields defined in the issue template are 
also prepopulated in the Copy Issue dialog box. 

9Define all appropriate fields. 
10Click the Submit button. 

6 Managing Issue Subscriptions 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue notification messages. 
Issue subscriptions enable project members to receive notification by e-mail, pager, mobile phone, PDA, or personal 
folder whenever a triggering action for an issue performed in the DevTrack client. 
The ability of project members to subscribe or unsubscribe to individual issues depends on the notification rule or 
escalation rule governing an issue or event, and the subscription options assigned to the project member by the project 
administrator. For each notification or escalation rule every project member is assigned one of four subscription options: 
Must Subscribe, Never Subscribe, Optional Yes, and Optional No. 
Issue subscription tasks include: 

Understanding Notification and Escalation Rules 
Understanding Notification and Escalation Subscription Options 
Understanding E-mail Notification Message Types 
Subscribing to Issue and Event Notifications 
Defining Subscription Issue-specific CC Lists 

6.1 Understanding Notification and Escalation Rules 
All issue notification rules, issue escalation rules, event notification rules, and event escalation rules are defined by a 
project administrator in DevTrack Admin. Notification rules and escalation rules help development teams ensure that 
appropriate actions are taken on issues and events in a timely manner. 
E-mail notification may be triggered by many different actions taken on an issue including the submission, editing, 
forwarding, closing, and reopening of the issue itself. Administrators may also create notification and escalation triggers 
that are based on changes made to specific issue properties. 

E-mail notifications are sent to all rule subscribers whenever an administrator-defined triggering event occurs.   
Escalation notifications are sent to all rule subscribers whenever an expected changeis notmade to an issue or 
event during a defined time period. 

DevTrack features rule-based notification and escalation. Administrators may define notification and escalation rules to 
manage every issue or event in the project. Each notification and escalation rule is represented by a trigger, a set of 
conditions, an action, and subscription options for all potential recipients.   

The trigger defines the action that must occur for the notification messages to be sent. 
Conditions limit the scope of the rule to issues that meet administrator-defined criteria. 
Actions represent the applicable notification methods for that rule. Notification may be delivered by e-mail, page, 
mobile phone, PDA, or personal folder. 
Subscription options determine whether those project members who may receive notification must subscribe, 
mayopt inoropt out, or may not subscribe to a particular notification or escalation rule. 

 If more than one triggering event occurs, members of the cc list are notified by e-mail for notification or escalation rule 
triggered. 

Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 

6.2 Understanding Notification and Escalation Subscription Options 
Administrators may assign a different subscription option to each account type, group, project member, or customer for 
each issue notification rule, issue escalation rule, event notification rule, and event escalation rule that they define in the 
project. 
Project members may be assigned one of four subscription options for each notification or escalation rule: 

The Must Subscribe option means that the project member must subscribe to the rule and will receive notification 
by e-mail, pager, mobile phone, or personal folder if the notification or escalation rule is triggered. 
The Never Subscribe option means that the project member may not subscribe to the rule. No issue notification 
can be sent to the project member if the notification or escalation rule is triggered. 
The Optional Yes option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is Yes. The project member will receive notification 
unless they choose to unsubscribe. 
The Optional No option means that the project member may choose to subscribe or unsubscribe to an a specific 
notification or escalation rule. The default setting for this option is No. The project member will not receive 
notification unless they choose to subscribe. 

6.3 Understanding E-mail Notification Message Types 
Project administrators may define any number of e-mail messages in DevTrack Admin and customize these e-mail 
messages to describe the purpose of the notification or escalation action. 
However, the administrator may only assign two e-mail messages to each notification or escalation rule: a internal-facing 
e-mail and a external-facing e-mail. 

The internal e-mail is automatically sent to all DevTrack project members that are subscribed to the notification or 
escalation rule. 
The external e-mail is automatically sent to customers that the administrator has subscribed to the notification or 
escalation rule. Administrators may subscribe the customer that submitted the issue and the selected contacts that 
are associated with each issue. 

Project administrators may also enable subscribing project members to define e-mail cc lists for DevTrack issues. Each 
e-mail address that is added to issue-specific cc list is copied on e-mail notifications regarding that issue. For more 
information see Defining Subscription Issue-specific CC Lists?on page 80. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. 

6.4 Subscribing to Issue and Event Notifications 
Project members may use controls in the Issue E-mail Subscription manager to subscribe or unsubscribe to DevTrack 
issue and event notification messages. 
  

6.4.1 To Subscribe to Notification and Escalation Messages 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. The Issue E-mail Subscription manager appears.3Select an option 
from the Rule Type dropdown list. 

The E-mail Notification option enables project members to define subscription options for issue notification rules. 
The E-mail Escalation option enables project members to define subscription options for issue escalation rules. 
The Event Notification option enables project members to define subscription options for event notification rules. 
The Event Escalation option enables project members to define subscription options for event escalation rules. 

The option selected determines the subscriptions displayed in the Rule Name list. 
4Subscribe or unsubscribe to rules. 
Project members may only edit those rules for which they have been assigned either an Optional Yes or Optional No 
subscription. If the Subscription Option column displays Must Subscribe, all fields are read-only for that rule. 

To subscribe to a rule select the Subscription check box.   
To unsubscribe to a rule deselect the Subscription check box. 

5Click the OK button. 

6.5 Defining Subscription Issue-specific CC Lists 
  
Project members may define e-mail cc lists for individual DevTrack issues using the Issue E-mail Subscription manager. 
Every e-mail address defined in the cc list are notified by e-mail if an applicable notification or escalation rule is 
triggered. 
To add one or more e-mail addresses to an issue-specific cc list, the project member must be subscribed to the 
corresponding notification or escalation rule. 
Every DevTrack issue associated with a notification or escalation rule has a unique cc list. Every project member that 
subscribes to a notification or escalation rule associated with that issue may define, edit, or delete the addresses in the 
cc list. 
Every address included in that cc list is copied on every e-mail notification that is sent regarding that issue. 
The e-mail message that is sent to the addresses included in the issue-specific e-mail list isalwaysthe internal e-mail 
message. Project members should be careful about which e-mail addresses are added to the issue-specific cc list. For 
more information see Understanding E-mail Notification Message Typeson page 79.(todo: create link) 

6.5.1 To Define Issue-specific CC Lists 
1Right-click in the issue list panel. 
The Issue List shortcut menu appears. 
2Select the Subscription of this Issue command. 
The Issue E-mail Subscription manager appears. 
3Click the Ellipsis button in the Define CC List column. 
The Define E-mail CC List dialog box appears. 
4Enter e-mail addresses in the Define E-mail CC List field. 
E-mail addresses should be separated by commas. 
5Click the OK button. 

7 Managing Issue Prioritization 
DevTrack issue prioritization enables project members prioritize their work schedule based the priority order of 
DevTrack issues. 
The priority order of each issue is based on administrator-defined priority values. Project members may then tag critical 
issues in the issue list panel and prioritize their work schedule based on the issue priority order. 
Issue prioritization is an optional feature in DevTrack and must be enabled by a project administrator in DevTrack Admin. 
Also each project team member must be granted the Can Change Priority Order of Own Issues privilege or the Can 
Change Priority Order of All Issues privilege to use this feature. 
  

7.1 Understanding Issue Prioritization 
Issue prioritization is an optional feature in DevTrack that enables project administrators to assign priority values to 
DevTrack issues based on a formula defined in DevTrack Admin and project members to assign priority order numbers 
to their issues and use this priority order as a guide for planning their work in the DevTrack client. 
Each issue may be assigned a priority order number, a priority value, or both:   

The priority value is a read-only value calculated based on a predefined formula in DevTrack Admin. DevTrack 
automatically assigns a weighted priority value to weight, or value.   
The priority order number is a number manually assigned to each issue by a DevTrack user. If a user has ten 
issues, each issue will have a unique priority order number from one to ten. 

The User Preferences Manager enables project members may add the Priority Order Number column and the Priority 
Value columns to the issue list panel. Team members can then sort DevTrack issues based on their order number or 
priority value. 
  

to their issues. The priority order number can then be used as a guide for prioritizing work in the DevTrack client. 
Depending upon the privileges granted to each account type, a project team member may prioritize his or her own 
issues or all DevTrack issues using the Prioritization dialog box. 
The Prioritization dialog box displays all the issue ID number, title, priority value, and priority order for each DevTrack 
issue. 
  

 

7.2.1 To Prioritize Issues 
1Right-click an issue in the issue list panel. 
2Select the Prioritize command in shortcut menu. The issue prioritization dialog box appears. 
3Select a project team member from the Owners dropdown list. 
4Adjust the priority number for each issue.   

Click the Up button to move an issue up in priority. 
Click the Down button to move an issue down in priority. 

5Click the OK button. 

8 Managing Group Actions 
The DevTrack Group Property Change feature enables project members to quickly update multiple fields in multiple 
DevTrack issues. 
In certain circumstances project members may need to perform the same operation on many issues. For example, say 
that due to lack of time an project team must push back one hundred bug fixes to a later release. Manually changing the 
Release field in all of these of issues would be an inefficient and onerous exercise. 
The Group Property Change feature enables project members to perform this task quickly and easily. 
  
To perform group changes project members must first be granted special privileges by a project administrator: 

To perform group op 

 Chapter 6- Issue Management 
Communication is a key component to the development of quality products. Issue knowledge management tools enable 
development organizations to ensure that all issue stakeholders may access up-to-date and accurate information about 
development tasks. In this chapter: Understanding Issue Knowledge Management Managing Issue Descriptions, Work 
Descriptions, and Notes Managing Development Issue Notes Managing Development Issue Attachments Using the PowerPad 
Text Editor Managing Screen Captures

1 Understanding Issue Knowledge Management 
Issue knowledge management is the management of issue-specific data in development issues. A development issues 
is a tool for tracking and sharing information about a specific development task. Each development issue serves as a 
centralized repository for storing, managing, and sharing information. 

All issue-specific information is directly embedded in, or attached to, the development issue used to track the issue. 
Issue-specific information may be managed and tracked in issue descriptions and work descriptions, issue histories, 
and issue notes and note attachments. 

Memo fieldcontrols including the Issue Description control, the Work Description control, the Event control descriptions 
enable development organizations to collect, manage, and track large amounts of information about development tasks. 
Memo field controls are the primary vehicle for sharing issue-specific information among project team members. 

Issue descriptionreports enable development organizations to view all development issue property definitions and its 
entire history in a single page. 

Issue notesare issue-specific comments that are defined and tracked in the Notes page. Project members may add 
any number of notes to each development issue. 

Issue attachmentsare documents, HTML links, and knowledge topics that are attached to development issues. Project 
members may choose to attach new documents or HTML links or existing documents, HTML links, or topics to 
development issues. 

Screen capturesare graphic images that may be attached to issues. DevTrack Smart Screen Capture enables project 
members to take screen captures and immediately attach the JPEG file to an issue or issue note. 

  

2 Managing Issue Descriptions, Work Descriptions, 
and Notes 
Issue descriptions, work descriptions, and issue notes enable development organizations to define the content and 
context of development issues and serve as the primary vehicle for sharing issue-specific information among 
development team members. 

In DevTrack, all issue-specific communication is managed and tracked within the development issue itself. Key 
information that might otherwise be buried in a chain of e-mails is embedded and tracked as issue properties inmemo 
field controls. 

Memo field controls enable development organizations to collect, manage, and track large amounts of information about 
development tasks. By default each memo field may contain up to 10K of data. 

Two key memo field controls are the Issue Description control, the Work Description control, and the Note controls. 

The Description memofield enables project members to describe the development issue. The Description control is 
displayed in the Issue Description page. 

TheWork Descriptionmemo field enables project members to describe and track development work. The Work 
Description page is displayed in the Current Status page. 

Memo fields enable development organizations to add lengthy notes to describe changes made to an issue during 
workflow. Project administrators may also define custom memo field controls to track business critical information. 

  

2.1 Memo field customizations 
DevTrack enables project administrators to customize memo controls to support the following features. 

Not all features are available in every memo field control: 

2.2 Defining Issue Descriptions 
The Description control is displayed in the Issue Description page is a memo field control designed to record detailed 
descriptions of development tasks. 

Text may be entered into the Description control whenever a project member submits, updates, forwards, closes, or 
reopens a development issue. 

 

The Issue Description memo field control may be defined as mandatory on submission by a project administrator. If the 
control is defined as mandatory, the field must be defined before the issue can be submitted to the project. 

The Issue Description control may feature additional tools that enable project members to better describe development 
tasks: 

Time stamping: The Issue Description control supports time stamping of all data entered in the field. A time stamp is a 
signature that is concatenated to text entered in the data-entry field that logs the exact date and time of the entry.  

Spell checking: The Issue Description control supports spell checking. Spell checking is an optional feature that must 
be enabled by a project administrator in a DevTrack project.  

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility.  

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

All issue description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.3 Defining Issue Work Descriptions 
The Work Description control in the Current Status page is a memo field control designed to track the complete history 
of work performed on a development issue. 

Work description entries may be made whenever any update is made to an issue. Text may be entered into the Work 
Description control whenever a project member updates, forwards, closes, or reopens a development issue. 

Development issue work description entries need not always be entered in the Work Description control. Project 
members may optionally choose to add forwarding notes to the work description of an issue whenever they Forward an 
issue in the DevTrack Windows client. For more information see Forwarding Issues in the DevTrack Windows Client. 

All work description entries are recorded and displayed in the Change Log report Issue Detail page. 

  

2.4 Spellchecking the Issue Description 
The Issue Description control supports spell checking. Spell checking is an optional feature that must be enabled by a 
project administrator in a DevTrack project. 
  

 

2.4.1 To Check the Spelling of Issue Description Text 
1Click the Spellcheck button in the issue description page of the issue detail panel. 
The spell checking window appears. 
The spell checking window displays words not identified in the dictionary, the context in which the word was used, and a 
list of suggested spellings. 
2Edit the spelling of text in the issue description: 

To ignore the word, click the Ignore button. 
To ignore all instances of the word, click the Ignore All button. 
To change the word to the word displayed in the Change To text box, click the Change button. 
To change all instances of the word to the word displayed in the Change To text box, click the Change All button. 
To add the word to the dictionary, click the Add button. 
To cancel edits made to the issue description, click the Cancel button The spell checking window displays another 

misspelled word or the Spellchecking Complete dialog box. 
3Click the Done button. 
The spell checking window closes. 

2.5 Understanding Memo Field Time Stamping 
Atime stampis a signature that is concatenated to text entered in the data-entry field. DevTrack time stamps log the 
exact date and time of the entry, the name of the project member entering the data, and the action that accompanied the 
work description entry. 
The Description control, Work Description control, and Note control support the time stamping of all data entered in the 
field. 
In addition, project administrators may define time stamped entries as indelible: once entered the entries cannot be 
edited or deleted. Subsequent entries may be made, but these entries are marked by a unique time stamp. 
Time stamping is an optional feature that must be enabled by a project administrator. 

  

2.6 Understanding Memo Control Field Sizes 
Memo fields may contain up to 64K of data. DevTrack administrators may define the size of memo fields in a DevTrack 
site. The default setting is 10K. 

A warning message is displayed if the field limit is exceeded. Longer comments should be added using controls in the 
Notes page or as note attachments. For more information seeManaging Development Issue Notes. 

2.7 Understanding DevTrack Search Engine 
The DevTrack search engine enables project members to quickly search the notes, memo fields, and descriptions of 
DevTrack issues and events. 
Project members may use keywords to search the following DevTrack memo fields: 

Description 
Close Note 
History 
Issue Notes 
Link Comments 
Event Description 
All custom-defined memo fields 

The DevTrack Search Engine is a feature of the DevTrack Enterprise Edition. 

2.8 Text Editor Controls 

Text editor controls are available when HTML edit is enable. The available controls are below: 

   Font dropdown list : allows you to change the font to use 

 Font Size dropdown list:  allows you to change the size of the font 

 Header dropdown list : allows you to select the font style by selecting the 

header level 
Bold: allows you to change the font style to Bold  

Italic: allows you to change the font style to Italics  

Underline button: allows you to font style to underline  

Align Left : new lines start at the same point on the left 

Align Center: lines of text are centered on the page  

Align Right: lines of text end at the same point on the right  

Justified Align: lines of text are adjusted so that they start and end at the same 

point  
Ordered List: lines of text are numbered  

Unordered List: lines of text are bulleted 

Decrease Indent: removes indents on the current line 

Increase Indent:  increases the indentation on the current line 

Text Color: change the color of the text  

Background Color: change the background color of the selected text 

Spell Checker button: performs spell check on the selected text or all text if 

nothing is highlighted  
  Horizontal Rule control: creates a line break in text  

  
Hyperlink Control: Add a hyperlink into the text 

  
Insert Image: Insert a picture into the text 

  
 Strikethrough: enable strikethrough text 

  
Subscript: enable subscripting of text 

  
 SuperScript: enable superscripting of text 

  
 Redo Last Action: redo the last action undone 

  
 Undo Last Action: undo the last action performed 

  
Insert Table: insert a data table into the body of text 

  
Enlarge Editor Window: enlarge the editor window 

  
Toggle HTML Source: toggle the editing mode between text and html source 

editing 

2.9 Working In HTML Mode 
  
Memo field formatting tools provide project members with a WYSIWYG tool for writing and formatting issue 
descriptions, issue work descriptions, and issue notes.Project members that prefer to work with HTML tags may switch 
to HTML mode to manually edit the mark up of memo field entries. 
 To enter HTML mode, click the HTML mode button in the formatting toolbar. The HTML Mode button is included in the 
two-line formatting controls. 

  
 

3 Tracking Issue History in the Issue Detail Page 
  

The Issue Detail page presents development organizations with a complete history of a development issue. Project 
team members may view all development issue property definitions, a read-only audit trail of all development work, and 
information about associated events, linked issues, and customers. 

The Issue detail page is divided into 12 distinct report areas. Each section displays detailed information about the 
current status or history of the development issue. 

The Owner State Change History report ?The Description report  

The Current Status report  

The Tracking History report  

The Links report  

The Change Log report  

The Web Conversation report  

The Notes report  

The Events report  

The Customer Info report  

The Time Track report  

The Custom page reports 

Project members may select which reports are displayed in their DevTrack client using personalization controls in the 
User Preferences manager. For more information seePersonalizing the Issue Detail Report. 

Development organizations may not only view the history of development issues in the Issue detail page, they may also 
manage the issue itself. Data-entry controls displayed in the Issue detail page enable project members to update or 
forward development issues. 

  

3.1 Understanding the Owner and State Change History Region 
  

The Owner and State Change History report displays the history of ownership and issue workflow state changes of a 
development issue. 

 

  

The Owner and State Change History report displays all development issue updates in sequential order. 

Each action (transition, issue workflow state change, or ownership change) is represented by a color-coded action 
arrow, the name of the project member that performed the action, the transition, the issue workflow state, and the date 
and time of the action. 

  

 

The action arrows are color-coded to indicate the type of action executed. 

  Thered actionarrow represents a submit action. 

Thegreen actionarrow represents a update or forward action. 

Theblue actionarrow represents a close action. 

  

  

  

3.2 Understanding the Description Report 
The Description report displays all of the issue properties tracked in the Description page as well as the Issue ID 
number and the subproject. 

3.3 Understanding the Current Status Report 
The Description report displays all of the issue properties tracked in the Current States page as well as the name of the 
project member that originally submitted the issue and the project member who assigned the issue to the current owner. 

3.4 Understanding the Tracking History Report 
The Tracking History report displays information about the changes made to an issue in a tabular format. 

The Tracking History report displays changes in ownership, changes in issue workflow state, changes to the issue 
description, and the date and time of these changes. 

  

 

3.5 Understanding the Change Log Report 
The Change Log report in the Issue Detail page displays the complete record of every update made to a development 
issue in chronological order. 

 

The Change Log report shows a complete history of every change to issue properties, the executor of that change, and 
the date and time of that action. 

Indexed Data All text entered in memo fields is 
indexed by the DevTrack Search 
Engine. Indexed information enables 
project members to quickly search 
the notes, memo fields, and 
descriptions of DevTrack issues and 
events. 

Time Stamping Memo field controls support the time 
stamping of all data entered in the 
field. A time stamp is a signature that 
is concatenated to text entered in the 
data-entry field that logs the exact 
date and time of the entry. 

Mandatory Fields Many memo field controls may be 
defined as mandatory by the project 
administrator. A mandatory field is a 
data-entry control that must be 
completed before other changes to 
that issue may be saved. 

Text Formatting Tools Memo field controls feature graphical 
text editing tools that enable project 
members to format issue descriptions 
and use modern link-based systems 
in the DevTrack Windows and web 
clients. The DevTrack HTML editor 
enables project members to format 
text entries and display images using 
standard graphical formatting tools. 
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Unlike the Owner and State Change History report and Tracking History reports, the Change Log report recordsevery 
updateto issue property definitions and not just those that change the issue workflow state or issue owner. 

Every edit of issue descriptions in the Description control, Work History control, Notes control, or any other memo field 
control are recorded in the Change Log report. 

  

3.6 Understanding the Link Report 
The Link report displays high-level information about every issue or incident that has been linked with the issue. 

 

For each linked issue the Link section displays:  

Project Name  

Project ID  

Issue ID  

Issue Title  

Status 

Owner  

Link Type 

  

3.7 Understanding the Notes Report 
The Notes report displays all of the notes associated with the issue. In addition to the title and body of the note itself, the 
Note section also displays 

The name of the project member who created the note and the date and time the note was created. 

All attachments, knowledge items, or web pages associated with each note. 

 

The Notes Section only displays notes that are currently associated with a issue. Once a note is deleted information 
about that note and all note content is removed from the Notes section of the History page. 

  

3.8 Understanding the Customer Info Report 
The Customer Info report displays information about customers associated with the issue including the customer type, 
the customer contacts linked to the issue, and contact phone numbers and e-mail addresses. 

 

The Customer Info section is only displayed in the History page if the project administrator has associated the project 
with a customer base project. Customer base projects and the Beta Customer Portal are features of the DevTrack 
Enterprise Edition. 

  

3.9 Understanding the Custom Page Report 
The Custom Page report displays issue properties tracked in a custom page. The History report may display one 
section for each custom page added to the project. (The name of the report section represents the administrator-
defined name of the custom page). 

Project administrators may add up to five custom pages to a project. 

 

The fields and data displayed in this section of the History page depends on customizations made to the custom page 
by a project administrator. 

  

4 Managing Development Issue Notes 
Issue notes and note attachments enable project teams to communicate issue-specific information with one another. 
Notes are issue-specific comments. Project members may add any number of notes to each issue. Project members 
may create and to add notes and file attachments to DevTrack issues in the Notes control. 
The issue notes provide project teams with a repository for storingissue-specificrather than project-related information. 
The Notes page of the main view is displayed in the issue detail panel and is divided into three areas: the Note list, Note 
detail area, and the File Attachment area. 
The Note list displays the title, the user name of the note submitter, and the date and time of the note submission for 
each note associated with the current file. Notes that include file attachments display a small icon that indicates the 
attachment type. 
The HTML Links icon indicates that the attachment is a web page URL. 
The File Attachment icon indicates that the attachment is a document, spreadsheet, knowledge item, or topic. 
The Notes list buttons enable project members to manage notes associated with the current issue: 

The New button enables project members to add a new note to the issue. 
The Select button enables project members to add an attachment directly to the issue without a note. Project 

members may subsequently add a note to the attachment or add an attachment to the original attachment. 
The Edit button enables project members to edit the note title and the body of the note. Project members may not 

edit the note attachment. 
The Delete button enables project members to delete issue notes. 

4.1 Adding Notes to Development Issues 
Project members may use the New button in the Notes page to add a note to a DevTrack issue. Issue notes consist of 
the note title, the body of the note, and, optionally, a note attachment. 
The Notes control may feature additional tools that enable project members to better describe development tasks: 

Screen captures: The Issue Description control is one of two data-entry controls (the other is the Notes Description 
control) that supports the DevTrack smart screen capture utility. 

HTML Text Editor: The Issue Description control displays tools that enable project members to format the text 
displayed in the memo field control. 

4.1.1 To Add Notes to Issues 
1 Click the New button in the Notes tab of the issue detail panel. 
The Add Notes manager appears. 
2 Enter a title for the note in the Title field. 
3 Enter the body of the Description field. 
The text of the note appears in the Note field of the Notes page. 
4 Click the OK button. 
The Add Notes manager closes. The note appears in the Note detail area and any 
attachments appear in the Attachment/Knowledge list of the Notes page. 

4.2 Editing Issue Development Notes 
Project members may use the Edit Notes dialog box in the Notes page to edit the title and text of any note added to 
DevTrack issues. 
Project members may only edit their own notes unless they have been granted the Can Edit Other User? Notes privilege 
by an administrator. 

Note:Project members may not use the Edit Notes dialog box to change or delete note attachments. The Detach 
button in the Notes page may be used to detach an attachment from a note. The Attach button may then be used 
to add a different attachment. 

4.2.1 To Edit a Note 
1 Select the Notes tab in the issue detail panel. 
2 Click the Edit button. 
The Edit Notes dialog box appears. 
3 Update the title in the Title field. 
4 Update the body of the note in the Notes field. 
5 Click the OK button. 

4.3 Deleting Development Issue Notes 
To delete development issue notes, select a note in the Note list of the Note tab in the issue detail panel and click the 
Delete button. 

4.4 Displaying all Development Issue Notes 
To display all development issue notes, select the All radio button in the Notes tab of the issue detail panel. 

4.5 Filtering Notes by Note Type 
Development organizations may now organize and manage issue notes usingnote types. An administrator-defined note 
type identifies different subtypes of development notes to increase the security and accessibility of development 
issues. 
Development notes may be filtered and searched for based on note type.The Notes page in the DevTrack clients now 
display controls that enable project members to filter the issue notes displayed in the Notes list by note type. 

4.5.1 To Filter Notes in the Notes Tab 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 
  

 

2 Add or remove note types to the Note list. 
 To add a note type to the Note list, select the note type in the Available Note Types list and click the Right arrow. 

Notes belonging to the selected note types are displayed in the Note list. 
 To remove a note type to the Note list, select the note type in the Selected Note Types list and click the Left arrow. 

Notes belonging to the selected note types are not displayed in the Note list. 

4.6 Adding or Removing Note List Display Columns 

4.6.1 To Add or Remove Columns in the Note List 
1 Select the Filter radio button in the Notes tab of the issue detail panel. 
The Notes Display Preference dialog box appears. 

 

2 Add or remove columns to the Column list. 
To add a column to the Note list, select the column in the Available Note Types list and click the Right arrow. 
To remove a column to the Note list, select the column in the Selected Note Types list and click the Left arrow. 
3 Click the OK button. 
The Notes Display Preference dialog box closes. 

5 Managing Development Issue Attachments 
DevTrack enables project members to add four different types of attachments to issue notes: new files, existing files, 
new URLs, and existing URLs. 

 New files include any new file that is added directly to the issue note. These files cannot be accessed or managed in 
the knowledge view. 

Existing files include any topic, document, or attachment saved in the DevTrack system and managed in the 
knowledge view. 

New URLs include links to web pages that are added directly to the issue note. These URLs are only accessible from 
the Notes page. 

Existing URLs include links to web pages that are stored in and managed in the HTML Links folder of the knowledge 
view. 

5.1 Attaching New Documents to Development Issues 
A document is any document that is added directly to an issue note. Project members may add file attachments may be 
added to notes whenever a project member creates a new issue note or by using the Attach command in the Notes 
page. Only one attachment may be added to each issue note. 
Project members may add a file attachment to each issue note using controls in the Notes page of the issue detail 
panel. 
All attachments added to DevTrack notes may be accessed through the Attachments folder in the knowledge view. 

5.1.1 To Add a New Document to a Development Issue 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Attach a New File radio button. 
The Select a new File dialog box appears. 
6 Navigate to the file on the local hard drive. 
7 Click the OK button. 
The Select a new File dialog box closes. 
8 Click the OK button in the Add Notes manager. 

5.2 Attaching Existing Knowledge Items to Development Issues 
Project members may add links to existing DevTrack files (documents, topics, and attachments) to issue notes using 
the Link to Knowledge Topic manager. 
An existing file is a document, topic, or attachment that is stored in the DevTrack database and that may be managed 
using tools in the knowledge view. using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 

DevTrack User Guide

Page 82 of 148



using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 
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using tools in the knowledge view. 
File attachments may be added to notes whenever a project member creates a new note or attaches a knowledge item 
to a note in the main view Notes page. 
The Link to Knowledge Topics manager enables project members to locate and select existing knowledge topics, 
documents, and attachments stored in the DevTrack database. 
 

 

Link to Knowledge Topics Manager is divided into four sections: 
The Project dropdown list enables project members to select the project in which the files are stored and 
managed. The option selected in this control determines the folder structure displayed in the Tree menu. 
The Knowledge tree menu enables project members to navigate through the selected knowledge view to locate 
the correct file. The tree menu displayed represents the tree menu displayed in the knowledge view of the 
selected project. 
The File Name field displays all of the files contained in the highlight knowledge tree folder. A check mark appears 
next to the file name when the file is selected. 
The File field displays the text of the selected file. 

5.2.1 To Add Existing Knowledge Items to Issues 
1 Select the Notes tab in the issue detail panel. 
2 Click the New button. 
The Add Notes manager appears. 
3 Enter note details in the fields provided. 
For step-by-step instructions on creating new notes see Adding Notes to Development Issues(create link). 
4 Click the Attach button in the Add Notes manager. 
The Attach dialog box appears. 
5 Select the Link to an Existing File radio button. 
6 Click the OK button. 
The Link to Knowledge Topics manager appears. 
7 Select a project option from the Project dropdown list. 
8 Locate the file and folder in the Knowledge tree menu. 
9 Select the file to be attached to the note. 
A check mark appears next to selected knowledge items. 
10 Click the OK button. 
The Link to Knowledge Topics manager closes. 
11 Click the OK button in the Add Notes manager. 

5.3 Attaching New HTML Paths to Development Issues 
Project members may attach new HTML paths to issue notes whenever they add a new note to a DevTrack issue. 

New HTML paths are attached directly to each issue and are managed in the Notes page. New HTML paths are not accessible in knowledge view. 

Existing HTML paths are created and managed in the knowledge view and attached to issues. For more information see "Attaching Existing HTML Paths to Development 

Issues".

5.3.1 To Attach New HTML Paths to Development Issues 
1Select the Notes tab in the issue detail panel. 

 Chapter 7- Subproject Management 

In this chapter: 

• Understanding Subprojects 

• Managing Normal Subprojects 

• Managing Subproject Schedules 

• Managing Subproject Knowledge 

• Managing Issues in Subprojects 

• Managing Subproject Reports 

1 Understanding Subprojects 
A subproject is a logical grouping of issues within a DevTrack project that enables development teams to schedule, 
prioritize, and track those issues separately from other issues in the project. 

Each subproject has its own description, priority, status, and start and end dates that define how issues are managed as 
a group. Moreover, issue access controls, applicable issue type rules, and workflow rules may be defined independently
for each subproject. 

Subprojects are represented in the issue tree panel of the DevTrack clients assubproject foldersorganized in an 
hierarchical tree structure. 

The hierarchical structure of subprojects defines and represents the parent-child relationships between subprojects. 
Every user-defined subproject is the child of a parent subproject and may be the parent to one or more child 
subprojects. Subproject due dates, delivery dates, and notes may be inherited by child subprojects from their parent 
subproject. 

The hierarchical structure shows the relationships between groups of issues and defines how those issues are 
managed. 

Project members may filter, search for, and run reports on development issues based on their subproject. 

Development organizations may use any taxonomy to organize development issues 

1.1 Subprojects and branch management 
Branch management is an optional DevTrack Enterprise Edition feature that enables development organizations to 
define and manage business objects representing products, versions, and builds and to manage these objects in 
subprojects. Each release subproject represents a specific product, version, or build. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships, enforces control of development subprojects, and clearly represents the relationships between each area 
of development. 

Using DevTrack branch management, the subproject hierarchy both represents the designed product that is in 
development andwork breakdown structurethat will used to implement that vision. 

If DevTrack branch management is enabled in a DevTrack project, project members may create and manage two 
different types of subprojects. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

For more information on branch management and release subproject management see Managing Release Subprojects.

2 Managing Normal Subprojects 
A normal subproject is logical grouping of issues within a DevTrack project that enable development organizations to 
schedule, prioritize, and track those issues separately from other issues in the project. 

Using normal subprojects, development organizations may organize issues by development groups, issue priorities, 
components, delivery dates, or any other category that makes sense to the business. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. For more information on branch 
management and release subproject management see ?anaging Normal Subprojects in Release Structures.? 

The Subproject tree window enables project members to create and organize a hierarchy of subfolders to manage their 
issues. Project teams may create subproject folders within the main Project Issues folder. 

  

2.1 Creating Normal Subprojects 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
web client. 

The New Subproject page consists of three tabbed pages: the General page, the Workflow page, and the Subproject 
Child Fields page. 

The General page 

The Workflow page 

The Subproject Child Fields page 

To create a subproject, project members must belong to an account type that has been granted the appropriate 
privileges by the project administrator. 

2.1.1 Creating Normal Subprojects (DevTrack Web Client) 

To create normal subprojects (DevTrack Web Client):

1.      Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject. 

2.      Select the New command in the Action control. The New Subproject page appears. The New Subproject page 
consists of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

3.      Define general subproject properties in the General page. General subproject properties include: 
  
Title 
Status 
Percent Complete 
Priority 
Type 
  
4.      Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of 

the General page. Subproject date properties include: 
 

Start Date 
Finish Date 
Due Date 
Delivery Date 
5.      Optional: To define subproject notes, enter a brief note in the Note text field control. 
6.      Optional: To define the title of subproject workflow, enter a unique title in the Title control of the Workflow tab. 
7.      Optional: Define applicable choices for definable fields. 
8.      Click the Submit button. 

  

2.1.2 Creating Normal Subprojects (DevTrack Windows Client) 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

Project members with the appropriate privileges may create new subprojects in the issue tree panel of the DevTrack 
Windows client. 

The New Subproject page consists of three tabbed pages: 

The General page 

The Workflow page 

The Subproject Child Fields page 

2.2 Updating Subproject Properties 
Subprojects are a tool or organizing the development issues into smaller more meaningful categories. 

All subprojects are created within a hierarchical tree structure that defines the relationships between subprojects. Each 
subproject is the child of a parent subproject and may be the parent of many child subprojects. 

2.2.1 To Edit subprojects (Windows Client) 

Right-click a product subfolder in the Subproject tree list window and select the Edit command in the shortcut menu.
The Subproject manager appears. 

Update general subproject properties in the General tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.2.2 To Edit subprojects (Web Client) 

Select a subproject folder in the issue tree panel. 

Select the Property command in the Action control.The Subproject page appears. The Subproject page consists of
four tabbed pages: the General page, the Workflow page, the Product/Version page, and the Subproject Child 
Fields page. 

Update general subproject properties in the General tab. 

Update branch management properties in the Product/Version tab. 

Update subproject child fields in the Subproject Child Fields tab. 

Click the OK button. 

2.3 Closing Subprojects 
Project members may close a subproject by selecting the It Is Closed option in the Subproject dialog box or by 
selecting the Close command in the Issue tree shortcut menu. 

Project members typically close subprojects once the subprojects due date has passed and the custom development 
work, product, or release has been delivered. A closed subproject is a subproject that has been closed by a project 
member. 

No issues may be added to a subproject once that subproject is closed. 

A subproject may be closed only if there are no open issues associated with that subproject. 

Closed subprojects are not displayed in the issue tree panel by default. Project members may display or hide close 
subproject folders by selecting the Show Closed Project command in the Tree window shortcut menu. For step-by-step 
instructions see ?isplaying or Hiding Closed Projects.?o:p> 

To close a subproject: 

Right-click in the issue tree panel. The Subproject dialog box appears. 

Select the date that the subproject was completed in the Delivery Date control. 

Select the It Is Closed check box. 

Click the OK button. The Subproject dialog box closes. 

  

2.4 Displaying or Hiding Closed Projects 
Project members may use the Show Closed Project command in the Subproject shortcut menu to display or hide 
closed subproject folders in the issue tree panel. 

By default closed subproject folders are not displayed in the issue tree panel. 

To display closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears. 

Select the Show Closed Projects command. A black check mark appears next to the title of the command. 

To hide closed projects: 

Right-click the Project Issues folder The Issue Tree shortcut menu appears.  

Select the Show Closed Projects command. No check mark appears next to the title of the command. 

2.5 Defining Subproject Statuses 
The Subproject Status control tracks the progress made on the development project managed within that subproject. 

Subproject statuses may be defined manually by selecting an administrator-defined option from the Status dropdown list
or may be defined automatically based on administrator-defined rules. 

Four different methods may be used to determine the progress status of a subproject. 

Independent of its Incidents 

Derived from the lowest-ranked incident status 

Derived from the highest-ranked incident status 

Linked to Incident Status Definition 

2.6 Deleting Subprojects 
A project member must belong to an account type that has been granted the appropriate privileges to delete a 
subproject. 

To delete product subprojects: 

Right-click a product subfolder in the Subproject tree list window and select the Delete command in the shortcut 
menu. A DevTrack dialog box appears. 

Click the OK button. 

2.7 Placing Subprojects in the Issue Tree Panel 
The issue tree panel displays subproject folders and personal folders belonging to individual project members or their 
team members. 

The My Personal Folder and Team Member? Folder are not contained in the Project Issues folder. Personal folders are
displayed above or below the Project Issues folder in the issue tree panel depending on user preference settings. For 
more information see ?anaging Personal Folder Preferences.?/FONT> 

3 Managing Subproject Schedules 
Project scheduling consists of defining dates and time lines for completion subproject tasks. Project managers may 
define a project schedule whenever they create or edit a subproject in the General tab of the Subproject page. 

The General tab displays the five controls used to define subproject time lines: the start date, the finish date, the 
duration, the due date, and the delivery date. 

The Start Date identifies the beginning date for the work associated with the project. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Finish Date identifies the ending date for the work associated with the project. The finish date defines the actual end
of the subproject and is used to calculate the duration of the subproject and critical paths. 

The Due Date is a milestone that represents the date that the subproject is due to be finished. Project managers may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

The Delivery Date represents the date by which the end product of the subproject is delivered and is used to calculate 
critical paths when a subproject is the predecessor of another subproject. Project managers may mandate that the 
delivery date of a parent subproject is inherited by one or more of its child subprojects. 

3.1 Defining Subrpoject Start and End Dates 
Every subproject has a distinct start and end date. The starting and ending dates of all subprojects are managed and 
tracked in the Start Date control and the End Date control of the Subproject manager. 

The start date identifies the beginning date for work associated with the subproject. The start date defines the actual 
beginning of the subproject and is used to calculate the duration of the subproject in DevPlan.  

The end date defines the actual end of the subproject and is used to calculate the duration of the subproject and critical 
paths in DevPlan. 

To define the start date or end date of a subproject, select the Ellipsis button adjacent to the Time control and select the
date from the Time control 

3.2 Defining Subproject Due Dates 
The due date is a milestone that represents the date that the subproject is due to be finished. Project manages may 
mandate that the due date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject due date inheritance rules, select an option from the due date Inheritance dropdown list control. 

The date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

3.3 Defining Subproject Delivery Dates 
The delivery date is a milestone that represents the date that the subproject is due to be delivered. Project manages 
may mandate that the delivery date of a parent subproject is inherited by one or more of its child subprojects. 

To define subproject delivery date inheritance rules, select an option from the Note Inheritance dropdown list control. 

The delivery date Inheritance dropdown list displays two options: 
 
?Just for this Subproject 
 
?Enforced for all Children 

  

3.4 Understanding Subproject Time Inheritance 
In DevTrack project members may define relationships between parent and child subprojects that enforce the 
inheritance of subproject settings for the Due Date, Delivery Date, and Notes properties. 

Project members may define three types of inheritance rules 
 
?The Enforced by Parent rule creates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?The Just for this Subproject rule does not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?The Enforced for All Child Subprojects rule mandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Settings tab in the Subproject detail window. 

Select an option from the Inheritance dropdown list. 

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

4 Managing Subproject Knowledge 
The application development life cycle starts with the design of a product. Software products are generally planned and 
defined and in a series of control documents including business requirements, functional specifications, technical 
specifications. Each document may go through several revisions before the product design is approved. 

But to see the ?esigned product?described in the design documents realized, an organization must ensure that all 
project stakeholders have access to the most up-to-date documents and that project managers and team leaders are 
held accountable for implementing features as they were designed. 

The subproject hierarchy organizes all areas of development, all products, features, versions, and builds, into 
subprojects. Control documents may be directly linked to each subproject providing all stakeholders with access every 
document that is specifically relevant to that area of work. 

The subproject hierarchy is the framework for all planning and development so the documents linked to a subproject are
accessible in both DevPlan and DevTrack. 

  

4.1 Managing Subproject Notes 
Project managers may create and to add notes and file attachments to subprojects in the Notes control of the General 
Settings tab in the Subproject detail window. Subproject notes enable project teams to communicate subproject-
specific information with one another. 

To define subproject notes, enter text in the Notes control of the General Settings tab of the Subproject detail window. 

4.2 Defining Subproject Note Inheritance 
Notes defined in the Notes control may be inherited by every child subproject of the active subproject. The displays of 
subproject notes is based on user-defined inheritance rules. 

Project members may define three types of inheritance rules 
 
 
 
?TheEnforced by Parent rulecreates a relationship between the parent subproject and its children by which parent 
subproject settings are inherited by the child subprojects. 
 
?TheJust for this Subproject ruledoes not create a relationship between the current subproject and its children. 
Subproject properties are not inherited. 
 
?TheEnforced for All Child Subprojects rulemandates that all child projects inherit subproject properties from the 
parent subproject. Inherited subproject definitions may not be overwritten in child subprojects. No inheritance 
relationships may be defined for the Start Date or Planned Date subproject properties. 

To define subproject note inheritance rules: 

Select a subproject in the Subproject tree list window. 

Select the General Se ings tab in the Subproject detail window.  

Select an option from the Inheritance dropdown list.  

The Inheritance dropdown list displays two options 
 
 
 
?Enforced by Parent 
 
?Just for this Subproject 

  

5 Managing Issues in Subprojects 
Project members may use subproject folders to manage issues in DevTrack projects. Using controls in the DevTrack 
client project members may create issues in subprojects, move existing issues to subproject folders, or order issues in 
each subproject. 

5.1 Submitting Issues to Subprojects 
Project members may create issues in a subproject by two different methods. 
 
 
 
?Issues may be created directly in a subproject using the New Issue command in the Subproject shortcut menu. 
 
?Issues may be added to a subproject during issue submission by selecting an option from the Subproject dropdown 
list of the New page. 

To submit an issue to a subproject: 

Right-click a subproject in the issue tree panel. The Issue Tree shortcut menu appears. 

Click the New Issue command. 

Define the issue properties.  

Click the OK button. The issue is automatically assigned to the selected subproject. 

To add an issue to a subproject: 

Create an issue. 

Define the issue properties.  

Select an option from the Subproject dropdown list. 

Click the OK button. The issue is automatically assigned to the selected subproject. 

5.2 Moving Issues Between Subproject Folders 
Project members may move issues from one project to another by using the ?rag-and-drop?method common to 
Windows applications. 

The ability to quickly click on other subprojects to view related issues provides a very efficient way to organize and 
manage development issues. 

To drag-and-drop issues: 

Click the issue in the issue list panel. 

While keeping the mouse button depressed, move the cursor to the target subproject in the subproject frame. The 
subproject folder is highlighted. 

Release the mouse button. The issue is now associated with the new subproject. 

5.3 Filtering Issues by Subproject 
Clicking on a subproject folder in the Subproject Tree window filters the issues displayed in the issue list panel. 

To display all the issues in the entire project, click the Project Issues folder in the issue tree panel. 

  

6 Managing Subproject Reports 
Subprojects are fully reportable in the DevTrack Windows client. 

Project members may filter report results based by subproject. To apply a query using subproject filters, use the same 
functionality used during any other search within the DevTrack client. 

Each report type may be grouped by subproject. Three new reports are available specifically for grouping by 
subprojects: 
 
 
 
?List report by subproject 
 
?Distribution report by subproject 
 
?Trend report by subproject 
 
 
 
For more information on running reports in the Windows client see ?anaging List Reports? ?anaging Distribution 
Reports? and ?anaging Trend Reports.?/FONT> 

  

 Chapter 8- Searches and Queries 

In this chapter: 

• Understanding DevTrack Searches and Queries 

• Managing Customer Searches 

• Defining Keyword Search Conditions 

• Managing Event Searches 

• Defining Note Type Search Conditions 

• Managing Event Searches 

• Managing Issue Workflow Search Conditions 

• Managing Customer Searches 

• Managing Saved Queries 

1 Understanding DevTrack Searches and Queries 
The ability to effectively identify, prioritize, and manage key development issues is key to development processes. To 
work effectively, project members must be able to quickly identify and executed important tasks. Too much information 
can be overwhelming and make it difficult for developers to focus on the task at hand or stay on top of important issues. 

Issue filtering and querying is crucial. Filtering enables users to quickly identify relevant issues based on key indicators, 
minimize the time needed to review large numbers of records, and to maximize effectiveness. The DevTrack search 
engine returns all work items that match the search criteria and displays those work items in the list panel. 

A DevTrack query is a set of instructions for retrieving and displaying development issue data in the issue list panel or 
DevTrack report. Every query consists of one or moresearch conditions, which identify the data fields searched and the
field value criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the 
AND, NOT, and OR logical operators. 

  

1.1 Understanding the Search Manager 
The DevTrack Search Manager takes issue filtering a step further by enabling project members to define complex 
queries based on keywords, project timelines, issue histories, the status of related events, or a combination of multiple 
search conditions. 

Unlike standard database queries, which require knowledge of a search language such as SQL to define the search 
criteria, DevTrack enables the user to define complex queries that incorporate multiple conditions and search logic 
using controls in a graphical interface. 

The Search Manager is a multiple page form that displays controls in up to five pages: the General Properties tab, 
Custom Fields tab, State Change tab, Event tab, and Customer tab. Each tab displays tools that enable the user to 
define search conditions based on issue-related criteria. 

 

The Events tab and the Customer tab are optional and are only displayed in the Search Manager if these features have 
been enabled in the project. 

Every tab is organized into four distinct areas: the Field list, Field Values area, Search Condition list, and Search Logic 
control. Using the controls in each area, project members may define the three components of a DevTrack query: 
search conditions, search terms, and search logic. 

In theField Listarea the user may select the field (usually an issue property) to be queried. 

In theField Valuearea the user may identify the field values (issue property definitions) that define thesearch 
condition. 

TheSearch Conditiondisplays all user-defined search conditions and organizes those search conditions into 
discreet groups calledsearch terms. 

In theSearch Logicarea the user may define logical relationships between search terms using three operators: 
AND, OR, and NOT. 

2 Managing Searches Based on Issue Property 
Definitions 
In DevTrack, the most common type of query is based on issue property definitions. An issue is a collection of data that 
represents a particular task or set of tasks that must be processed in the course of a development project. Every issue 
is defined by a unique issue ID, description, workflow state, owner, work description, and other dynamic properties. 

Using tools in the General Properties page, project members may define search conditions based on keywords, issue 
property values, user and issue variable values, and other parameters to display subsets of issues in the issue list panel.
A search condition is a set of issue property definitions that define the criteria of the search. 

2.1 Understanding Issue Property Searches 
A DevTrack issue is a collection of many different types of data that are stored in the database using different field 
types that are tracked in the client using different control types. 

The Search Manager enables project members to easily define search conditions for every type of data. The search 
condition tools that are displayed in the Search Manager depend on the control type control type that represents the field
in the client Search conditions for time-date property definitions may be defined using date-time controls. 

Issue property queries may be defined using field text, date-time, field value, keyword, and other tools displayed in the 
field value area of the Search Manager. 

  

2.2 Defining Field Text Search Conditions 
Field text search conditions return issues that match a user-defined text string. Using field text search conditions, project
members may query data that is tracked in text field controls including the Title property. 

Text Field search conditions may be used to query any custom field that is tracked using a text field in the client. 

Text field search conditions may also be used to retrieve issues by their system-defined ID numbers. In DevTrack, 
every development issue is identified by a sequential ID number that is assigned to that work item when it is submitted 
to the project. 

Using basic punctuation marks (commas, hyphens, and asterisks) as logical operators, project members may define 
complex queries to locate multiple work items based on ranges of work item ID numbers. 

Use commas to search for multiple records (for example, 3, 7, 21). 

Use hyphens to search for ranges of records (for example, 20-50)  

Use asterisks (*) as wildcard characters to search for multiple records (for example, *9).  

Use the greater than >, less than <, and equal to = characters to define dynamic ranges of work items.  

Combine commas, hyphens, and asterisks in a single Go To search (for example, 3, 20-30, *9). 

The wildcard expression may be used to distinguish different ranges of work items: 

  

Greater than and less then characters may be used to search for dynamic ranges of work items. 

  

 To define a text field search condition:  

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The Title and Issue ID may be queried with search conditions defined using text field search conditions.  

Define search terms in the Keyword Search area. 

 

2.3 Defining Field Value Search Conditions 
  

Field value search conditions return issues that match criteria selected from a predefined set of options. Field value 
search conditions may be used to query data that is tracked in selection controls autogrow combo boxes, combo boxes,
dropdown list, and multiple selection controls. 

For eachfield(issue property) selected in the field list, the user may select one or morefield values(issue property 
definitions) in the field value area of the Search Manager. 

A field value search condition may represent a single field value or multiple field values and return issues that match any 
one of the defined criteria. For example, Terry Johnson may want to search for all of the issues owned support 
technicians. By selecting the{Owner}variable in the field list and the *Tech Support account type in the field value area, he 
may define a search condition that returns issues that are owned by project members belonging to the TechSupport 
account type. 

Field value search conditions may be used to query for issue properties that are tracked as system-defined variables or 
in fields that are represented byselection controlsin the client dropdown lists, combo boxes, autogrow combo boxes, or
multiple selection controls. 

2.3.1 Selection Controls 
A selection control is a graphic element that enables the user to choose an option from a predefined list of options. 
DevTrack supports four selection control types: autogrow combo boxes, combo boxes, dropdown lists, and multiple 
selection controls. 

Many core issue properties are tracked using selection controls in the client including the Type, Priority, and Workflow 
State issue properties: 

The Type field tracks the issue type property. Type conditions return issues defined by a selected issue type. 

The Priority field tracks the issue priority property. Priority conditions return issues defined by a selected priority. 

The Progress Status field tracks the issue workflow state property. Progress Status conditions return issues that 
are currently in selected workflow states. 

Field value searches may be used to query any custom field that is tracked using a selection control in the client. 

2.3.2 User Variables 
  

A user variable is a system-defined placeholder that represents an issue stakeholder a project member that has a 
working relationship with the work item. User variables enable project members to queries that return issues that are 
owned, submitted, or closed by particular project members. User variables include the{Submitter} user variable,{Current Owner}

user variable, and{Previous Owner}user variable. 

The{Current Owner}user variable tracks the issue owner at every stage in the issue life cycle.{Current Owner}conditions returns 
issues that are owned by selected project members based on their account type or team group. 

The{Submitted By}user variable represents the project members that initially submitted issues to a project.{Submitted By}conditions
return issues that were submitted by selected project members based on their account type or team group. 

The{Closed By}user variable represents the project members that closed issues to a project.{Closed By}conditions return issues 
that were closed by selected project members based on their account type or team group. 

  

 

2.3.3 Issue Variables 
  

An issue variable is a system-defined placeholder that represents an issue property that is not tracked using data-entry 
control in the client. Issue variables enable project members to define queries that return issues based on workflow 
transitions, link types, subprojects, and substatuses. 

The {Substatus}issue variable tracks the substatus of an issue at every stage in the issue life cycle. {Substatus}conditions return 
issues defined by the selected substatuses. 

The{Last Transition}issue variable the most recent transition in the life cycle of an issue.{Last Transition}conditions return issues that 
which have transitioned between two workflow states by means of the selected transitions. 

The{Links}issue variable tracks link types used to connect an issue to other work items.{Links}queries return every issue that 
is linked to another work item using selected link types. 

The{Subproject}issue variable tracks the parent subproject of an issue.{Subproject}conditions return issues that are the children of 
selected subprojects. 

The Include/Exclude check box enables project members to quickly select or deselect all of the field values displayed 
in the field value list. 

The Include option returns only those records that contain the selected field values in the search field. 

The Exclude option returns only those records that do not contain the selected field values in the search field 

  

2.3.4 To define a field value search condition 

Open the Search Manager.  
Select a search field in the General Properties tab. 
 
 
 
The Field List displays a list of search fields including issue properties, issue variables, and user variables.  
Optional:To define the logic of the search condition, select the Include or Not Include option button. 

The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR operator. 

Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select All option button. 
or Clear All op on bu on.  
Select search criteria in the Selection list. 
 
 
 
The Field Value list displays field values that belong to the issue property (selection control, issue variable, or user 
variable) that was selected the Field Name list. 

2.3.5 Defining Date and Time Search Conditions 
A date-time condition returns development issues based project schedules and time lines including the date and time 
that those issues were were submitted, due, assigned to the current owner, closed, or last edited. 

In DevTrack, project members may define two types of date-time search conditions: static (fixed dates) date-time 
conditions and dynamic (number of days) date-time conditions: 

A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are defined 
by a fixed starting date and fixed ending date. 

A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to the 
current date that marks the first day of the condition scope. 

2.3.5.1 Date-time fields 
Date-time conditions enable project members to query issue properties that are tracked indate-time controlsor are 
represented by time-based issue variables. 

TheDate Assignedfield tracks the date that the issue was assigned to the current owner. 

TheDue Datefield tracks the date that the issue is due to be completed. 

The{Date Closed}issue variable tracks the date that the issue was closed. 

The{Date Submitted}issue variable tracks the date that the issue was submitted to the project. 

The{Date Modified}issue variable tracks the date that the issue was last edited. 

Date-time conditions may also be used to query custom-defined date-time fields. 

  

2.3.5.2 To define a static date search condtion 

Open the Search Manager.  

Select a date-time field in the Field List. 
 
 
 
The field list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed Status}

issue variables, and all custom-defined date-time fields. 

Select the Static Search option in the Field Value area of the General Settings tab. 
 
 
 
A static date-time condition returns all issues that fall within a fixed time period. Static date-time conditions are 
defined by a fixed starting date and fixed ending date. 

Define the beginning date in the From date-time control and the ending date in the To date-time control. 

2.3.5.3 To define a dynamic date search condition 

Open the Search Manager.  

Select an issue property in the Field List. 
 
 
 
The field value list displays the Date Assigned and Due Date system fields, the{Date Closed},{Date Submitted},{Date Modified}, and{Closed 

Status}issue variables, and all custom-defined date-time fields.  

Select the Dynamic Search option in the Field Value area of the General Settings tab. 
 
 
 
A dynamic date condition returns all issues that fall within a dynamically defined time period. Dynamic date-time 
conditions are defined by acondition scope. The number of days and acondition offset the number of days prior to 
the current date that marks the first day of the condition scope.  

Define the condition scope (in days) in the Days text box. 
 
 
 
The condition scope defines the number of days that are included in the condition. For example, if the condition 
scope is set to 30 days, the condition returns issues falling within a 30 day time period.  

Define the condition offset (in days) in the Offset text box. 
 
 
 
The condition offset defines the days prior to the current date that marks the first day of the condition scope. For 
example, if the condition offset is set to 40 days, the condition returns issues falling within a 30 day time period that 
starts 40 days before the present date. 

  

2.3.6 Defining Keyword Seach Conditions 
In DevTrack, a keyword is a term (word, phrase, or alphanumeric string) that is used as a search condition in a query. 
The DevTrack search engine searches for instances of the keyword in a record set and returns those records in which 
the keyword is found. 

Using controls in the Search Manager, the user may define rules for handling search conditions that include multiple 
keywords. Search logic rules include Any of the these Words, Exact Phrase, All of these Words, and None of these 
Words rules. 

  

 

The keyword condition scope defines that fields searched. Keyword conditions may be defined for one or all of the 
following fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, and Event 
Description fields. 

Project members may define search conditions based on multiple keywords, a range of keywords, or exact phrases. 
The field value area displays four controls: 

TheAny Of These Wordstext field enables project members to search for issues based on multiple words. The 
condition returns any issue that matches any one of the keywords entered in the field. 

TheExact Phrasetext field enables project members to search for issues based on a set of keywords. The condition 
returns only those issues that match the exact phrase. 

TheAll Of These Wordstext field enables project members to search for issues based on multiple keywords. The 
condition returns only those issues that contain every keyword entered in the field. 

TheNone Of These Wordstext field enables project members to search for issues that do not contain a set of 
keywords. The condition returns only those issues that contain none of keywords defined in the field. 

To define a keyword search condition: 

  

1.      Open the Search Manager. 
2.      Select the {Keyword} variable in the Field List. 
3.      Define keywords in the field value area. Keyword conditions may be defined in four controls: the Any Of These 

Words, Exact Phrase, All Of These Words, or None Of These Words text box controls: 
  

To search for issues that include at least one of multiple keywords, enter one or more keywords in the Any of 
These Words text box. 

To search for issues that include a specific phrase or combination of words, enter a text string in the Exact 
Phrase text box. No quotation marks are needed. 

To search for issues that include multiple keywords, enter multiple keywords in the All Of These Words text 
box. 

To search for issues that do not include a term, enter one or more search terms in the None Of These Words 
text box. 

  
4.      Define the keyword condition scope in the field value area. Keyword search conditions may be used to eight 

system-defined fields: the Title, Description, History, Note Title, Note Description, Link Comments, Event Title, 
and Event Description fields. 

 

2.3.7 Defining Note Type Search Conditions 
A note type condition returns issues that are linked to notes that are defined by a user-specified note type. 

A note type is an administrator-defined category of notes, which distinguishes notes of that type from other notes that 
may be linked to issues. Note types enable development organizations to filter and search for issues based on the kinds
of information that are linked to those issues. 

The Search Manager enables the user to choose one or more field values from a list of administrator-defined note 
types. 

Two note types are defined by default: the{Work Note}and{Knowledge}note types. Other note types might include the Comment, 
Resolution, Release Note, or Design note types. 

To define a note type search condition: 

2.3.8 Defining Links Search Condition 
A{Links}search returns issues that are linked to other work items using a user-specified link type. 

A link type is an administrator-defined category of links, which distinguishes those links from other kinds of links. Using 
link types, development organizations may define business rules for managing the relationships between linked work 
items. 

The Search Manager enables the user to choose criteria from a list of administrator-defined link types. 

The field value list displays the{Any Link}and{Unspecified Link Type}variables and all administrator-defined link types. 

The{Any Link}variable returns all issues that are linked to other work items regardless of link type. 

The{Unspecified Link Type}variable returns all issues that are linked to issues without a defined link type. 
 
 
 
Beginning with DevTrack 6, all links are defined by a link type. The{Unspecified Link Type}variable enables the user to search for 
issues based on links created prior to DevTrack 6. 

To define a link search condition:   

  

1.      Open the Search Manager. 
  

2.      Select the {Links} variable in the Field list of the General Settings tab. 
  

3.      Optional:To define the logic of the search condition, select the Include or Not Include option button. 
  

4.      The Include option returns issues that match the field value criteria selected. Equivalent to an AND operator. 
  

5.      The Not Include option returns issues thatdo not matchthe field value criteria selected. Equivalent to an OR 
operator. 

  
6.      Optional: To select all or clear all search field values displayed in the Search Condition area, select the Select 

All option button. or Clear All option button. 
  

7.      Select a link type option in the Search Conditions area. The field value list displays the {Any Link} variable, the 
{Unspecified Link Type} variable, and all administrator-defined link types. 

2.3.9 Defining Subproject Search Conditions 
A{Subproject}search returns issues that belong to one of a user-specified list of subprojects. Every issue may be defined by 
a single owner, workflow state, and subproject. 

A subproject is a tool for organizing development issues into smaller, more manageable areas of work. Subprojects 
enable development organizations to define distinct access controls and workflow rules for different issues tracking the 
development of different products, components, or modules. 

The Search Manager enables the user to choose one or more subprojects from a list of administrator-defined 
subprojects in the field value list. 

The Search Condition area displays a tree structure that represents the subproject hierarchy. Every subproject is the 
child of a single parent and may be the parent to several child subprojects. Selecting a parent subproject returns all 
issues assigned to its child subprojects. 

Issues that have not been assigned to a subproject may be found using the{Unspecified}variable. An{Unspecified} subproject 
search condition returns issues that have not been assigned to a subproject. 

  

To define a subproject search condition: 

  
Open the Search Manager. 

Select the {Subproject} variable in the Field list of the General Settings tab. 

Optional:To define the logic of the search condition, select the Include or Not Include option button. 

 The Include option returns issues that belong to the subprojects selected. Equivalent to an AND operator. 
The Not Include option returns issues thatdo not belongto the subprojects selected. Equivalent to an OR operator.
  

Optional: To select all or clear all subprojects displayed in the field value area, select the Select All option button. 
or Clear All option button. 

  
Select one or more subprojects options in the field value area. The field value list displays the {Unspecified} 
variable and all administrator-defined subprojects. 

3 Managing Issue Workflow Search Conditions 
Depending on the project workflow model, issue workflow search conditions may based on either state-to-state changes
or state transitions: 

If state-based workflow is used in the project, project members may define search parameters based on issue state 
changes only.  

If transition-based workflow is used in the project, project members may define search parameters based on issue state
changes and on transitions. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

Date range criteria may be used in conjunction with state-based or transition-based conditions to return issues that 
passed through specific states or transitions within a specific time period. 

3.1 Defining State-Based Search Conditions 
Project members may use tools in the Searching Status Change page to define search criteria for issues based on 
state-based workflow changes. 

Project members can base queries on the account type that made the change, the workflow state before or after the 
change, and the date of the change. 

Issue workflow conditions may be based on the person who made the change, the workflow state before or after the 
change, or the date of the change. 

To define state-based search conditions: 

Open the Search Manager. 

  
Select the Search by State option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select an option in the Changed From dropdown list. The Changed From dropdown list displays the ending state in 
a state-to-state transition. 

  
Select an option from the Changed To dropdown list. The Changed To dropdown list displays the ending state in a 
state-to-state transition. 

  
Optional: To indicate that the transition represents a transitive change, select the Include Transitive Change check 
box. 

  
Define a date range for the state-to-state transition. Search Manager enables the user to define date search criteria 
by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

 To return all issues regardless of the date of the transition action, select the Any Date option. 
To return only those issues that transitioned on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

3.2 Defining Transition-Based Search Conditions 
Open the Search Manager. 

  
Select the Search by Transition option button in the State Change tab. Search Manager supports state-based and 
transition-based searches. In a state-based search, the user may define the beginning state and ending state of a 
state-to-state transition. 

  
Select an option from the Changed By dropdown list. The Changed By dropdown list displays all account types and
project members that may change the workflow state of the issue. 

  
Select a transition in the Transition tree control. 

  
Optional: Define a date range for the state-to-state transition. Search Manager enables the user to define date 
search criteria by four methods: all dates, the current date, static (fixed dates) and dynamic (number of days). 

To return all issues regardless of the date of the state-to-state transition, select the Any Date option. 
To return only those issues that transitioned from state-to-state on the current date, select the Today option. 
To return issues based on a static date range, select the Changed From option and define the beginning and 

ending date of the date range. 
To return issues based on a dynamic date range, select the Changed in Days option and define the time period

of the search (in days) and number of days that the search is offset(previous to) the current date. 

4 Managing Event Searches 
An event-based search condition defines search criteria for event property fields. Queries based on event-based 
search conditions return issues that are the parent of an event meeting the search condition criteria. 

A development event is a subtask of a development issue. Development events enable organizations to divide a 
development task into many different subtasks, assign each of those subtasks to a different project member, define 
separate start and due dates for each subtask, and manage and track each of those tasks independently in workflow. 

Note:The Event tab is only displayed in the Search Manager if event management is enabled in the project. Event 
management is a DevTrack Enterprise Edition feature and is not available in the DevTrack Standard Edition. 

The Event tab consists of four general areas: the Field List, the Field Value area, the Search Conditions list, and the 
Search Logic field. 

Using controls in the Event tab of the Search Manager, a project member may define a search condition based on nine 
different event properties: Event Owner, Created By, Event Template, Event Status, Start Date, Due Date, Created 
Date, Closed Date, and Last Modified Date. 

Event property fields are represented in the DevTrack clients by data-entry controls, which are defined by their control 
type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field value area 
based on the control type of the field being searched. 

  

5 Managing Customer Searches 
A customer-based search condition defines search criteria for customer property definitions. Queries based on 
customer-based search conditions return only those issues that are owned by a customer that meets the criteria of that 
condition. 

The Beta Customer Portal enables customers and customer contacts to submit and edit DevTrack issues through the 
Internet. The ability of customers and customer contacts to access to the DevTrack project through the Beta Customer 
Portal is regulated by administrator-defined customer accounts and contact accounts. 

Note:The Customer tab is only displayed in the Search Manager if the Beta Customer Portal is enabled in the 
project. The Beta Customer Portal is a DevTrack Enterprise Edition feature and is not available in the DevTrack 
Standard Edition. 

The Customer page consists of four areas: the Field list, the field value controls, the Search Conditions area, and the 
Define Search Logic area. 

Using controls in the Customer tab of the Search Manager, a project project may define a search condition based on 
seven different customer properties: Customer Name, Contact Email, First Name, Last Name, Contact Phone, Contact 
Type and Customer Type. 

Customer property fields are represented in the DevTrack clients by data-entry controls, which are defined by their 
control type (text box, dropdown list, date-time, and so on). The Search Manager displays different tools in the field 
value area based on the control type of the field being searched. 

  

6 Managing DevTrack Search Logic 
Search Manager enables project members to define complex and versatile queries by combining multiple conditions 
using logical operators (AND,OR, andNOT) to define the logical relationship between the conditions in a query. 

Using controls in the Searching Define Search Logic area of the Search Manager, project members may define logical 
relationships between search conditions and search terms. 

The Condition list displays all of the search criteria defined in the Search Manager. The Search Manager enables project
members to define search parameters for each field displayed in the Field Name list.  

The Search Logic field displays the search criteria defined in the Search wizard as a SQL statement. Project members 
may edit the statement displayed in this field using standard SQL statements. 

The query is displayed as a tree structure in two levels: the term level and the condition level. The tree can be expanded
or collapsed. 

Selecting a search condition in the Search Condition tree list, displays the condition itself and the Search Formula for 
Current Search text box displays the logic of the search term that the selected condition belongs to. 

Selecting a search term in the Search Condition tree list, the Search Formula for Current Search text box displays the 
logic of the entire query. 

Complex queries may be created by combining search criteria and defining logical relationships between sets of criteria.
The building blocks of DevTrack searching are search conditions and search terms. 

6.1 Adding Search Terms 
In DevTrack, a search term is a grouping of one or more search conditions joined by logical operators. 

Each query defined in the Search Manager is defined by one or more search terms. Every search term added to the 
search condition list is identified by the alphanumeric sequence T1, T2, T3 and so on. 

Search Manager enables project members to create and manage complex queries comprised of multiple search terms 
and defined using three logical operators: AND, NOT, and OR. Users may define any number of search terms and every
search term may consist of any number of search conditions. 

For example, the queryT1 AND (T2 OR T3)consists of three search terms (T1, T2, and T3) which, in turn, represent a 
set of search conditions. T1 is defined by the conditionsA1 AND B1; T2 is defined by the conditionsA2 NOT B2; and T3
is defined by the conditionsA3 AND (B3 NOT C3). 

To add a search term: 

To add a search term, click the Add Term button in the Search Condition area of the Search Manager. 

The search condition is immediately added to the list. 

  

6.2 Understanding Search Manager Logical Operators 
Search Manager supports three logical operators: the AND operator, the OR operator, and the NOT operator. Project 
members may also use parentheses (the grouping function) to define complex search conditions. 

The values returned for each logical operator: 

  

  

6.3 Editing Search Conditions in the Condition List 
To edit a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Change command in the shortcut menu.  

Update search criteria in the Search Manager. 

6.4 Deleting Search Conditions in the Condition List 
To delete a search condition in the Condition List: 

Right-click a search condition in the condition list. 

Select the Delete command in the shortcut menu. 
 
 
 
The search condition is deleted. 

7 Managing DevTrack Quick Searches 
DevTrack Quick Search enables project members to define, save, and update quick searches in the DevTrack web 
client without opening another page.DevTrack Quick Search enables project members to search for issues based on 
user-defined search parameters. Project members may create, define, update, rename, and save quick searches in the 
Quick Search panel within the DevTrack Web Client. 

The Quick Search panel displays a set of controls that enable project members to alternatively execute or manage quick
searches. Project members may display or hide the Quick Search panel by clicking the Quick Search button in the 
Search bar. 

  The Down Arrow button in the Search bar displays the Quick Search panel 

 The Up Arrow button in the Search bar hides the Quick Search panel 

The Quick Search panel may display two different modes in the DevTrack web client. 

The Quick Search query mode  

The Quick Search definition mode 

The query mode of the Quick Search panel enables project members to quickly define and search for issues based on 
user-defined keywords. 

Quick searches may be based on user-defined keywords. Project members may define one or more keywords and the 
logic of the search in the Quick Search panel. Searches may apply the Any of these Words, All of these Words, Exact 
Phrase, or None of these Words search logic to the keywords defined in the query. 

Project members may also define which fields are searched by selecting one or more of the options displayed in the 
Quick Search panel: the Issue Title/Description, Include History, Include Notes Title/Description, Include Link 
Comments, and Include Event Title/Description options. 

The Quick Search panel displays three buttons in query mode. 

The Search button immediately executes the quick search.  

The Clear All clears query parameters and keywords.  

The Setup Layout button displays controls that enable project members to manage quick search parameters and 
settings. 

The definition mode of the Quick Search panel enables project members to may create, customize, delete, rename, and
save quick searches. 

Project members may create, edit, delete, rename, and save quick searches in the Quick Search Layout panel. 

Project members may add or remove sections. The maximum number of section allowed is defined by an administrator 
in the DevTrack Admin client (5). 

Project members may edit each sections name 

Project members may add/remove fields to each sections  

Project members may add to each section will be automatically arranged 

Project members may delete current search 

Project members may save as new public/private search (public search need privileges) 

  

8 Managing Saved Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data in the issue list panel or a report of the DevTrack client. 

Every query consists of one or moresearch conditions, which identify the data fields searched and the field value 
criteria for each field. Multiple search conditions may be organized intosearch termsand filtered by using the AND, NOT,
and OR logical operators. 

In DevTrack, a Query is sometimes distinguished from a ?earch?in that every query has beensavedto the project 
database and may be accessed and used again and again to retrieve issues that meet its search criteria. A search is 
anad-hoc querythat is used once and lost. 

Queries are also distinguished from searches in that every query is defined by its query type. A query type defines 
query access rights?ho may access and use the queries saved in each project. DevTrack supports three query types: 

Aprivate queryis a query that is only available to the project member that creates that created that query. 

Apublic queryis a query that is available to all project members. 

Aprotected queryis a public query that is only available to project members of select groups or account types. Project 
members may define who may access a protected query. 

The ability to define public queries is regulated by account type-based privileges. To create public or public limited team
members queries, a project team member must belong to an account type that has been granted the Can Define Public 
Query/ Report privilege by a project administrator. 

8.1 Running Queries 
A DevTrack query is a set of instructions (search conditions, search terms, and logic), for retrieving and displaying 
development issue data that has beensavedto the project database. 

The Query dropdown list in the search bar displays all available queries including all personal queries, all public queries, 
and those protected queries that are available to them based on their account type or group. 

The Query dropdown list also displays the{No Query}and the{Ad-Hoc Query}variables. 

The{No Query}variable cancels the search criteria that currently filter issues and returns all issues.  

The

 Chapter 9- Development Event Management 

In this chapter: 

• Understanding Development Event Management 

• Managing Regular Development Events 

• Tracking Development Events 

• Managing Co-Owner Development Events 

• Understanding Event Reports 

1 Understanding Development Event Management 
Adevelopment eventrepresents a subtask of a development issue. Events enable development organizations to 
manage development issues more effectively by assigning development subtasks to many different event owners, and 
schedule and manage those subtasks in workflow. 

Development issues represent development tasks such as fixing bugs or implementing new features. Every 
development issue has a single owner, is managed within issues workflow, and has a unique schedule. But 
development tasks are often quite complex and require the input from many different project members that work within 
many different schedules. And each subtask may require its own workflow. 

Development events enable organizations to divide a development task into many different subtasks, assign each of 
those subtasks to a different project member, define separate start and due dates for each subtask, and manage and 
track each of those task independently in its own workflow. 

Development event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

1.1 Development Event Templates 
All development events are based on development event templates. Event workflow states, applicable event owners, 
applicable issue workflow states or transitions, event attachment rules, and access controls are all defined by the 
development event template used to create an event. 

1.2 Development Event Types 
Development organizations may create and manage two types of development events in DevTrack projects: regular 
events and co-owner events. 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 

Field Text Search Title 
{Issue ID} 

A field text search 
enables the user to 
search for keywords in 
property fields that are 
tracked using text box 
controls in the client. 

Date Time Search Date Assigned 
Due Date 
{Date Closed} 
{Date Submitted} 
{Date Modified} 
{Closed Status} 

A date time search 
enables the user to 
search for date ranges in 
property fields that are 
tracked using datetime 
controls in the client. 

Field Value Search Type 
Priority 
Component 
Version 
Platform 
Check box field 
Progress Status 
Assigned By 
Target Release 
{Current Owner} 
{Submitted By} 
{Closed By} 
{Substatus} 
{Last Transition} 
{Links} 

A field value search 
enables the user to 
search for multiple 
criteria in property fields 
that are tracked using 
multiple selection 
controls in the client. 
  
Field value searches are 
also used to search for 
issues based on system 
defined user variable and 
issue variable values. 
Issue properties that are 
not tracked using 
controls in the client are 
represented by these 
variables. 

Keyword Search {Keywords} 
{Notes} 

A keyword search returns 
issues that match a user-
defined search condition 
in one or more user-
specified fields: the Title, 
Description, History, 
Note Title, Note 
Description, Link 
Comments, Event Title, 
and Event Description 
fields. 

Note Type Search {Note Type} A note type search 
returns issues that are 
linked to notes of a user-
specified note type. 

Links Search {Links} A links search returns 
issues that are linked to 
other work items using a 
user specified link type. 

4* All work items beginning with the  
number 4 

*4 All work items ending with the number 
4 

*4* All work items containing the number 
4 

>50 All work items greater than 50. 
<50 All work items less than 50. 
>=50 All work items greater than or equal to 

50. 

Field Value Search Event Owner 
Created By 
Event Template 
Event Status 

A field value search 
returns issues based on 
event property definitions 
of its child events. 

Date-Time Start Date 
Due Date 
Created Date 
Closed Date 
Last Modified Date 

A date-time event search 
returns issues based on 
the schedule of its child 
events. 

Keywords Keyword A keyword search returns 
issues based on the 
presence of keywords in 
child event fields. 

Field Text Search Customer Name 
Contact E-mail 
First Name 
Last Name 
Contact Phone 

A field text search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

Field Value Search Contact Type 
Customer Type 

A field value search 
returns issues based on 
the customer property 
definitions of associated 
customers. 

AND A AND B All issues that meet both 
A and B criteria. 

OR A OR B All issues that meet 
either A or B criteria. 

NOT A NOT B All issues that meet A 
criteria and do not meet 
B criteria 

() A OR (B AND C) All issues that meet 
either A criteria or that 
meet both B and C 
criteria 

Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 
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Regular development eventsrepresent a subtask of a development issue. Regular development events may be 
controlled by regular event workflow rules and advanced event workflow rules. All regular development events are based
on an administrator-defined regular event template. Regular event templates may be used to generate one development
event at a time. 

Co-owner development eventsare development events which use event variables to determine which project 
members are the applicable owners for the event. Co-owner events may be single choice events or multiple choice 
events. All co-owner development events are based on an administrator-defined regular event template. Co-owner 
event templates may be used to generate multiple development events simultaneously and to assign each of those 
events to a different owner. 

2 Understanding Development Event Workflow 
Development event workflow enables organizations to independently manage the various subtasks that must be 
completed before a development issue can be forwarded from one issue workflow state to the next. 

Event workflow rules enable project teams to manage and track development subtasks independently of one another, 
assign those tasks to different owners, and define separate schedules (start and due dates) for each event. 

Every development event is the child of a parent issue and represents a subtask of that development issue that must be
performed within an issue workflow state. 

Like development issues, development events are managed within a set of administrator-defined workflow rules. The 
life cycle of a development event is composed of open and closed workflow states. 

The workflow of development events is typically much simpler than that of their parent development issues. 

But event workflow often consists of no more than two event workflow states: an open state and a closed state. In this 
scenario, the event merely tracks whether a specific subtask has been completed. 

The event has two workflow states: 

To be done (open) 

Done (closed) 

2.1 Standard Event Workflow Rules 
Standard event workflow rules define applicable event templates for each issue workflow state and transition, and event 
auto-creation rules and event auto-close rules for each development event template. 

2.2 Advanced Event Workflow Rules 
Advanced event workflow rules define event state change triggers, event auto-creation rules, issue auto-creation rules, 
and issue state change rules for each development event template. 

All standard and advanced event workflow rules are defined on a template-by-template basis. The event template 
defines the event life cycle and workflow rules that may be used to manage events within event workflow. 

Events and event workflow are optional. DevTrack Enterprise Edition features. Project administrators may define 
development event templates, event workflow rules, advanced event workflow rules, event notification rules, and event 
escalation rules in the DevTrack Admin. 

3 Managing Regular Development Events 
A development event is defined by a unique event ID number, an event description, an event workflow state, event start 
and finish dates, an event owner, and other dynamic properties. 

Every development event is based on a development event template. An event template represents a set of predefined 
event properties, event workflow rules, applicable issue state or transition rules, applicable event owner rules, 
attachment rules, and access controls. 

All regular development events are submitted to DevTrack projects by one of three methods: 

Manual submission:Project members may manually create new events based on development event templates using 
controls in the Events page. 

Auto-creation based on standard event workflow rules:Events may be created automatically based on event 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

Auto-creation based on advanced event workflow rules:Events may be created automatically based on advanced 
workflow rules. Administrators may define workflow rules that create new events based on changes to the workflow state
of a parent issue. 

3.1 Submitting Regular Development Events 
A regular development event is the child of that parent development issue and represents a subtask of that 
development issue. 

Regular development events may be controlled by standard event workflow rules or advanced event workflow rules. 

Project members may manually submit new development events, define development properties, forward events to 
project members or event workflow states, and attach knowledge items to development events in the Events page of 
the Issue detail page. 

Every development event is defined by a unique, auto-generated, event ID number. All other event properties including 
event descriptions, event workflow states, event start and finish dates, and the event owner are inherited from the event 
template used to create the development event. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To submit regular development events: 

Click the Add button in the Events tab of the issue detail panel. The Events page appears. 

Select an event template from the Event Templates dropdown list. The Event Template dropdown list displays the 
development event templates that are applicable to the current issue workflow state.  

Click the Continue button. The Event page appears. The data-entry controls in the Events page are prepopulated by 
values defined in the development event template.  

Define a unique, descriptive title of the development event in the Title control.  

Define the start date and end date of the event in the Start Date and End Date controls. Events enable development 
organizations to independently manage and track development issue subtasks as events. Every event may have its 
own start and due dates.  

Select an owner from the Owner dropdown list. The Owner dropdown list displays the names of every project 
member that may own the development event. Applicable event owners are defined on a template-by-template 
basis.  

Select an event workflow state from the State dropdown list. The State dropdown list displays the event workflow 
states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 
template-by-template basis.  

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list. The 
Attachment dropdown list displays the knowledge item types that may be attached to the event. 

Click the Save button. 

Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules. 

3.2 Opting to Submit Autocreated Development Events 
Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

In the course of project workflow, project members may be prompted to submit new development events based on 
administrator-defined event auto-creation rules. 

Standard event auto-creation rules may automatically create new development events based on changes to the issue 
workflow state of parent development issues. 

Advanced event auto-creation rules may automatically create new development events based on event template triggers
or event group triggers. 

  

 

The Event Workflow dialog box enables project members to accept or cancel the creation of the development events 
for each applicable event template. 

Event auto-creation is controlled by one of three auto-creation rules: 
 
Mandatory event auto-creation rulesautomatically create and submit new development issues when the event auto-
creation rule is triggered. No input from the project member is allowed. 

Option-Yes auto-creation rulesautomatically create new development issues, but enable the project member to 
submit or cancel the development event. The development event is selected by default. 

Option-No auto-creation rulesautomatically create new development issues, but enable the project member to submit
or cancel the development event. The development event is deselected by default. 

3.3 To accept development event auto-creation 

Submit, forward, or close a development issue. 

 

 

 

Standard event auto-creation workflow rules are based on the transitions between issue workflow states and are triggered whenever an action that changes the issue 

workflow state is performed on a development issue. 

 

 

 

The Event Workflow Triggering page appears.  

To accept the auto-creation of a development event based on an event template, ensure that the box adjacent to the 
event template title is selected. 
 
 
 
Events are selected or deselected by default in the Event Workflow Triggering page based development event auto-
creation rules. Event auto-creation is controlled one of three development event auto-creation rules: Optional-Yes, 
Optional-No, or Mandatory.  

Select an event workflow state from the State dropdown list. 

 

 

 

The State dropdown list displays the event workflow states that comprise the life cycle of the development event. The life cycle of a development event is defined on a 

template-by-template basis. 

Select an applicable owner from the Owner dropdown list. 

 

 

 

The Owner dropdown list displays the names of every project member that may own the development event. Applicable event owners are defined on a template-by-

template basis.  

Click the Continue button. 

3.4 Updating Regular Development Events 
  

Adevelopment eventis the child of that parent development issue and represents a subtask of that development issue.

Project members may update development event properties in the Event page of the DevTrack client. 

A development event is defined by six properties: 

Event title 

Start date 

End date 

Owner 

State 

Description 

All event properties are inherited from the event template used to create the development event. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears.  

Select a development event in the Event list of the Event page.  

Update the title of the development event in the Title control. 

Update the start date and end date of the event in the Start Date and End Date controls. 

Select an owner from the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of every project member that may own the development event. 
Applicable event owners are defined on a template-by-template basis.  

Select an event workflow state from the State dropdown list. 
 
 
 
The State dropdown list displays the event workflow states that comprise the life cycle of the development event. 
The life cycle of a development event is defined on a template-by-template basis. 

(Optional): To add an attachment to the event, select an option from the Attachment dropdown list.The Attachment
dropdown list displays the knowledge item types that may be attached to the event. 
 
 
 
Note:Attachments may be forbidden, optional, or mandatory depending on the event template attachment rules.  

Click the Save button. 

  

3.5 Closing Regular Development Events 
Every event workflow state has either an open or closed status. 

Project members may close development events by forwarding the event to a closed event workflow state. 

To close regular development events: 

Click the Edit button in the Issue detail page. 
 
 
 
The Events page appears. 

Select a development event in the Event list of the Event page. 

Select a closed event workflow state from the State dropdown list. 
 
 
 
The life cycle of a development event is defined on a template-by-template basis. Every event workflow state has 
either an open or closed status.  

Click the Save and Close button. 

3.6 Managing Autoclose Development Events 
A development event is the child of that parent development issue and represents a subtask of that development issue. 

In the course of project workflow, project members may be prompted to close development events based on 
administrator-defined event auto-close rules. 
 
The Can Be Open development event rule dictates that open development events do not affect parent issue transitions. 

The Must be Closed development event rule dictates that open development events must be closed before the parent 
issue transition is executed. Project members are prompted to close open development events. 

The Must be Closed (auto close) development event rule dictates that open development events must be closed before
the parent issue transition is executed. DevTrack automatically closes open development events. Project members are 
not notified. 

Project administrators may define distinct auto-close rules for each regular development event template in each issue 
workflow state or transition. 

3.7 Deleting Regular Development Events 
Project members may use the Delete command in the Event page to delete regular development events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete an event: 

Select the Event tab in the issue detail panel.  

Select an event in the Item list. 

Click the Delete button. 
 
 
 
A warning dialog box appears. 

Click the Yes button. 

3.8 Understanding Event Change User Identity Authentication 
User identity authentication enables development teams to add an addition level of security to their projects by requiring 
that project members verify their identity before they may update issues or events in specific workflow states. 

Event authentication rules may require that project members enter their password before an event may be updated 
based on event templates and event states identified by the project administrators. 

Once enabled and defined, user authentication rules ensure that no changes may be made unless the user confirms 
their identity by entering their password. Project members are prompted to enter their password whenever they attempt 
to update an issue or event covered by an authentication rule. 

All identity authentications are recorded and tracked in the History page in the Issue Detail page. User identity 
authentication is a DevTrack Enterprise Edition feature. 

3.9 Understanding Development Event Management Privileges 
The ability of project members to manage development events in a DevTrack project is based on event access 
privileges. Project members may only perform event-related tasks if they belong to an account type that has been 
granted the appropriate privileges by an administrator in DevTrack Admin. 

All event access privileges are defined on a template-by-template basis. Project members may be able to view, create, 
edit, and delete events based on one event template, and have no access to events based on another development 
event template. 

TheWho Can Submitprivilege determines the account types that can submit events based on this event template. 
Administrators may also grant this privilege to the owner of the parent issue, or to the original submitter of the parent 
issue. 

TheWho Can Viewprivilege determines the account types that can view events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Editprivilege determines the account types that can edit events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. 

TheWho Can Deleteprivilege determines the account types that can delete events based on this event template. 
Administrators may grant this privilege to the owner of the parent issue, the original submitter of the parent issue, the 
owner of the event, and/or the submitter of the event. The Who Can Delete property overrides view and edit access 
privileges. If a user is granted this privilege for an event, that user may view and edit the event as well, regardless of 
other settings. 

4 Tracking Development Events 
  

4.1 Viewing Events in the Issue List Panel 
Project members may view events in the Issue list panel. 

The Issue list panel displays all records (issues, linked issues, and events) in a tabular format. Each row represents a 
single record. Each column represents a record property. Events may be displayed in the Issue list panel beneath to 
their parent issue. 

Development events displayed in the Issue list panel are identified by an icon that shows current status of the event. 

 The Open Event icon is displayed next to all current open events. 

 The Overdue Event icon is displayed next to all open events that are overdue. 

The Closed Event icon is displayed next to all closed events. 

Project members may use the User Preferences manager to personalize the display of events in the Issue list panel. 
Project members may display or hide closed events and determine which events are displayed based on event 
ownership. For more information see Displaying Events in the Issue List Window. 

4.2 Filtering Events in the Issue List Panel 
Project members may use the User Dropdown list to filter the events displayed in the Issue list panel. 

Project members may choose between two options: 

If the Show Related User Event Only option is selected the Issue list panel displays all of the events owned by the 
project member selected in the User Dropdown list, as well as the parent issues of those events. The parent issues are 
displayed regardless of issue ownership. 

If the Show Related User Events option is selected the Issue list panel displays only those events owned by project 
member selected in the User Dropdown list. Parent issues are not displayed unless the selected project member also 
owns the parent issue. 

4.3 Viewing Events in the Issue Detail Window 
Project members may view detailed information about events in the Events page of the issue detail panel. 

To view development event details in the issue detail panel, a project member must belong to an account type that has 
been granted the appropriate event access privileges by the project administrator. 

  

5 Managing Co-Owner Development Events 
Co-owner development events are development events which use event variables to determine which project members 
may own development events. 

Co-owner event templates enable developers to generate multiple development events simultaneously, and assign 
each of those events to different owners. 

A co-owner event enables development organizations to define multiple owners of different areas of a development 
issue. For example, a co-owner event may be created to represent development subtasks in several different versions 
of a component. 

A co-owner event may be either a single choice or multiple choice development event. Multiple choice co-owner event 
templates may be used to generate multiple events simultaneously. 

Multiple-choice co-owner eventsenable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner eventsenable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

The development issue is used to represent the general development task and is assigned to one owner. Each co-
owner development event represents the development task in a different version of the product and each co-owner 
development event is assigned to a different project member. 

  

5.1 Creating Co-owner Events 
Co-owner events are development events that use event variables to determine which project members may own 
development events. 

In practice, co-owner events enable project members to assign events to different project members or development 
teams based on the properties of the parent development issue. 

Project members may create and define co-owner events whenever they submit a development issue in a DevTrack 
project by selecting co-owner event owners and event workflow states in the Current Status page. 

 

  

The Co-owner Event area of the Current Status page displays or enables project members to define co-owner event 
variables, the co-owner event owner, and the co-owner event state. 

Multiple-choice co-owner events enable project members to create multiple co-owner events simultaneously from a 
single event template. 

Single-choice co-owner events enable project members to create a single co-owner event based on a single event 
variable value. Single-choice co-owner events may be managed using event group workflow rules. 

To create co-owner events: 

Click the New button. 

Define development issue properties in the Description page and Current Status page. 

Select a project member in the Owner dropdown list. 
 
 
 
The Owner dropdown list displays the names of all project member that have been defined as applicable owners for 
the corresponding event variable.  

Select a co-owner event workflow state in the State dropdown list. 

Click the Submit button. 

6 Understanding Event Reports 
Project members may generate Event list reports in both the Windows and web clients. Event list reports display text 
only information regarding the current project? events. Event reports can be presented in a brief, concise, or detailed 
version, each providing a different level of detail for events. 

Event reports can be grouped by any of the following: 

Event ID 

Event Owner 

Event Status 

Date Created 

Start Date 

  

 Chapter 10- Beta Customer Portal 
Wiki Summary.

1 Managing Customers and Contacts in the Customer 
Manager 
The DevTrack Beta Customer Portal is a secure, interactive web site through which selected customers may access 
DevTrack issues related to development processes. Typically, customers with Beta Customer Portal access are from a 
selectedbeta groupthat is assisting the development team in the development and QA processes. 

Each beta customer (company) may access one or more DevTrack projects, depending on their customer type. 

DevTrack project administrators may define customer types and access types to implement security at the customer 
level. 

Customer types regulate the information that a customer may access from the Beta Customer Portal. 

Access types are similar to the account types used to manage the internal development team. Access types are set up 
with defined privileges, and customer contacts (individual) are assigned contact types that best represent their 
responsibilities in the development process. 

Project members may use the Customer Manager to create and edit customer and contact account information. All 
customer and customer contact data is managed in a customer base project. 

The customers and customer contacts that project members manage in the Customer Manager may submit and view 
DevTrack issues through the Beta Customer Portal. 

Project members are responsible for creating customers and customer contacts and for assigning administrator-defined 
customer types and access types to those customers and customer contacts. 

1.1 Logging into the Beta Customer Portal 
Customer contacts may submit and view DevTrack issues in the Beta Customer Portal. The revised URL for accessing 
the project ID is: 

http://yourWebserver/scripts/texcel/devtrack/clogin.dll?projectid=# 

1.2 Understanding Customer Management Privileges 
Project members who have been granted the appropriate privileges may create, edit, delete and otherwise manage 
customer and contact accounts in the Customer Manager. 

Administrators may grant Customer Manager privileges to DevTrack project account types using controls in DevTrack 
Admin. Administrators may grant five different privileges to each account type: 

2 Managing Customers in the Customer 
ManagerSection 
DevTrack project members may use the Customer Manager to define customers, customer contacts, and parent-child relationships 
between customers or customer types and administrator-defined options. The Customer Manager consists of the Customer list 
and a Customer Detail window consisting of four tabbed pages. 

The Customer list window displays high-level information about every customer managed in an associated customer 
base project including their name and their customer type. 

The Customer Detail window consists of four tabs. Each tab in the Customer Detail window enables project members to 
manage a customer account. 

The Customer Info page enables project members to define basic information about a customer. Administrators may 
customize the Customer Info page using controls in DevTrack Admin.  

The Contact page enables project members to view high-level information about customer contacts. Controls in this tab 
enable project members to create, edit, and delete customer contacts.  

The Parent-Child Relation page enables project members to define which options are displayed in a child multiple-
selection list control when the parent multiple selection list control displays customer type or customer options.  

The Related Issues page enables project members to view issues submitted by a customer. 

2.1 Filtering Customers in the Customer Manager 
Project members may sort the customer accounts displayed in the Customer list of the Customer Manager based on 
whether they are linked to the current project. 

The Customer Manager displays all of the customer accounts managed in an associated customer base project. Each 
customer account has alink statuswhich represents that customers relationship to the current DevTrack project. 
Because a customer base project may be used by multiple DevTrack projects, as well as TechExcel CRM projects and 
TechExcel HelpDesk projects, the customers displayed in the Customer Manager may not be linked to the current 
DevTrack project and may not have access to the issues managed in the project through the Beta Customer Portal. 

The Customer Manager dropdown list enables project member to filter the customers displayed in the customer field 
according to their link status. The Customer Manager dropdown list displays three options: 

The All Customers option displays all customers regardless of their link status.  

The Customers Linked to Current Project option displays only those customers that have been linked to the current 
DevTrack project.  

The Customers Not Linked to Current Project option displays only those customers that have not been linked to the 
current DevTrack project. 

To filter customers: 

Select Tool > Customer Manager. 

Select an option from the Customer Manager dropdown list. 

2.2 Sorting Customers in the Customer Manager 
Project members may sort the customers displayed in the Customer Manager by clicking the column headers in the 
Customer Manager list. The Customer Manager list displays high-level information about each customer account 
including the customer ID, the customer name, and the customer type. 

When a column heading is clicked the customer account records displayed in the Customer List are sorted by that 
column. 

The Customer ID column sorts customers numerically by their customer ID number.  

The Customer Name column sorts customers alphabetically by their customer name.  

The Customer ID column sorts customers alphabetically by their customer type. 

  

To sort customers in the Customer Manager: 

Select Tool > Customer Manager. 

Sort the customers displayed in the Customer list. 

Click the column header once to sort customers from lowest to highest order (A to Z or 1 to 10). 

Click the column header twice to sort customers from highest to lowest order (Z to A or 10 to 1). 

2.3 Searching for Customers in the Customer Manager 
Administrators may use the Search button in the Customer Manager to search for customers managed in a customer 
base project. 

The Search Customer dialog box enables project members to define parameters for searching for customers based on 
customer account properties: 

  

Name 

City 

State 

Zip 

Country 

Customer Type 

Phone 

  

To search customers in the Customer Manager: 

Select Tool --> Customer Manager. 

Click the Search button. The Search Customer dialog box appears.  

Enter the search parameters in the Search Customer dialog box. 

Click the Search button. 

3 Managing Customers Accounts 
Project members may use the New button in the Customer Manager to create, edit, and manage customer accounts. 

Customers represent thebeta customersthat may be aiding the development team in product testing. Each customer is 
represented by one or more customer contacts. 

Each customer is assigned an administrator-defined customer type which determines which DevTrack projects that the 
contacts belonging to that customer may access through the Beta Customer Portal. 

Customer management tasks include: 

Creating Customer Accounts  

Deleting Customer Accounts  

Linking Customers  

Unlinking Customers 

3.1 Creating Customer Accounts 
Project members may use the New button in the Customer Manager to create new customer accounts. 

The New Customer page displays data-entry controls that enable project members to define customer account 
properties. 

  

The names of the controls on the Customer Info page as shown above can be customized using the Admin Client. 

To create customer accounts:  

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the Create button. 

3.2 Checking for Existing Customers 
Project members may use the If Exists button in the New Customer page to search for existing customers that meet 
certain parameters. 

  

In the course of creating a new customer in the New Customer page, project members may search the customer base 
project for existing customers in order to avoid creating duplicate customer accounts. 

Project members may enter parameters into the data-entry controls displayed in the New Customer page. Each data-
entry field completed in the New Customer page acts as a search parameter enabling project members to view all 
existing customers that meet those requirements. 

To check for existing customers: 

Select Tool > Customer Manager. 

Click the New button. The New Customer page appears. 

Enter data in the data-entry controls displayed in the New Customer page. 

Click the If Exists button. The existing customers that match the parameters entered in the completed data-entry 
controls are displayed at the bottom of the New Customer page.  

Click the Create button. 

3.3 Deleting Customer Accounts 
Project members may use the Delete button in the Customer Manager to delete customer accounts. 

To delete customer accounts: 

Select Tool > Customer Manager. 

Select a customer in the Customer list. 

Click the Delete bu on. A warning dialog box appears.  

Click the Yes button. 

  

3.4 Linking Customers 
Project members may use the Link button in the Customer Manager to link customer accounts with the current DevTrack 
project. 

Linking a customer to DevTrack project enables contacts belonging to that customer to submit and view DevTrack 
issues through the Customer Web Portal. 

To Link customer accounts: 

 Chapter 11- DevTrack Time Tracking 

In this chapter: 

• Managing DevTrack Time Tracking 

• Managing Issue-Level Time Tracking and Cost Tracking 

  

1 Managing DevTrack Time Tracking 
DevTrack supports issue-level time and cost tracking in DevTrack projects. 

Issue-level time tracking enables project teams to track the tasks performed in DevTrack projects based on 
administrator-defined work types and schedules. 

Issue-level cost tracking enables project teams to track the cost of the tasks performed in DevTrack projects 
based on administrator-defined rates. Cost tracking is based on an hourly rate that is assigned to each work type. 

Time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For information on 
managing time tracking reports see Managing Project- Level Time Track Reports or Managing Issue-Level Time 
Tracking Reports. 

2 Managing Issue-Level Time Tracking and Cost 
Tracking 
Project members may use tools in the Time Tracking page to add, edit, and delete time items for DevTrack issues 
whenever they create, edit, close, or forward DevTrack issues. 

Issue-level time tracking and cost tracking enable project teams to track the time project members spends working 
on DevTrack issues. 

Project administrators may require that project members record issue time items whenever an issue is created, 
forwarded, or closed. The Time Track page may be displayed in the client application whenever the project 
member submits, forwards, or closes an issue. In addition, the Time Track page is displayed in the issue detail 
panel. 

Issue-level time tracking and cost tracking data may be used to create reports that identify development, and user 
trends. Issue-level time tracking data maintained in DevTrack may be viewed and analyzed in DevTrack reports. For 
information on managing time tracking reports see Managing Issue-Level Time Tracking Reports. 

  

2.1 Adding Issue Time Items 
Project members may use controls in the Issue Time Item dialog box to add time items for DevTrack issues. 

Project members may create time items using controls in the Issue Time Track page of the issue detail panel, or 
they may be prompted to create a new time item in the Issue Time Item dialog box whenever they create, forward 
or close an issue in the DevTrack client. 

Each time item records the amount of time that the project member spend working on a particular time item and the 
work type of the work performed. 

If the administrator has enabled issue-level cost tracking in the project and the project member has been granted 
the appropriate privileges, project members may view and update hourly rates for each time item. 

To add an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Click the Add button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list. 

Select a work type option from the Work Type dropdown list.  

Enter the hours worked in the Hours field.  

Enter a note in the Note field.  

Click the OK button. 

  

2.2 Editing Issue Time Items 
Project members may use controls in the Time Track page to edit time items for DevTrack issues. 

The Time Track page may be displayed in different places in the client. 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To edit an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Edit button. The Issue Time Item dialog box appears. 

Define the beginning and ending date of the work performed. 

Select a user account from the User Name dropdown list.  

Select a work type option from the Work Type dropdown list. 

Enter the hours worked in the Hours field. 

Enter a note in the Note field. 

Click the OK button. 

  

2.3 Defining Other Project Memeber Schedules 
Project members may also add or edit time items for other project members provided that they have been granted 
that privilege by the administrator in DevTrack Admin. 

  

  

2.4 Deleting Issue Time Items 
Project members may use controls in the Time Track page of the issue detail panel to time items for DevTrack 
issues. 

  

 

Time items record the amount of time that the project member spent working on a particular time item and the work 
type of the work performed. 

To delete an issue time item: 

Select the Issue Time Track tab in the issue detail panel. 

Select a time item in the Issue Time Track list. 

Click the Delete button. A confirmation dialog box appears. 

Click the Yes button. 

 Chapter 13- DevTrack Personalization 

In this chapter: 

• Managing DevTrack Personalization 

• Managing Issue Submission Preferences 

• Personalizing the Main View Work Area 

• Personalizing the Issue List Panel 

• Managing System Settings 

• Managing Subscriptions 

• Managing Personal Folder Preferences 

• Managing Event Preferences 

• Managing DevTrack Web Preferences 

1 Managing DevTrack Personalization 
DevTrack personalization tools enable project members to customize the appearance and functionality of the 
DevTrack Windows client. 

A project member may customize their DevTrack client to suit their personal work habits and preferences. Using 
the User Preferences Manager in the DevTrack Windows client and the Settings page in the DevTrack web client, 
project members may define how data is displayed and managed. 

The preferences that a project member defines in the User Preferences Manger apply only to their personal client 
and do not affect the personal preferences of other project members. 

Each tab in the User Preferences Manager includes a cluster of data-entry forms that enable each user to 
personalize an area of the DevTrack client. 

TheSubmit tabenables project members to define development issue submission preferences for their Windows 
client.  

TheUser List tabenables project members to choose which project members appear in the User List dropdown 
list in the client.  

TheTab tabenables project members to choose which project members appear in the User List dropdown list in 
the client.  

TheIssue Detailtab enables project members to choose which sections appear in the Issue Detail tab in the client.  

TheTools tabenables project members to add, edit, or remove tools to the Tool menu in the menu bar. Custom-
Tool menu commands may be used to launch third-party applications.  

TheIssue List tabenables project members to choose which columns appear in the issue list panel.  

The Date/Time tab enables project members to define how the date and time are presented in the client. TheOther 
tabenables project members to define the local checkout root path, project login rules, and enable the spell 
checking function in the client.  

TheEvents tabenables project members to define their personal preferences for viewing events in the issue list 
panel. 

TheMy Subscription tabenables project member to view and define subscription preferences for development 
issue notification e-mails.  

ThePersonal Folder tabenables project members to define how personal folders are displayed in the issue tree 
panel of their DevTrack client. 

The system administrator and project administrator can define system-level and project-level preferences, but 
these settings can be overridden by individual users. 

  

2 Managing Issue Submission Preferences 
Issue submission preferences define how the DevTrack client submits new development issues to a project. 
Project members may define user preferences in their client application that suit their work habits, responsibilities, 
or personal preferences. 

DevTrack time saving features include options for prepopulating fields in the New Issue page, the Forward Issue 
page, and the Close Issue page. Project members may define personal preferences that determine the source of 
the values used to prepopulate fields in these fields. 

2.1 Enabling Synchronized Issue Assignment 
The Synchronized Assignment option enables project members to view the workload of other project members 
before they assign new development issues to them. 

Synchronized assignment works best when the As Current Owner option is selected in the View menu. If both the 
Synchronized Assignment option and the As Current Owner options are selected, the issue list panel automatically 
displays the workload for the project member selected in the Assigned To field in the New Issue page. 

For example, when Project Member A selects Project Member B in the Assign To field in the New page, the 
development issue list automatically displays all development issues that Project Member B currently owns. If 
Project Member B is already working on several development issues, Project Member A may want to assign the 
new development issue to someone else. 

Note:Whenever an development issue is submitted a confirmation message with the new development issue 
ID appears in the main view work area. If the Synchronized Assignment option activated, this confirmation 
message is not displayed. 

Synchronized assignment works for new development issues created in the New Issue page. Synchronized 
assignment does not work for the Forward page. 

  

2.2 Enabling Automatic Closing of Issue Submit Page 
Project members may define and submit new development issues in the New Issue manger of the DevTrack 
Windows client. By default, the New Issue manager remains open after a development issue is submitted to 
facilitate the rapid submission of multiple new issues. 

To force the New Issue manager to close whenever a development issue is submitted to the project, click the 
Close Submission Dialog after an Issue Is Submitted check box in the Submit tab. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

2.3 Defining Next Issue Submission Settings 
Project members may use the Data for the Next Issue Submission controls in the Submit tab to predefine data for 
the next development issue they submit. 

Whenever a project team member submits a new development issue in DevTrack, he or she must enter values for 
that development issue in the New page. DevTrack enables project members to predefine submission settings for 
each page in the New Issue page. 

Project members may choose one of three submission settings for next development issue submission: 

The Retain Data control  

The Reset Data control  

The Use the Default Issue Template control 

The Retain Data control retains the data from the previous development issue submitted. Each field in the New 
Issue page is pre-populated with the values from the previous development issue submitted. 

The Reset Data control forces DevTrack to reset values for all fields in each successive submission. Whenever the 
project team member submits an development issue, the values in the New Issue page are immediately erased 
and all fields are reset to their default values. 

The Use the Default Issue Template control loads the values from the default development issue template 
automatically whenever a new development issue is created. 

Note:If the Close Issue Submission page on Issue Submission option is enabled, the Data for Next 
Submission setting is ignored. 

  

  

2.4 Defining Default Issue Templates 
Project members may use the Default Issue Template on Submission control to define a default template for all 
development issue submissions. 

Project members may only select a default development issue template from the Default Issue Template on 
Submission dropdown list if they have selected the Use the Default Issue Template option in the Data for the Next 
Submission controls. For more information see Defining Next Issue Submission Settings. 
 
 
 

Note:The project administrator may choose to define a project-level default development issue template in 
DevTrack Admin. If the project administrator defines a default template, the Default Issue Template on 
Submission dropdown list is disabled and all project members must use the project-level template as their 
default development issue template. 

  

To define default development issue templates: 

1.      Select the User Preference command in the System menu. 

 

 

 

The User Preference manager appears. 
2.      Select a development issue template option from the Default Issue Template on Submission dropdown list. 
3.      Click the OK button. 

  

2.5 Enabling Issue Template Selection on Submission 
Project members may use the Enable Issue Template Selection on Issue Submission control in the Submit tab to 
enable themselves to choose a development issue template at the time they submit a DevTrack development 
issue. 

If this option is selected, the Template button appears in the New Issue page. By clicking the Template button 
project members may select a development issue template (assuming multiple development issue templates exist) 
with which to populate the Issue Submission page. 

To define default development issue templates: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Issue Template Selection on Issue Submission check box. 

Click the OK button. 

  

2.6 Enabling Automatic Issue List Refreshing 
Project members can use the Refresh Current Issue List after Forwarding control in the User Preferences manager 
to cause the issue list panel to refresh whenever an development issue is forwarded to another project team 
member. 

To enable automatic development issue list refreshing: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Refresh the Current Issue List after Issue Forwarding check box in the Other tab. 

Click the OK button. 

  

3 Personalizing the Main View Work Area 
Project members can use the User List tab in the User Personalization manager to personalize the work area in the 
main view. 

3.1 Personalizing the User List 
Project members can use the User List tab in the User Personalization manager to determine which project 
members are displayed in their User List dropdown list. 

  

 

The User List tab enables project members to limit the number of project members displayed in the User List 
dropdown list to those project members that the project member works with frequently. User list filtering options are 
particularly useful in large projects which include dozens of team members. 

The team members and group folders options available to you in the Default User List dropdown list are based on 
the project-level privileges. 

To define User List dropdown list preferences: 

  

Select the User Preference command in the System menu. The User Preference manager appears. 

Select the Apply User List filter check box in the User List tab. The User list is activated.If the Apply User List filter check box is selected, only those users selected in 
the User dropdown list are displayed in the Assign To list, the User list, and the Team Member filter. 

(Optional):To include inactive DevTrack users in the user list filter, select the Include inactive members in team member filter check box. If the Include inactive 
members check box is selected, all inactive DevTrack users are displayed in the User dropdown list. For more information on active and inactive members see 

“Including Inactive Project Members in User List” on page 224. 

Modify the preferred user list by selecting or deselecting each project members in the User list. A check mark appears next to the name of the project member when 
you add the project member to the list filter. 

Select an option from the Default User List Selection on Login dropdown list. The Default User List Selection on Login dropdown list enables you to select whose 
development issue list you will see when you log into DevTrack. 

 Select the OK button. The User Preference Manager immediately closes. 

Select the Reload Project Settings command in the View menu. The DevTrack work area immediately reloads, and displays the page with the new filter settings. 

 
 

3.2 Including Inactive Project Members is User List 
Project members can use the Include Inactive Members in Team Filter command to display inactive project members in their User List. 

With this option selected inactive members appear in the User list.  

 Inactive users are displayed with the textInactivenext to their names.  

Active users are displayed with the textActivenext to their names. 

Typically, project members do not need to view the development issues submitted or owned by inactive users. In this case simply leave the box unchecked. 

To include inactive project members: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Include Inactive Team Members in Team Filter check box in the Other tab. 

Click the OK button. 

  

3.3 Personalizing Issue Detail Window Tab Placement 
Project members can change the location of the page tabs in the issue detail panel using tools controls in the Tab page of the User Preferences manager. 

 Tabs may either be placed on top of pages or below them in the issue detail panel. 

The Top option places tabs above all pages in the issue detail panel. 

The Bottom option places tabs below all pages in the issue detail panel. 

Can Create Customer/Contact 
Information privilege 

The Can Create Customer/Contact Information privilege enables account types to create 
new customers and customer contacts.

Can Edit Customer Information privilege
The Can Edit Customer Information privilege enables account types to edit customer 
settings.

Can Delete Customer Information 
privilege

The Can Delete Customer Information privilege enables account types to delete 
customers from the project.

Can Associate Customer/contact 
With An Issue 

The Can Associate Customer/contact With An Issue privilege enables account types to 
associate a customer type or contact with an issue.

Can View Customer Information privilege
The Can View Customer Information privilege enables account types to view customer 
related information

 Chapter 12- Specification and Requirement 
Tracking 

In this chapter: 

• Understanding DevSuite Specification Management 

• Tracking Specifications 

• Managing Subproject-Specification Links 

• Managing Development Issue-Specification Links 

1 Understanding DevSuite Specification 
Management 
In DevSuite, a specification represents a formal commitment to implement a feature or enhancement a particular 
product release. Every specification represents a set of requirements and provides the business with a framework 
for organizing and tracking the data and knowledge needed to implement those requirements. 

Specifications may correspond to a new feature, an enhancement of an existing feature, or even the detailed 
analysis of a defect that needs to be fixed. 

Using controls in the DevTrack clients, project members may link DevSpec specifications to release subprojects 
and development issues, track and update specifications. 

As specifications progress through its life cycle, development managers work with the product managers to define 
features, validate requirements, approve designs, and schedule their implementation. 

In DevTrack, release subprojects and development issues may be linked to multiple subprojects and are managed 
together in the DevTrack client. 

A primary specification is a specification that defines a subproject or development issue. 

A subproject is defined by multiple primary specifications, but each specification may be linked to only one 
subproject. 

A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. Development 
issues may be linked to multiple specifications, but only one primary specification. 

  

2 Tracking Specifications 
In the DevTrack client, specifications may be tracked and managed in multiple panels and pages including the All 
Links tab, the Specification tab, and the Subproject Links tab. 

Displaying Specifications in the List Panel 

To display specifications in the list panel, click the Show Specification check box in the issue list bar of the 
DevTrack Web client. 

  

3 Managing Subproject-Specification Links 
In DevTrack, release subprojects may be linked to multiple subprojects and are managed together in the DevTrack 
client. 

A primary specification is a specification that defines a subproject or development issue. A subproject is defined 
by multiple primary specifications, but each specification may be linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

Specifications may be linked to subprojects in Specification tab of the subproject detail panel or the Specification 
tab of the issue detail panel. 

  

  

  

3.1 Defining Subproject-Specification Links 
In DevTrack, a release subproject may be defined by multiple primary specifications, but a specification may be 
linked to only one subproject. 

Using controls in the Subproject Links tab, project members may link specifications to a subproject. 

A subproject may be linked to multiple specifications. Each specification is designated as a primary specification 
for that subproject and may be defined as the primary specification of development issues managed within that 
subproject. 

To link a specification to a subproject: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears.  

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

  

3.2 Dropping Subproject-Specification Links 
Subproject-specification links cannot be dropped if the subproject is the parent of a development issue that is 
linked to that specification. 

To drop links between specification to a subproject: 

Select the Specification tab in the issue detail panel. 

Click the Remove bu on. A confirmation dialog box appears.  

Click the Yes button. 

4 Managing Development Issue-Specification Links 
A development issue is defined by one primary specification. To be defined as the primary specification of a 
development issue, a primary specification must be linked to the parent subproject of that issue. 

Development issues may be linked to multiple specifications, but only one primary specification. 

4.1 Defining Primary Development Issue-Specification Links 
In DevTrack, a primary specification is a specification that defines a subproject or development issue. A 
development issue may be linked to a single primary specification which describes the development task that is 
tracked by the development issue. 

Using controls in the Specification tab, project members may link a specification to a development issue. 

The primary specification assigned to a development issue must be linked to the parent subproject of that issue. 
Within a subproject, multiple development issues may be defined by the same specification. 

To define primary development issue specifications: 

Select the Specification tab in the issue detail panel. 

Select the Show Specification for Current Issue option button. 

Click the Ellipsis button. The Change Specification dialog box appears. 

Select a specification in the Specifications dropdown list. The Specifications dropdown list displays the 
specifications linked to the subproject that is the parent of the development issue. 

Click the OK button. The development issue is defined by the selected specification. 

4.2 Linking Specifications to Development Issues 
In DevTrack, multiple specifications may be linked to each development issue to provide developers with 
supplemental material that is related to the development issue. 

Linked specifications may be managed and tracked in the Links tab of the issue detail panel. 

Using controls in the Links tab, project members may link multiple specifications to a development issue. 

Although development issues may be linked to multiple specifications, one specification may be designated as the 
primary specification for that issue. 

Specifications linked to a development issue need not linked to the parent subproject of that issue. Only the primary 
specification must be linked to the parent subproject before it may be linked to the development issue. 

To link a specification to a Development Issue: 

Select the Specification tab in the issue detail panel.  

Click the Add New button. The Link Specification window appears. 

Optional: To filter specifications by Specification folder, select a folder in the tree panel. 

Select one or more specifications in the list panel. 

Click the Link button. The Link Specification window closes. 

To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 

  

lass="WIKI_section_title WI 

 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 

DevTrack User Guide

Page 142 of 148



To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
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To personalize tab placement: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tab tab. 

Determine tab placement: 

Click the Top radio button to place tabs above the page. 

Click the Bottom radio button to place tabs below the page. 

Click the OK button. 

3.4 Personalizing the Issue Detail Report 
Project members can use the Issue Detail tab in the User Preferences manager to include or exclude Issue Detail report sections from the Issue Detail page in their Windows 

client. 

The Issue Detail page is a read-only log of all of the changes made to a DevTrack record. The Issue Detail page is comprised of seven sections that present information about 

the history of the record. 

Issue Detail page sections include: 

The Change Log history report  

The Custom Page history report  

The Links history report  

The Owner and State Change Issue Detail history report  

The Summary history report  

The Tracking Issue Detail report 

The Issue Detail page preferences defined in the User Preferences manager apply only to the current project and do not affect the Issue Detail page in other DevTrack clients. 

To personalize the Issue Detail report: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue Detail tab. 

Add or remove sections to the Issue Detail report: 
 
To add pages select a section in the Available Issue Detail Sections list and click the Right arrow. 

To remove pages select a section in the Issue Detail Sections Displayed list and click the Left arrow. 

Change the order of sections displayed in the Issue Detail report. 

Select a section in the Issue Detail Sections Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Sections Displayed list and click the Down button to move the section lower in the 
report. 

Select an option in the Issue Tracking Order area: 

Click the Ascending radio button to display development issue in the report from oldest to newest. 

Click the Descending radio button to display development issue in the report from newest to oldest. 

  

3.5 Adding Tools to the Tool Menu 
Project members can use the Tools tab in the User Preferences manager to add commands that launch third-party applications to the Tool menu in menu bar. 

Project members may provide themselves with easy access to commonly used tools (for example, a spreadsheet application) within the DevTrack Windows client GUI. 

Project members may use the Add button in the Tool tab to navigate to a directory containing an executable file for any application. 

To add tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab.  

Click the Add button. 
 
 
 
The Add Tools dialog box appears.  

Enter a title for the tool in the Menu Title field. 

Click the ellipsis button next to the Command field. 
 
 
 
The Browse dialog box appears. 

Navigate to the location of the executable. 

Click the Open button. 
 
 
 
The Browse dialog box closes. 

Click the OK button. 
 
 
 
The Add Tools dialog box closes. 

Click the OK button in the Tools page. 
 
 
 
The menu title appears in the Tool menu 

  

3.6 Ordering Tools in the Tool Menu 
Project members may use the Tools tab in the User Preferences manager to organize the application shortcuts that appear in the Tool menu. 

Project members can change to the order of tools added to the Tool menu. The Up and Down commands in the Tool page of the User Preferences Manager enable project 

members to move menu titles up or down in the Tool menu. 

To organize tools to the Tool menu: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Tool tab. 

Select a tool in the Menu Title list. 

Change the order of menu titles. 

To move the tool title higher in the menu, Click the Up button. 

To move the tool title in the menu, Click the Down button. 

Click the OK button. 

3.7 Displaying or Hiding the Tool bar 
Project members can use the Tool bar command in the View menu to display or hide the tool bar in the DevTrack work area. 

The Tool bar command displays or hides the tool bar depending on the current status of the tool bar. 

If the tool bar is hidden, selecting the Tool bar command displays the tool bar. 

If the tool bar is displayed, selecting the Tool Bar command hides the tool bar. 

3.8 Displaying or Hiding the Status Bar 
Project members can use the Status Bar command in the View menu to display or hide the status bar in the DevTrack work area. 

The Status Bar command displays or hides the status bar depending on the current status of the tool bar. 

If the status bar is hidden, selecting the Status Bar command displays the status bar.  

If the status bar is displayed, selecting the Status Bar command hides the status bar. 

3.9 Displaying or Hiding the Report View 
Project members can use the Report View command in the View menu to display or hide the report view in the DevTrack work area. 

The Report View command displays or hides the Report view depending on the current status of the report bar. 

If the report view is hidden, selecting the Report View command displays the tool bar.  

If the report view is displayed, selecting the Report View command hides the report view. 

4 Personalizing the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to customize the issue list panel in the main view. 

The issue list panel displays development issues in a tabular format of rows and columns. Each row represents a development issue. Each column represents a development 

issue property. 

Using controls in the Issue List tab of the User Preferences manager, project members may choose which columns are displayed in the issue list panel and the order of those 

columns. Project members may also choose to display child development events or development issues that are linked to each issue. 

  

  

4.1 Adding or Removing Columns to/from the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to add or remove columns to the issue list panel in the main view. Each column represents a 

development issue property. 

Issue list display columns fall into three broad categories: 

System control columns display data that is tracked in system-defined data-entry controls. System controls may be 
displayed in the Description page, the Current Status page, and all custom pages in the DevTrack client.  

Custom control columns display data that is tracked in administrator-defined data-entry controls. Custom controls are 
displayed in the Description page and the Current Status page in the DevTrack client.  

System variable columns display data that is not tracked in data-entry controls, but that is defined automatically based on 
project workflow. 

4.1.1 System and custom control columns 
Most issue list display columns represent system-defined or custom-defined dataentry controls. Project administrators may rename or otherwise customize data-entry 

controls in each DevTrack project. The list of available issue list display columns is determined by project customizations. 

The Description Preview column is a special Issue list column that displays data tracked in the Description control of the Description page. If the Description Preview column 

is added to the display columns, the first 200 characters of an issue description is displayed in the Issue list panel. 

Line feeds and carriage returns are represented by the pipe character, |, in the Issue list panel preview.  

HTML markup tags are stripped out and not displayed in the Issue list panel preview. 

4.1.2 System Variable Columns 
System variable columns do not represent data that is tracked in system or custom data-entry controls. Each system variable column displays issue properties that are 

automatically calculated based on project workflow. 

Eleven system variable columns may be displayed in the Issue list panel of the DevTrack client. 

TheAssigned By columndisplays the user name of the project member that assigned the development issue to its 
current owner. 

TheAttachment columndisplays an icon to indicate if any files are attached to a development issue.  

TheClose Status columndisplays the closing status of a development issue.  

TheDate Assigned columndisplays the date that the development issue was assigned to its current owner.  

TheDate Closed columndisplays the date that development issue was closed.  

TheLast Modified columndisplays the date that the development issue was last updated.  

TheLast Transition columndisplays the date of the last change to the issue workflow state of a development issue.  

TheLinks columndisplays an icon to indicate if any issues or events are linked to a development issue.  

TheLocked By columndisplays the name of the project member that has locked a file that is attached to a 
development issue.  

TheTime to Planned Start Date columndisplays the number of days before work on a development issue is 
scheduled to start.  

TheTime to Due Date columndisplays the number of days that have passed since work on a development issue has 
started. 

To add or remove columns to the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

Add or remove sections to the issue list panel: 

To add pages select a section in the Data Fields list and click the Right arrow. 

To remove pages select a section in the Issue List View Columns list and click the Left arrow. 

Click the OK button. 

4.2 Changing the Display Order of Issue List Columns 
To change the display order of issue list columns: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 
 
 
 
Select the Issue List tab. 

Change the order of sections displayed in the issue list panel. 

Select a section in the Issue List View Columns list and click the Up button to move the section higher in the report. 

Select a section in the Issue List View Columns list and click the Down button to move the section lower in the 
report. 

Click the OK button. 

4.3 Displaying Linked Reference Development Issue 
To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

4.4 Displaying Interproject Linked Issues or Incidents 
To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

4.5 Displaying Linked Child Development Issues 
To display linked child development issues in the issue list panel, select the Show Child Issue under a Parent Issue check box. 

4.6 Displaying Linked Parent Development Issues 
To display linked parent development issues in the issue list panel, select the Show Parent Issue under a Child Issue check box. 

4.7 Displaying Linked Issues in the Issue List Panel 
Project members may use the Issue List tab in the User Preferences manager to display or hide linked development issues in the issue list panel in the main view. 

Typically, the issue list panel displays all of the development issues stored in the main view in a tabular format. Each development issue is represented by a row in the 

window. Each column displays the values for each development issue property. If either linked development issue option is selected, the linked development issue appears as 

a separate row in the development issue list. 

The Show Referential Linked Issues option displays referential links as a separate row below the parent development 
issue in the issue list panel. 

The Show Interproject Linked Issues option displays interproject links as a separate row below the parent development 
issue in the issue list panel. 

To display linked development issues in the issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Issue List tab.  

(Optional):To display referential links in the issue list panel, select the Show Referential Linked Issues check box. 

(Optional):To display interproject links in the issue list panel, select the Show Interproject Linked Issues check box. 

Click the OK button. 

 

4.8 Displaying Events in the Issue List Panel 
Project members may use the Events tab in the User Preferences manager to display or hide events in the issue list panel in the main view. 

The issue list panel may optionally display linked development issues and events associated with each development issue. 

The User Preferences manager enables project members to define their preferences for displaying events in the issue list panel. 

Project members may choose to display all open events, all closed events, all open and closed events in the issue list 
panel. 

Project members may also choose to display all events belonging to every project member or only those events that 
belong to that user. 

Events are an optional feature in the DevTrack Enterprise Edition. The Events tab only appears in the User Preferences manager if a project administrator has enabled events 

processing in the project. 

To display events in the development issue list: 

Select the User Preference command in the System menu. 
 
 
 
The User Preferences Manager appears. 

Select the Events tab.  

Choose an option for displaying events in the issue list panel. 

Select the None Event radio button to not display events in the issue list panel. 

Select the Open Event radio button to display open events in the issue list panel. 

Select the Closed Event radio button to display closed events in the issue list panel. 

Select the Open and Closed radio button to display both open and closed events in the issue list panel. 

Select the Show Related User Event Only check box to display all events owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member, as well as the parent development issues of those events. The parent issues are 
displayed regardless of who owns those issues. 

Select the Show Related User Events check box to display events and issues owned by the project member currently 
selected in the User List dropdown list.If this option is selected, the issue list panel displays all of the events owned 
by the selected project member. Parent issues are not displayed unless the selected project member also owns 
the parent issue.  

Click the OK button. 

5 Managing System Settings 
Project members may use controls in the User Preferences manager to customize system settings for their DevTrack client. 

System settings include the user password, local checkout root path, and date and time preferences. 

5.1 Changing Passwords 
Project members can use the Password command in the System menu to change their DevTrack password. 

To change passwords: 

Select the Password command in the System menu. 
 
 
 
The Change Password dialog box appears. 

Enter the password in the Current Password field 

Enter a new password in the Password field. 

Enter the new password in the Confirm field 

Click the OK button. 

  

5.2 Defining the Local Checkout Root Path 
Project members can use the Local Check Out Root Path control in the User Preferences manager to define a directory to store files that they have checked out from the 

knowledge base. 

Note:TechExcel recommends that project members define a unique local document checkout directory for each 
DevTrack project. Creating this directory eliminates the chance that files from different projects that share the file 
names can overwrite one another. 

By default, the local check out root directory on each computer isC:\PtDoc. 

To define document directory: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Define the Local Checkout directory in the Other tab. 

To search for a Local Checkout directory click the Local Checkout Root Path button and navigate to a local directory. 

To enter the path type in the Checkout Root Path field. 

Click the OK button. 

  

5.3 Defining a Default Project 
Project members can use the Log into the Following Project Automatically control in the User Preferences manager to define a default project. Once a default project is 

defined for a Windows client, the machine automatically logs into the project. 

To define default project: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Log into the Following Project Automatically check box in the Other tab. 

Select the default project from the dropdown list. 
 
 
 
Only those projects to which you are a member appear in the dropdown list. 

Click the OK button. 

5.4 Enabling Spell Checking 
Project members can use the Enable Spell Check control in the User Preferences manager to enable automatic spell checking of all fields on their Windows client machine. 

The spell checking option automatically highlights all misspelled words in red throughout the DevTrack client. 

Note:DevTrack spell checking must be enabled by an administrator in DevTrack Admin. Project members may 
then choose to enable or disable the DevTrack spell checking on their DevTrack Windows client. If the 
administrator does not enable spell checking in DevTrack Admin the Enable Spell Check control is disabled. 

To enable spell checking in the DevTrack client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable spell check box in the Other tab. 

Click the OK button. 

5.5 Enabling Multiple Database Connections 
Project members can use the Enable Multiple Database Connections command in the User Preferences manager to enable the client to connect to ODBC data sources other 

than the DevTrackDB. 

The Enable Multiple Database Connections option enables project teams to run several different versions of DevTrack simultaneously, and to maintain different DevTrack 

databases. 

Once project members have defined the ODBC connection for the datasource and enabled multiple database connections, they can log into DevTrack and select alternative 

databases in the Login dialog box using the Data Source button. For more information see ?ogging Into Projects.? 

Before DevTrack can connect to a database the database must first have a DSN (data source name) defined in Windows. 

To enable multiple database connections: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Enable Multiple Database Connections check box in the Other tab. 

Click the OK button. 
 
 
 
A DevTrack warning dialog box appears. 

Click the OK button. 

  

5.6 Defining Date and Time Settings Preferences 
Project members can use the Date/Time tab in the User Preferences manager to define their time zone and the formats used to display dates and times in their Windows 

client. 

A DevTrack project can be configured to operate in multiple time zones and to use different date and time formats for each of those projects. Times zone definitions and 

formats can be set at the system-level, the project-level, or the user-level. 

Note:TechExcel recommends that time zone definitions and formatting are set at the system or project level to ensure 
the integrity of data collected form users in multiple time zones. 

If time zone settings are not configured at the system or project level, individual users may configure the day/time format on the client. 

To set date and time formats in the client: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Date/Time tab. 
 
 
 
If the date/time settings in DevTrack Admin are specified as system- or project-level, all fields on the Date/Time 
form page are read-only.  

Select an option from the Time Zone dropdown list. 

Select an option from the Date dropdown list in the Date area.   
 
 
 
An example of the selected date format is displayed in the Sample field. 

Select an option from the Time dropdown list of the Time area. 
 
 
 
An example of the selected time format is displayed in the Sample field. 

6 Managing Subscriptions 
Project members may use the My Subscription tab in the User Preferences manager to view or edit issues notification and issue escalation subscriptions. 

Administrator-defined subscription settings determine whether each project member may or may not receive e-mail notification for issue notification actions or issue escalation 

actions. 

Project administrators may define subscription options for project members in DevTrack Admin. Project administrators may assign one of four subscription rules to each 

project member: 

 

TheMust Subscribe rulemandates that the project member must subscribe to notifications sent based on that 
notification or escalation rule. The notification rule or escalation rule is grayed out in the My Subscription tab and cannot 
be edited. 

TheNever Subscribe rulemandates that the project member cannot subscribe to notifications sent based on that 
notification or escalation rule.  

TheOption No ruleenables the project member may subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is not selected by default, but the project member may use 
controls in the My Subscription tab to subscribe. 

TheOption Yes ruleenables that the project member to subscribe to notifications sent based on that notification or 
escalation rule. The notification rule or escalation rule is selected by default, but the project member may use controls in 
the My Subscription tab to unsubscribe. 

  

6.1 Defining Issue Notification Subscriptions 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail notification subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the E-mail Notification option from the Rule Type dropdown list in the My Subscription tab. 
 
 
 
All e-mail notification rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

6.2 Defining Issue Escalation 
Project members may use controls in the My Subscription tab of the User Preferences manager to view or edit e-mail escalation subscriptions. 

To view or edit e-mail notification subscriptions: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the My Subscription tab. 

Select the E-mail Escalation option from the Rule Type dropdown list. 
 
 
 
All e-mail escalation rules are displayed in the Notification Rules list. 

To edit e-mail notification subscriptions, select or deselect the check box in the Subscription column of each e-mail 
notification rule. 

A check mark indicates that the project member is subscribed to the rule. 

No check mark indicates that the project member is not subscribed to the rule. 

7 Managing Personal Folder Preferences 
Project members may use the Personal Folder tab in the User Preferences manager to define personal folder preferences in their client applications. 

Project members may enable the display of their own personal folders as well as the personal folders belonging to other project members. 

  

  

  

7.1 Managing the Display of Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make their personal folders visible in their DevTrack client. 

Once personal folders are enabled and selected the My Personal Folder folder is displayed in the issue tree panel of the DevTrack client. The My Personal Folder contains 

one subfolder representing each of the personal folders enabled by the project member. 

The My Personal Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

To display personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View My Personal Folder check box. 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The select folders are displayed in the issue tree panel of the DevTrack client application. 

7.2 Managing the Display of Team Member Personal Folders 
Project members may use controls the Personal Folder tab of the User Preferences manager to make the personal folders of their team members visible in their DevTrack 

client. 

Project members may select which personal folders are displayed, and may choose to display or hide personal folders belonging to specific project members. 

Once personal folders are enabled and selected the Team Member Folder folder is displayed in the issue tree panel of the DevTrack client. The Team Member Folder contains 

multiple subfolders. Project members may determine how subfolders are organized in the Team Member Folder. 

The By Personal Folder option displays every enabled personal folder and includes a subfolder within each personal 
folder for each enabled project member. 

The By Team Member option displays every enabled team member and includes subfolder within each team member 
folder for each enabled personal folder. 

The Team Member Folder may be displayed above or below project issue folders in the issue tree panel. For more information seeSelecting Personal Folder Display 

Preferences. 

  

To display team member personal folders: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select the Enable View Team Member? Personal Folder check box. 

Select a display option.  

 Select the By Personal Folder radio bu on  

 Select the By Team Member radio button 

Select one or more personal folders in the Select Personal Folder list. 
 
 
 
The selected folders are displayed in the issue tree panel of the DevTrack client application. 

Select one or more team members in the Select Team Members list. 
 
 
 
The folders belonging to the selected project members are displayed in the issue tree panel of the DevTrack client 
application. 

7.3 Selecting Personal Folder Display Preferences 
Project members may use controls the Personal Folder tab of the User Preferences manager to define how personal folders are displayed their DevTrack client. 

Personal folders are displayed in the issue tree panel of the DevTrack client. The personal folders that the project member enables for display are presented either above or 

below the project issue folders. 

To define display preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select the Personal Folder tab. 

Select a display option from the Display Personal Folder dropdown list. 

8 Managing Event Preferences 
Project members may use the Events tab in the User Preferences manager to define how events are displayed in the their client applications. 

 

Project members may choose between one of four options for displaying events in the client: 

The None Event option 

The Open Events Only option 

The Closed Events Only option 

The Open and Closed Events option 

Project members may also enable two options which limit the events displayed in the client. 

The Show Related Event option 

The Show Related User option 

To define event preferences: 

Select the User Preference command in the System menu. 
 
 
 
The User Preference manager appears. 

Select a display event option in the Event tab. 

To limit the events displayed in the client to events that are related the user, select the Show Related User Events 
Only check box. 

To limit the events displayed in the client to events that are related to issues belonging to the user, select the Show 
Related User Issues Only check box. 

  

9 Managing DevTrack Web Preferences 
The Settings page enables project members to define user preferences for pages and controls displayed in their DevTrack web client. 

 

  

The Settings menu enables project members to navigate between the twelve pages displayed in the Settings page. 

Each page in the Settings view enables project members to customize the appearance and functionality of the DevTrack web client: 

ThePreferences pageenables project members to define personal preferences for viewing and managing issues in 
the DevTrack web client. 

TheList View Preferences pageenables project members to define which columns are displayed in the Issue List 
page. 

TheIssue Detail Preferences pageenables project members to define which sections are displayed in the Issue 
Detail page. 

TheUser List Preferences pageenables project members to define which project members are displayed as options 
in the User dropdown list. 

TheIssue Searching pageenables project members to define which fields are included in quick searches. 

ThePassword pageenables project members to manage their DevTrack passwords. 

TheTeam Member pageenables project members to view project member contact information and to update their own 
data. 

TheE-mail Subscription pageenables project members to view and edit their issue notification, issue escalation, event 
notification, and event escalation subscriptions. 

ThePersonal Folder pageenables project members to define personal folder and team folder preferences. 

TheDate/Time Format pageenables project members to define their time zone and the format of dates and times 
displayed in their web client. Project members may define time zones and the format of dates and times only if they are 
enabled to by the project administrator. 

TheOnline Help pageenables project members to access DevTrack online help. 

TheAbout pageenables project members to view information about the current version of the software. 

  

9.1 Defining Web Client Preferences 
The Preferences page enables project members to define personal preferences for viewing and managing issues in the DevTrack web client. The web client preferences 

defined in the Preferences page apply only to the project member and only in DevTrack web client. 

 

  

Project members may define personal preferences for the issue list panel, the User List, the Home page, and the Issue Detail page as well enabling and defining DevTrack 

issue management features. 

The Preferences page displays eight controls. Each control enables users to personalize a different feature of their DevTrack web client. 

TheView As controlenables project members to view the issues displayed in the Issue list based on either the current 
owner of the issue or the project member that initially submitted the issue. Depending on the option selected, the User 
List may be use to filter the issues displayed based on the issue owner or submitter. 

TheView Inactive Person controlenables project members to choose to view or hide the names of inactive project 
members in the User List. 

TheAuto Refresh on Issue list/Report pageallows project members to enable the DevTrack web client to be 
automatically refreshed. 

TheEnable Group Action controlallows project members to enable or disable group actions in the DevTrack web 
client. 

TheNumber of Issues Per Issue List Page controlenables project members to define the number of issues that are 
displayed simultaneously in the Issue List page. 

TheHome Page Preference controlenables project members to display or hide the administrator-defined project 
description in their personal home page. 

TheDefault Issue Template controlenables project members to select the default issue template used to create 
issues in the DevTrack web client. Project members may only select default issue template if they are enabled to by the 
project administrator. 

TheShow Note Content controlenables project members to enable the contents of issue notes to be displayed in the 
Notes section of the Issue Detail page and to define the number of character displayed in that note. 

  

9.2 Customizing Web Client Pane Sizes 
DevTrack web client users may customize the relative size of the frames that comprise the web client GUI: the subproject tree panel, the issue list panel, and the issue detail 

panel. 

Using controls in the Preferences page, project members may define the width of the subproject tree frame, the width of the issue list frame, and the height of the subproject 

detail frame. 

All sizes are defined as a percentage of the total width or height of the client workspace. 

The combined width of the subproject tree frame and the issue list frame always equals 100% of the client workspace. If the total percentage defined in the Preference page 

exceeds 100%, the client automatically recalculates the width of the issue list frame to accommodate the user-defined width of the subproject tree panel. 

The combined height of the issue detail frame and that of the subproject/issue list frames always equals 100% of the client workspace. The height of the subproject tree frame 

and the issue list frame is automatically calculated to accommodate the user-defined height of the subproject detail frame. 

  

9.3 Defining List View Preferences 
The List View Preferences page enables project members to define which columns are displayed in the Issue List page. 

Project members may use controls in the List View Page to determine how issues are displayed in the Issue List page. 

Add or remove columns 

Change the order of sections displayed in the issue list panel 

Show referential linked issues under issue list 

Show interproject linked issues under issue list 

Show parent issue under a child issue 

Show child issue under a parent issue 

Project administrators may use the Apply All button to apply settings to every project member. 

  

  

9.3.1 Add or Remove Columns 
Project members may use the List View Preferences page to add or remove columns to the issue list panel in the main view. 

To add columns select a field in the Data Fields list and click the Right arrow. 

To remove columns select a field in the Issue List View Columns list and click the Left arrow. 

Click the Submit button to save changes. 

9.3.2 Order Columns 
To move a column higher in the report, select a field in the Issue List View Columns list and click the Up button. 

To move a column lower in the report, select a field in the Issue List View Columns list and click the Down button. 

Click the Submit button to save changes. 

9.3.3 Show Referential Linked Issues Under Issue LIst 
To display referential links in the Issue List page, select the Show Referential Linked Issues check box. Click the Submit button to save changes. 

9.3.4 Show Interproject Linked Issues Under Issue List 
To display interproject links in the Issue List page, select the Show Interproject Linked Issues check box. Click the Submit button to save changes. 

9.3.5 Show parent issue under a child issue 
To display linked child issues in the Issue List page, select the Show Child Issue under a Parent Issue check box. Click the Submit button to save changes. 

9.3.6 Show Child Issue Under a Parent Issue 
To display linked parent issues in the Issue List page, select the Show Parent Issue under a Child Issue check box. Click the Submit button to save changes. 

9.3.7 Apply Settings to All Project Members 
Project administrators may use the Apply All button to apply issue list preferences to the DevTrack web client of every project member. 

The Apply All feature enables project administrator to push out DevTrack Web Issue List page preferences to all project members. These preferences immediately override the 

personal preferences of all project members. 

The Apply All button is only displayed in the List View page if the project member has been granted project administrator privileges for the current project. 

Click the Submit button to save changes. 

  

9.3.8 Defining Issue Detail Preferences 
The Issue Detail Preferences page enables project members to define which sections are displayed in the Issue Detail page. 

Project members may use controls in the Issue Detail Preferences page to determine how issues are displayed in the Issue List page. 

Add or remove detail sections displayed in the Issue Detail page. 

Change the order of issue detail sections displayed in the Issue Detail page. 

  

9.3.8.1 Add or Remove Issue Detail Sections 
Project members may use the Issue Detail Preferences page to add or remove columns to the Issue Detail page in the DevTrack web client. 

To add pages select a section in the Available Issue Detail Section list and click the Right arrow button. 

To remove pages select a section in the Issue Detail Section Displayed list and click the Left arrow button. 
 
 
 
Click the Submit button to save changes. 

9.3.8.2 Order Issue Detail Sections 
Select a section in the Issue Detail Section Displayed list and click the Up button to move the section higher in the 
report. 

Select a section in the Issue Detail Section Displayed list and click the Down button to move the section lower in the 
report. 

Click the Submit button to save changes. 
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 Chapter 14- Development Branch Management 

In this chapter: 

• Understanding Branch Management 

• Managing Release Subprojects 

• Managing Branch Issues 

• Managing Branch Events . 

1 Understanding Branch Management 
DevTrack enables development organizations to create and manage sophisticated structures for managing and tracking 
product development tasks across multiple products, versions, and builds. 

Every release of a product, version, or build that is managed in a DevTrack project may be associated with a subproject 
folder in the DevTrack client. The subproject folder represents that release and is used to organize and manage the 
development issues and branch issues related to that release. 

Branch management facilitates the testing of features across releases using branch issues. A branch issue is a copy of 
a development issue that may be assigned to a build subproject and is linked to its parent development issue by amulti-
release link. 

A single development issue may spawn multiple branch issues: each belonging to a distinct product, version, or build. 
branch issues enable development teams to create multiple identical issues that may be tested against many different 
builds of a product. 

Branch issues may, in turn, generate multiple branch events, which represent subtasks of the parent branch issue. 

An unlimited number of test issues may be used to track the resolution of the parent development issue across diverse 
environments. 

2 Managing Release Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

The subproject hierarchy defines the relationships between products, versions and builds in terms of parent-child 
relationships and clearly represents the relationships between each area of development. 

Every product release folder is the parent to one or more version subprojects. 

Every version release folder is the child of a parent product folder and the parent to one or more build subprojects. 

Every build release folder is the child of a parent version folder. 

Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Normal subprojects are subprojects that are unrelated to DevTrack branch management structures. If DevTrack branch 
management is not enabled in a project, normal subprojects are the only type of subproject that may be created. 

2.1 Creating Product Subprojects 
Release subprojects are subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every product release folder is the parent to one or more version subprojects. 

To create product release subprojects: 

Select the root subproject folder or a product subproject folder in the issue tree panel. The new subproject is automatically
defined as a child of the selected subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 
 
Title 

Status 

Percent Complete 

Priority 

Type 

Select an option from the Product dropdown list. The Product dropdown list displays all of the products that have been 
defined as applicable to the current project. If branch management is not enabled in the project, the Product dropdown 
list is read-only. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

7Click the Submit button. 

2.2 Managing Version Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every version subproject is the child of a parent subproject and the parent to one or more build release subprojects. 

To create version release subprojects: 

Select a subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the selected 
subproject. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To associate the subproject with a product, select an option from the Product dropdown list. The Product 
dropdown list displays all of the products that have been defined as applicable to the current project. If branch 
management is not enabled in the project, the Product dropdown list is read-only. 

Optional: To associate the subproject with a version, select an option from the Version dropdown list. The Version 
dropdown list displays the versions of the selected product that have been defined as applicable to the current project. 
If branch management is not enabled in the project, the Product dropdown list is not displayed. 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.3 Managing Build Release Subprojects 
Release subprojectsare subprojects that are defined by the DevTrack branch management structures. Every release 
subproject is either a product subproject, a version subproject, or a build subproject. 

Every build subproject is the child of a parent version subproject. 

Project members may use branch actions to generate multiple branch issues from a single development issue and to 
assign those branch issues to applicable build subproject folders. 

Branch issues may only assigned to build release subproject folders. 

To create build release subprojects: 

Select a version subproject folder in the issue tree panel. The new subproject is automatically defined as a child of the 
selected subproject.  

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists of 
three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page.  

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

To associate the subproject with a build, select an option from the Version dropdown list. The Build dropdown list 
displays the builds of the selected product that have been defined as applicable to the current project.  

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 

Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.4 Managing Normal Subprojects in Release Structures 
Normal subprojects organize development issues into smaller, more meaningful categories and enable development 
organizations to manage those issues independently of other issues. 

Normal subprojects are not tied to DevTrack branch management structures (products, versions, and builds). However, 
development organizations may create normal subprojects to organize issues into other logical groups (for example, 
development teams, components, or priority) within release subproject folders. 

To create normal subprojects in release structures: 

Select a subproject folder in the issue tree panel. 

Select the New command in the Action control. The New Subproject page appears. The New Subproject page consists 
of three tabbed pages: the General page, the Workflow page, and the Subproject Child Fields page. 

Define general subproject properties in the General page. General subproject properties include: 

Title 

Status 

Percent Complete 

Priority 

Type 

Optional: To define subproject start, finish, due, and delivery dates, select appropriate options in the Date area of the 
General page. Subproject date properties include: 
 
Start Date 

Finish Date 

Due Date 

Delivery Date 

Optional: To define subproject notes, enter a brief note in the Note text field control. 

Click the Submit button. 

  

2.5 Understanding DevTrack-DevPlan Subprojects 
TechExcel DevPlan is a tool for planning and managing the software development life cycle for distributed development
teams. DevPlan and DevTrack share the same hierarchical subproject structure to organize and manage releases. 

Project planning and implementation both are managed within a common subproject hierarchy that enforces good 
development practices and accountability and enables collaboration between distributed teams. 

DevPlan integration with DevTrack enables project managers to focus on high-level project planning and management 
tasks while the development work is managed and tracked within DevTrack. 

DevPlanis a tool for defining and managing planning processes and high-level implementation of the ?esigned 
product?represented by the work breakdown structure. 

DevTrackis the tool that enables organizations to make that vision a reality. DevTrack comprehensively tracks and 
manages all product defects, change requests, and all other development issues. DevTrack also provides powerful 
workflow and process automation. 

The subproject structure ensures that all deliverables and milestones arefeature-driven. 

Asubprojectis a discreet area of work that corresponds to a specific product, feature, version, or build. Subprojects 
organize planning processes so the scope of the project may be measured, dependencies identified, and resources 
properly allocated to all areas of work. 

The subproject tree structure as displayed in the DevPlan and DevTrack clients provides project managers, designers, 
and developers with a visual representation of the product or products in development. Managers and developers can 
see the product and its features in the tree structure and assess the status of all areas of development in the DevPlan 
client. 

A single DevPlan project may be used as a centralized planning and project management tool for multiple TechExcel 
DevTrack projects located anywhere in the world. All design and project planning may be managed in a centralized 
DevPlan project and the implementation of that plan and design is executed and tracked at the local level within 
distributed DevTrack sites. 

  

3 Managing Branch Issues 
A branch issue is a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may create multiple branch issues and assign those issues to applicable build subprojects by 
performingbranch actions. 

Abranch actionis a administrator-defined set of rules for creating branch issues that defines the release scope, branch
issue type, and the QA test link type of the child branch issue. 

Branch actions are also defined by access controls and applicable state rules that determine which project members 
may create branch issues and when they may create them. branch action commands are displayed in the Issue list 
shortcut menu in the DevTrack Windows client and the Action shortcut menu in the DevTrack web client. 

  

  

3.1 Creating Branch Issues 
A branch issueis a copy of a development issue that may be used to track the resolution of the parent development 
issue in many different builds All branch issues are created and managed within a build subproject folder. 

Branch issues inherit all issue property definitions from the development issue used to create it. Administrator-defined 
multiple branch actions may enable project members to edit new branch issues before they are assigned to a release 
folder. 

Branch issues may also inherit issue notes and the state change history from the parent development issue. 

Every branch issue is linked to its parent development issue by amulti-release link. 

Branch action rules define or constrain most branch issue properties including the issue type of the branch issue, 
applicable issue workflow states, applicable action executors, and the scope of the action. 

To create a branch issue (web client): 

Select a development issue in the Issue list panel of the DevTrack web client. 

Select a branch action in the Action shortcut menu. The Action shortcut menu displays a list of every administrator-
defined branch action that is applicable to the current version or build. The Create QA Child Test Issue page 
appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. A branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development 
issue prior to creating the branch issues. 

(Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action page closes. The Confirm branch issues page appears. The Confirm 
branch issues dialog box displays the Subproject tree and the branch issues just created as the children of the 
selected build subproject folders. 

Click the OK button 

To create a branch issue (Windows client): 

Right-click a development issue in the Issue list panel of the DevTrack Windows client. 

Select a branch action in the shortcut menu. The shortcut menu displays a list of every administrator-defined branch 
action that is applicable to the current version or build. The Create QA Test Child Issues dialog box appears. 

Select one or more applicable build subproject folders in the Subproject tree control. 

Click the OK button. The Create QA Test Child Issues dialog box closes. The branch action manager appears. The 
branch action manager enables project members to edit the properties inherited from the parent development issue 
prior to creating the branch issues. 

 (Optional): Define branch issue properties in the Description tab and Current Status tab. 

Click the Submit button. The branch action manager closes. The Confirm branch issues dialog box appears. The 
Confirm branch issues dialog box displays the Subproject tree and the branch issues just created as the children of 
the selected build subproject folders. 

Click the OK button. 

  

3.2 Tracking Branch Issues 
Abranch issueis a copy of a development issue that may be used to test the implementation of a development task 
across multiple builds of a product. Each branch issue is linked to the development issue that was used to create it by a 
multi-release link. 

Project members may view and track branch issues in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

3.2.1 Issue List Page 
Branch issues may be viewed in the Issue list page as the children of parent development events or on their own when 
the Issue list is filtered by version subproject or build subproject. 

Branch issues may be displayed in the root Project Issues folder and product release subproject folders if they are 
viewed as the children of parent development issues. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues. Branch issues are not displayed. 

Branch issues are displayed as the children of the parent development issue in the Issue list page. 

To display child issues in the Issue list page, project members must select the Show Child Issue under Parent Issue 
option in the User Preferences manager. 

3.2.2 Issue Detail Page 
Branch issues are displayed as linked issues in the Links area of the Issue detail page of the parent development issue.

3.2.3 Links Page 
Branch issues may be managed in the Links page of the parent development issue. 

For step-by-step instructions on managing and editing linked issues, see ?anaging Issue Linking.?/FONT> 

  

4 Managing Branch Events 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA subtasks to many different event owners. 

Branch issues facilitate the testing of product features across multiple builds of a product. Whenever changes are made
to product features, development organizations may create branch events in the appropriate build subproject folder to 
verify that all product features work properly in the new build of a product. 

Branch events enable organizations to divide a QA task into many different subtasks, assign each of those subtasks to a
different project member, define separate start and due dates for each subtask, and manage and track each of those 
task independently in its own workflow. 

Branch event tasks consist of submitting, updating, forwarding, and closing events within workflow. 

A branch event is defined by a unique event ID, an event description, event workflow state, event start and finish dates, 
event owner, and other dynamic properties. 

  

4.1 Defining Applicable Branch Event Templates 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple test events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. 

If no branch event template is defined as applicable to a build subproject folder, no branch events may be created within
that build subproject. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To define applicable branch event templates: 

Select a version subproject folder in the Subproject tree window. 

Create a build release subproject. 

Define build release subproject properties.  

Click the Next button. The QA Test Template page appears. To enable a QA test template to be used to create 
branch events for a variable value, select the variable value check box in the Event Variable column.  

Click the Finish button. 

  

4.2 Enabling Branch Event Autocreation in Build Subprojects 
A branch event represents a subtask of a branch issue. Events enable development organizations to manage test 
issues more effectively by assigning QA issues subtasks to many different event owners. 

Every branch event is based on a branch event template. A branch event template is administrator-defined template for 
creating multiple events simultaneously. 

To create branch events from a branch issue in a build subproject, development organizations must define one or more 
branch event templates as applicable to that build subproject. A branch event template may not be used to create 
branch events in a build subproject until it has been defined as an applicable branch event template for that subproject 
folder. 

Project members may define applicable branch event templates and enable branch event auto-creation whenever they 
create or edit a build subproject folder. 

To enable branch event auto-creation in build subprojects: 

Select a version subproject folder in the Subproject tree window.  

Create a build release subproject.  

Define build release subproject properties.  

Click the Next bu on. The QA Test Template page appears.  

To enable branch events to be automatically created from a QA test template, select the check box next to the QA 
Template variable value.  

Click the Finish button. 

  

4.3 Submitting New Branch Events (Web Client) 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage test issues more effectively by assigning QA issues subtasks to many different event owners. 

Each branch event is defined by a unique, auto-generated event ID. All other branch event properties are inherited from 
the branch event template used to create it. 

Each branch event created from the branch event template may be assigned to a different project member and to a 
different event workflow state. 

Every branch events are based on an administrator-defined branch event template. 

To submit branch events: 

Select a branch issue in a build subproject folder. Every branch event is the child of a branch issue. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
displays the QA event templates defined applicable to the current build subproject. 

Click the Continue button. The branch event frame is displayed. The QA test frame enables project members to 
create one or more branch events from a single branch event template. 

To create a branch event, select an applicable owner and event workflow state for each branch event variable value. 
One branch event may be created for each QA event variable value. Each branch event may be assigned to a 
different owner and a different event workflow state. 

Click the Save button. 

4.4 Updating Branch Events 
All branch event properties are based on event template properties defined by the administrator in DevTrack Admin. 
Project members may change these settings using controls the Event Edit manager. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update branch event properties: 

Select a branch issue in a build subproject folder. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event in the Events list. The Event detail page appears. 

Define event properties.  

Click the Save button. 

  

  

4.5 Tracking Branch Events 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage branch issues more effectively by assigning QA issues subtasks to many different event 
owners. 

Project members may view and track branch events in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

4.5.1 Issue List Page 
Branch issues may be viewed in the Issue list page the children of parent development events or on their own when the 
Issue list is filtered by version subproject or build subproject. 

Branch events may be displayed as the children of the parent branch issue in the Issue list page. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues and their child branch events. 

4.5.2 Issue Detail Page 
Branch events are displayed as events in the Events area of the Issue detail page of the parent branch issue. 

  

  

4.5.3 Events Page 
Branch events may be managed in the Events page of the parent branch issue. 

4.5.4 Current Status Page 
In the DevTrack Windows client, branch events may be viewed and created in the Current Status page of the parent 
branch issue. 

  

  

4.6 Closing Branch Events 
Every event workflow state has either an open or closed status. 

Project members may close branch events by forwarding the event to a closed event workflow state. 

To close branch events: 

Select a branch issue in a build subproject folder. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event in the Events list. The Event detail page appears. 

Click the Delete button. 

4.7 Deleting Branch Events 
Project members may use the Delete command in the Event page to delete branch events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete branch events: 

Select a branch issue in a build subproject folder. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event in the Events list. The Event detail page appears. 

Click the Delete button. 
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Select a branch event template in the Select Event Type dropdown list. The Select Event Type dropdown list 
displays the QA event templates defined applicable to the current build subproject. 

Click the Continue button. The branch event frame is displayed. The QA test frame enables project members to 
create one or more branch events from a single branch event template. 

To create a branch event, select an applicable owner and event workflow state for each branch event variable value. 
One branch event may be created for each QA event variable value. Each branch event may be assigned to a 
different owner and a different event workflow state. 

Click the Save button. 

4.4 Updating Branch Events 
All branch event properties are based on event template properties defined by the administrator in DevTrack Admin. 
Project members may change these settings using controls the Event Edit manager. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To update branch event properties: 

Select a branch issue in a build subproject folder. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event in the Events list. The Event detail page appears. 

Define event properties.  

Click the Save button. 

  

  

4.5 Tracking Branch Events 
A branch event is a collection of data that represents a subtask of a branch issue. Events enable development 
organizations to manage branch issues more effectively by assigning QA issues subtasks to many different event 
owners. 

Project members may view and track branch events in the Issue list page, the Links area of the Issue detail page, and 
Links page of the DevTrack clients. 

  

4.5.1 Issue List Page 
Branch issues may be viewed in the Issue list page the children of parent development events or on their own when the 
Issue list is filtered by version subproject or build subproject. 

Branch events may be displayed as the children of the parent branch issue in the Issue list page. 

Project members must filter the issues displayed in the Issue list panel by a version or build subproject folder in order to
view branch issues and their child branch events. 

4.5.2 Issue Detail Page 
Branch events are displayed as events in the Events area of the Issue detail page of the parent branch issue. 

  

  

4.5.3 Events Page 
Branch events may be managed in the Events page of the parent branch issue. 

4.5.4 Current Status Page 
In the DevTrack Windows client, branch events may be viewed and created in the Current Status page of the parent 
branch issue. 

  

  

4.6 Closing Branch Events 
Every event workflow state has either an open or closed status. 

Project members may close branch events by forwarding the event to a closed event workflow state. 

To close branch events: 

Select a branch issue in a build subproject folder. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event in the Events list. The Event detail page appears. 

Click the Delete button. 

4.7 Deleting Branch Events 
Project members may use the Delete command in the Event page to delete branch events. 

To view, submit, edit, or delete an event, a project member must belong to an account type that has been granted the 
appropriate event access privileges by the project administrator. 

To delete branch events: 

Select a branch issue in a build subproject folder. 

Select the Events command in the Action shortcut menu. The Events page appears. 

Select a branch event in the Events list. The Event detail page appears. 

Click the Delete button. 
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